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Architecture Model Editing

* “Compose Architecture Visually” on page 1-2

* “Decompose and Reuse Components” on page 1-16

* “Build Architecture Models Programmatically” on page 1-23
* “Modeling System Architecture of Small UAV” on page 1-31

* “Organize System Composer Files in a Project” on page 1-37
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Compose Architecture Visually

1-2

In this section...

“Create an Architecture Model” on page 1-2
“Components” on page 1-5

“Ports” on page 1-9

“Connections” on page 1-12

“Importing Architectures” on page 1-14

Create and edit visual diagrams to represent system architecture in System Composer™. Use
architectural elements including components, ports, and connections in the system composition.
Model hierarchy in architecture by decomposing components. Navigate through the hierarchy.

Create an Architecture Model

A System Composer architecture represents a system of components and how they interface with
each other structurally and behaviorally. You can represent specific architectures using alternate
views.

Different types of architectures describe different aspects of systems:

* Functional architecture describes the flow of data in a system.
* Logical architecture describes the intended operation of a system.
* Physical architecture describes the platform or hardware in a system.

A System Composer model is the SLX file that contains architectural information including
components, ports, connectors, interfaces, and behaviors.

An architecture model includes a top-level architecture that holds the composition of the system. This
top-level architecture also allows definition of interfaces of this system with other systems.

Start with a blank architecture model to model the physical and logical architecture of a system. Use
one of these three methods to create an architecture model:

* At the MATLAB® Command Window, enter:
systemcomposer

Select Architecture Model.
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Examples
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* From a Simulink® model or a System Composer architecture model. On the Simulation tab, select

New "u" and then select Architecture Iﬁ%ﬁ
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e At the MATLAB Command Window, enter:

archModel = new system('ModelName', 'Architecture');
open_system(archModel)

where ModelName is the name of the new model.

Save the architecture model. On the Simulation tab, select Save All E The architecture model is
saved as an .slx file.

The architecture model includes a top-level architecture that holds the composition of the system.
This top-level architecture also allows definition of interfaces of this system with other systems. The
composition represents a structured parts list — a hierarchy of components with their interfaces and
interconnections. Edit the composition in the Composition Editor.
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This example shows a motion control architecture, where a sensor obtains information from a motor,
feeds that information to a controller, which in turn processes this information to send a control
signal to the motor so that it moves in a certain way. You can start with this rough description and
add component properties, interface definitions, and requirements as the design progresses.

Components

A component is a nontrivial, nearly independent, and replaceable part of a system that fulfills a clear
function in the context of an architecture. A component defines an architecture element, such as a
function, a system, hardware, software, or other conceptual entity. A component can also be a
subsystem or subfunction.

The Component element in System Composer can represent a component at any level of the system
hierarchy, whether it is a major system component that encompasses many subsystems, such as a
controller with its hardware and software, or a component at the lowest level of hierarchy, such as a
software module for messaging.

Represented as a block, a component is a part of an architecture model that can be separated into
reusable artifacts.

Add Components

Use one of these methods to add components to the architecture:

* Draw a component — In the canvas, left-click and drag the mouse to create a rectangle. Release
the mouse button to see the component outline. Select the Component block option to commit.
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* Create a single component from the palette —

untitled

® untitled

untitled

B E e

1
]
:

(2] B [

B E OB E

i

S

* Create multiple components from the palette —
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[l
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untitled HEES
untitled ¥
untitled
Component Component
it

Name a Component

Each component must have a name that is unique within the same architecture level. The name of the
component is highlighted upon creation so you can directly type the name. To change the name of a

component, click the component and then click its name.

Sensor
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Move a Component

Move a component simply by clicking and dragging it. Blue guidelines may appear to help align the
component with other components.

untitled TS

® |4}

untitled P hd

untitled

EY ol

....... E Sensor Componentl

[

LT e N

Component2

i

P E OB E

Resize a Component
Resize a component by dragging corners.

1 Pause the pointer over a corner to see the double arrow.

Componenti

L

2 Click the corner and drag while holding the mouse button down. If you want to resize the
component proportionally, hold the Shift button as well.
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[T ]
Component1
0 '3%

3 Release the mouse button when the component reaches the size you want.
Delete a Component
Click a component and press Delete to delete it. To delete multiple components, select them while

holding the Shift key down, then press Delete.

Ports

A port is a node on a component or architecture that represents a point of interaction with its
environment. A port permits the flow of information to and from other components or systems.

There are different types of ports:

* Component ports are interaction points on the component to other components.

* Architecture ports are ports on the boundary of the system, whether the boundary is within a
component or the overall architecture model.

For example, a sensor might have data ports to communicate with a motor and a controller. Its input
port takes data from the motor, and the output port delivers data to the controller. You can specify
data properties by defining an interface as described in “Define Port Interfaces Between
Components” on page 3-2.

Add a Component Port

Represent the relationship between components by defining directional interface ports. You can
organize the diagram by positioning ports on any edge of the component, in any position.

1 Pause over the side of a component. A + sign and a port outline appear.

Sensor T

"

2 Click the port outline. A set of options appear for an Input, Qutput, or Physical port.
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1-10

Sensor

3  Select Output to commit the port. You can also name the port at this point.

Sensor

o -

q

An output port is shown with the *'icon, an input port is shown with the icon, and a physical

port is shown with the ' icon.
You can move any port to any component edge after creation.
Add an Architecture Port

You can also create a port for the architecture that contains components. These system ports carry
the interface of the system with other systems. Pause on any edge of the system box and click when
the + sign appears. Click the left side to create input ports and click the right side to create output
ports.
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Name a Port

Every port is created with a name. To change the name, click it and edit.

Componenti

—
gnEus

Ports of a component must have unique names.

Move a Port

You can move a port to any side of a component. Select the port and use arrow keys.

Arrow Key Original Port Edge Port Movement
Up Left or right If below other ports on the same
edge, move up, if not, move to
the top edge
Top or bottom No action
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Arrow Key Original Port Edge Port Movement

Right Top or bottom If to the left of other ports on
the same edge, move right, if
not, move to the right edge

Left or right No action

Down Left or right If above other ports on the same
edge, move down, if not, move
to the bottom edge

Top or bottom No action

Left Top or bottom If to the right of other ports on
the same edge, move left, if not,
move to the left edge

Left or right No action

The spacing of the ports on one side is automatic. There can be a combination of input and output
ports on the same edge.

Delete a Port

Delete a port by selecting it and pressing the Delete button.

Connections

Connectors are lines that provide connections between ports. Connectors describe how information
flows between components or architectures. A connector allows two components to interact without
defining the nature of the interaction. Set an interface on a port to define how the components
interact.

Connections are visual representations of data flow from an output port to an input port. For
example, a connection from a motor to a sensor carries positional information.

Connect Existing Ports

Connect two ports by dragging a line:

1 Click one of the ports.
Keep the mouse button down while dragging a line to the other port.

3 Release the mouse button at the destination port. A black line indicates the connection is
complete. A red-dotted line appears if the connection is incomplete.

Sensor Component

OutBus [ rmmmmm e e + I InBus
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You can take these steps in both directions — input port to output port, or output port to input port.
You cannot connect ports that have the same direction.

A connection between an architecture port and a component port is shown with tags instead of lines.

H|

@ [l [

O ®

v BB

untitled s3]
untitled 14 i
untitled
Sensor | Component1
OutBus = I InBus
b il InBus DutBus
Motor
InBus[p—{I> InBus
1)

Connect Components Without Ports

To quickly create ports and connections at the same time, drag a line from one component edge to

another. The direction of this connection depends on which edges of the components are used - left
and top edges are considered inputs, right and bottom edges are considered outputs. You can also

perform this operation from an existing port to a component edge.

Sensor | Componenti

OutBus [= _I_

You can create a connection between an edge that is assumed to be an input only with an edge that is
assumed to be an output. For example, you cannot connect a top edge, which is assumed to be an
input, with another top edge, unless one of them already has an output port.
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Branch Connections

Connect an output port to multiple input ports by branching a connection. To branch, right-click an
existing connection and drag to an input port while holding the mouse button down. Release the

button to commit the new connection.

Sensor Component1

CutBus [= [ ImBus

Create New Components Through Connections

If you start a connection from an output port and release the mouse button without a destination
port, a new component tentatively appears. Accept the new component by clicking it.

Sensor

OutBus

_I_

Importing Architectures

By combining the programmatic APIs of System Composer with MATLAB support for loading and
parsing many different file and databased formats, you can import external architecture descriptions
into System Composer. For details, see “Import and Export Architecture Models” on page 6-21.

You can setup a profile with stereotypes ahead of time to capture the architecture properties
represented in such descriptions. For details, see “Define Profiles and Stereotypes” on page 4-2.

Subsequently, you can use MATLAB programming to create and customize the various architectural
elements. For details, see “Build Architecture Models Programmatically” on page 1-23.
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See Also

Functions
createModel | addComponent | addPort | connect | exportModel | importModel

Blocks
Component

More About

“Decompose and Reuse Components” on page 1-16

“Create Interfaces” on page 3-4

“Describe System Behavior Using Sequence Diagrams” on page 5-25
“Organize System Composer Files in a Project” on page 1-37

“Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Decompose and Reuse Components

Every component in an architecture model can have its own design, or even several design
alternatives. These designs can be architectures modeled in System Composer or behaviors modeled
in Simulink. Engineering systems often use the same component design in multiple places. A common
component, such as power switch, can be part of all electrical components. You can reuse a
component in System Composer within the same model as well as across architecture models.

Decompose a Component

A component can have its own architecture. Double-click a component to view or edit its architecture.
When you view the component at this level, its ports appear as architecture ports. Use the Model
Browser to view component hierarchy.

[JRobot » [F]sensor ¥ hd

Sensor

GPS Gyro

OutBus

You can add components, ports, and connections at this level to define the architecture.

You can also make a new component from a group of components.

1 Select the components. Either click and drag a rectangle, or select multiple components by
holding the Shift button down.
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Position Controller Speed Controller Moter

ClutBues P InBus CarBus P InBus

Encodear

2  (Create a component from the selected elements by right-clicking and selecting Create
Component from Selection.

Component

PO A s KR RS

P PosCommand

DutBues B

As a result, the new component has the selected components, their ports, and connections as part of
its architecture. Any unconnected ports and connections to components outside of the selection
become ports on the new component.

Any component that has its own architecture displays a preview of its contents.

Create Reference Architecture

Some projects use the same, detailed component in multiple places, and require the design of such a
component to be tightly managed. You can create a reference architecture to reuse the architectural
definition of a component in the same architecture model or across several architecture models.
Create such a reference architecture using this procedure:

1 Right-click the Sensor component and select Save as Architecture Model.
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2 Provide a name for the model. By default, the reference architecture is saved in the same folder
as the architecture model. Browse for or type the full path if you want to save it in a different
folder.

Save component as an architecture model — O >
Save architecture model and, optionally, export local
interfaces to a new shared data dictionary.
New model name: |Sen5orReﬂ Browse...
From architecture template:
Default
New data dictionary name:
Cancel Help
3 System Composer creates an architecture model with the provided name, and links the
component to the new model. The linked model is indicated in the name of the component
between the <> signs.
Robot >
Robot

Sensor
< SensorRef = ] i Component1

"OutBus P> [> InBus

Motor

B InBus

All architecture models can reference this new architecture model through linked components.
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Use a Reference Architecture

You can use a reference architecture, saved in a separate file, by linking to it from a component.
Right-click the component and select Link to Model. You can also use the Create Reference option
in the element palette directly to create a component that uses a reference architecture.

To link a selected component to an existing architecture model, right-click the Trajectory
Planning component and select Link to Model.

Provide the full path to the reference architecture. If the linked component has its own ports and
components, this content is deleted during linking and replaced by that of the reference architecture.
The ports of the linked component become the architecture ports in the reference architecture.

Trajectory Planning
< planning_algarithm =

[ UserCommand
[» Obstaclelnfo path =

[» SensorData

Any change made in a reference architecture is immediately reflected in the models that link to it. If
you move or rename the reference architecture, the link becomes invalid and the linked component
displays an error. Link the component to a valid reference architecture.

Remove a Reference Architecture

In some cases, you have to deviate from the reference architecture for a single component. For
example, a comprehensive sensor model, referenced from a local component, may include too many
features for the motion control architecture at hand and require simplification for that architecture
only. In this case, you can remove the reference architecture to make local changes possible. Right-
click a linked component and select Inline Model.
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Trajectory Planning
<= planning_algarithm =

Explore
[ Obstaclelnfo

Open

[» SensorData

Open In New Tab

Open In New Window
Open As Top Model

& Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+V
Inline Model... I}

This operation provides two options:

» Interface and subcomponents — Ports, interfaces, and subcomponents of the reference
architecture are copied to the component.

» Interface only — The ports and designated interfaces of the reference architecture are reflected
on the component, but the composition is blank.

Once the reference architecture is removed, you can start making changes without affecting other
architectures. However, you cannot propagate local changes to the reference architecture. If you link
to the reference architecture again, local changes are lost.

To remove a Stateflow® Chart behavior, see “Remove Stateflow Chart Behavior from Component” on
page 5-19.

Create Variants

A component can have multiple design alternatives, or variants. A variant is one of many structural or
behavioral choices in a variant component. Use variants to quickly swap different architectural
designs for a component while performing analysis. A variant control is a string that controls the
active variant choice. Set the variant control to programmatically control which variant is active.

You can model variations for any component in a single architecture model. You can define a mix of
behaviors (defined in a Simulink model) and architectures (defined in a System Composer
architecture model) as variant choices. For example, a component may have two variant options that
represent two alternate structural decompositions.

Convert a Component to a Variant Component adding variant choices to the component. Right-click
the Sensor component and select Add Variant Choice.

The [# badge on the component indicates that it is a variant, and a variant choice is added to the
existing composition. Double-click the component to see variant choices.



Decompose and Reuse Components

<« ‘W RobotArch Sensor X Jivica]
@® |[7]robotarch ¥ [T]sensor P b
a4l |Is i
ensor (Variant)
D Sensor
Sensor
Cholce
E > Motioninfo SensorData [»
& Matianlnfo SensarData [> -
'
&= Mationinfo SensorData
Component
(i
« | o

Add Variant Choices

You can add more variant choices to a variant component using the Add Variant Choice option.
Open and edit the variant by right-clicking and selecting Variant > Open > <Variant Name> from
the component context menu.

You can also designate a component as a variant upon creation using the object in the toolstrip.

This creates two variant choices by default.

Activate a specific variant choice using the context menu of the block. Right-click and select Variant
> Label Mode Active Choice > <Choice (Component)>. The active choice is displayed in the
header of the block.
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Sensorsi

Variant1

il GF &<
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Explore

Open

OCpen In New Tab
Open In New Window

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+Vv
Delete Del

Add Variant Choice

Variant r Open b

Apply Stereotype Label Mode Active Choice ¥ Choice (Component)
Open in Variant Manager ~  Variant1 (Sensors)

Create Spotlight From Component I

Create Software Architecture from Component

You can create a software architecture model from a component in a System Composer architecture
model and reference the software architecture model from the component. You can use software
architectures to link Simulink export-function, rate-based, or JMAAB models to components in your
architecture model to simulate and generate code. For more information, see “Create Software
Architecture from Architecture Model Component” on page 7-5.

See Also

Functions
createArchitectureModel | LinkToModel | inlineComponent | addVariantComponent |
makeVariant | addChoice | setActiveChoice

Blocks
Reference Component | Variant Component

More About

. “Describe Component Behavior Using Simulink” on page 5-2

. “Describe Component Behavior Using Stateflow Charts” on page 5-16
. “Organize System Composer Files in a Project” on page 1-37

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Build Architecture Models Programmatically

Build an architecture model programmatically using System Composer™.

Build Model

To build a model, add a data dictionary with data interfaces, data elements, and value types, then add
components, ports, and connections. Assign an owned interface to a port. After the model is built, you
can create custom views to focus on specific considerations. You can also query the model to collect
different model elements according to criteria you specify.

Add Components, Ports, Connections, and Interfaces
Create a model and extract its architecture.

model = systemcomposer.createModel("mobileRobotAPI");
arch = model.Architecture;

Create an interface data dictionary and add a data interface. Add a data element to the data
interface. Add a value type to the interface data dictionary. Assign the type of the data element to the
value type. Link the data dictionary to the model.

dictionary = systemcomposer.createDictionary("SensorInterfaces.sldd");

interface = dictionary.addInterface("GPSInterface");

element = interface.addElement("SignalStrength");

valueType = dictionary.addValueType("SignalStrengthType", 'Units','dB', 'Description', 'GPS Signal
element.setType(valueType);

linkDictionary(model, "SensorInterfaces.sldd");

Save the changes to the interface data dictionary.

dictionary.save

View the interfaces in the Interface Editor.

Interfaces
S~ ok v ||gd v || /@ | il | |Eg +||Search (|| Dictionary View -
Type Units Description
~ @ Sensorinterfaces.sidd
~ & GPSInterface
SignalStrength (SignalStrengthType) SignalStrengthType dB GPS Signal Strength
] SignalStrengthType double dB GPS Signal Strength

Add components, ports, and connections. Set the data interface to ports, which you will connect later.
componentSensor = addComponent(arch, 'Sensor');

sensorPorts = addPort(componentSensor.Architecture,{'MotionData', 'SensorData'},{'in','out'});
sensorPorts(2).setInterface(interface)

componentPlanning = addComponent(arch, 'Planning');
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planningPorts = addPort(componentPlanning.Architecture,{'Command', 'SensorDatal', '"MotionCommand"'}
planningPorts(2).setInterface(interface)

componentMotion = addComponent(arch, 'Motion');
motionPorts = addPort(componentMotion.Architecture,{'MotionCommand', '‘MotionData'},{'in"', 'out'});

Create an owned interface on the 'MotionData' port. Add an owned data element under the owned
data interface. Assign the data element "Rotation" to a value type with units set to degrees.

ownedInterface = motionPorts(2).createInterface("DatalInterface");
ownedElement ownedInterface.addElement ("Rotation");
subInterface = ownedElement.createOwnedType('Units', 'degrees');

View the interfaces in the Interface Editor. Select the 'MotionData' port on the Motion component.
In the Interface Editor, switch from Dictionary View to Port Interface View.

Interfaces

A v |igd| v || /@ | |iEL|~ ||Bg ~ || Search Q[ Port Interface View -

Type Dimensions Units
* 'O MotionData
elem( double

Rotation double 1 degrees

Connect components with an interface rule and the default name rule. The interface rule connects
ports on components that share the same interface. By default, the name rule connects ports on
components that share the same name.

c_sensorData = connect(arch,componentSensor, componentPlanning, 'Rule',"interfaces");
c_motionData = connect(arch,componentMotion, componentSensor);
c_motionCommand = connect(arch,componentPlanning, componentMotion);

Add and Connect Architecture Port
Add an architecture port on the architecture.
archPort = addPort(arch, "Command","in");

The connect command requires a component port as an argument. Obtain the component port, then
connect.

compPort = getPort(componentPlanning, "Command");
c_Command = connect(archPort, compPort);

Save the model.

model.save
Open the model.

systemcomposer.openModel ("mobileRobotAPI");

Arrange the layout by pressing Ctrl+Shift+A or using this command.
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Simulink.BlockDiagram.arrangeSystem('mobileRobotAPI");

mobileRobat ¥

mobileRobot

t lCommand

Planning

Motion Sensor Commznd — &= Command

MotionCommand B

b MotionCommand MoticnData b b MoticnData SensorData b SensorData

Create and Apply Profile with Stereotypes

Profiles are XML files that can be applied to any model. You can add stereotypes with properties to
profiles and then populate the properties with specific values. Along with the built-in analysis
capabilities of System Composer, stereotypes help you optimize your system for performance, cost,
and reliability.

Create Profile and Add Stereotypes

Create a profile.

profile = systemcomposer.createProfile("GeneralProfile");

Create a stereotype that applies to all element types.

elemSType = addStereotype(profile, "projectElement");

Create stereotypes for different types of components. You can select these types are based on your
design needs.

pCompSType
sCompSType

addStereotype(profile, "physicalComponent", 'AppliesTo', "Component");
addStereotype(profile, "softwareComponent", 'AppliesTo', "Component");

Create a stereotype for connections.

sConnSType addStereotype(profile, "standardConn", 'AppliesTo', "Connector");

Add Properties

Add properties to the stereotypes. You can use properties to capture metadata for model elements
and analyze nonfunctional requirements. These properties are added to all elements to which the
stereotype is applied, in any model that imports the profile.

addProperty(elemSType, 'ID', 'Type', 'uint8');
addProperty(elemSType, 'Description', 'Type', 'string"');
addProperty(pCompSType, 'Cost', 'Type', "double', 'Units', 'USD");
addProperty(pCompSType, 'Weight', 'Type', 'double', 'Units', 'qg");
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addProperty(sCompSType, 'develCost', 'Type', 'double', 'Units', 'USD");
addProperty(sCompSType, 'develTime', 'Type', 'double', 'Units', "hour');
addProperty(sConnSType, 'unitCost', 'Type', 'double', 'Units','USD");
addProperty(sConnSType, 'unitWeight', 'Type', "double', 'Units','qg");
addProperty(sConnSType, 'length', 'Type', 'double', 'Units','m"');

Save Profile
profile.save;
Apply Profile to Model

Apply the profile to the model.
applyProfile(model, "GeneralProfile");

Apply stereotypes to components. Some components are physical components, while others are
software components.

applyStereotype(componentPlanning, "GeneralProfile.softwareComponent")
applyStereotype(componentSensor, "GeneralProfile.physicalComponent")
applyStereotype(componentMotion, "GeneralProfile.physicalComponent")

Apply the connector stereotype to all connections.
batchApplyStereotype(arch, 'Connector', "GeneralProfile.standardConn");
Apply the general element stereotype to all connectors and ports.

batchApplyStereotype(arch, 'Component',"GeneralProfile.projectElement");
batchApplyStereotype(arch, 'Connector',"GeneralProfile.projectElement");

Set properties for each component.

setProperty(componentSensor, 'GeneralProfile.projectElement.ID', '001");
setProperty(componentSensor, 'GeneralProfile.projectElement.Description', "' 'Central unit for all
setProperty(componentSensor, 'GeneralProfile.physicalComponent.Cost', '200");
setProperty(componentSensor, 'GeneralProfile.physicalComponent.Weight', '450");
setProperty(componentPlanning, 'GeneralProfile.projectElement.ID', '002"');
setProperty(componentPlanning, 'GeneralProfile.projectElement.Description’, "' 'Planning computer"’
setProperty(componentPlanning, 'GeneralProfile.softwareComponent.develCost', '20000");
setProperty(componentPlanning, 'GeneralProfile.softwareComponent.develTime', '300");
setProperty(componentMotion, 'GeneralProfile.projectElement.ID', '003");
setProperty(componentMotion, 'GeneralProfile.projectElement.Description', "' 'Motor and motor contr
setProperty(componentMotion, 'GeneralProfile.physicalComponent.Cost', '4500");
setProperty(componentMotion, 'GeneralProfile.physicalComponent.Weight', '2500"');

Set the properties of connections to be identical.

connections = [c_sensorData c _motionData c motionCommand c_ Command];

for k = 1l:length(connections)
setProperty(connections(k), 'GeneralProfile.standardConn.unitCost','0.2");
setProperty(connections(k), 'GeneralProfile.standardConn.unitWeight', '100");
setProperty(connections(k), 'GeneralProfile.standardConn.length','0.3");

end

Add Hierarchy

Add two components named Controller and Scope inside the Motion component. Define the ports.
Connect the components to the architecture and to each other, applying a connector stereotype.
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Hierarchy in an architecture diagram creates an additional level of detail that specifies how
components behave internally.

motionArch = componentMotion.Architecture;

motionController = motionArch.addComponent('Controller');

controllerPorts = addPort(motionController.Architecture,{'controlIn', 'controlOut'},{'in', 'out'})
controllerCompPortIn = motionController.getPort('controlIn');

controllerCompPortOut = motionController.getPort('controlOut');

motionScope = motionArch.addComponent('Scope');

scopePorts = addPort(motionScope.Architecture,{'scopelIn', 'scopeQut'},{'in','out'});
scopeCompPortIn = motionScope.getPort('scopeln');

scopeCompPortOut = motionScope.getPort('scopelut');

c_planningController = connect(motionPorts(1),controllerCompPortIn);

% For outport connections, the interface element must be specified

c_planningScope = connect(scopeCompPortOut,motionPorts(2), 'DestinationElement',"Rotation");
c_planningConnect = connect(controllerCompPortOut, scopeCompPortIn, 'GeneralProfile.standardConn"')
Save the model.

model.save

Arrange the layout by pressing Ctrl+Shift+A or using this command.

Simulink.BlockDiagram.arrangeSystem('mobileRobotAPI/Motion');

Motion

Controller Scope

b HfiMobonCommand MotionData i

MoticnCommandli— B controlln contralOut B [ scopeln scopeCut [ f@iMaotionData
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Create Model Reference

Model references can help you organize large models hierarchically and define architectures or
behaviors once that you can then reuse. When a component references another model, any existing
ports on the component are removed, and ports that exist on the referenced model will appear on the
component.

Create a new System Composer model. Convert the Sensor component into a reference component
to reference the new model. To add additional ports on the Sensor component, you must update the
referenced model "mobileSensor".

referenceModel = systemcomposer.createModel("mobileSensor");
referenceArch = referenceModel.Architecture;

newComponents = addComponent(referenceArch,"ElectricSensor");
linkDictionary(referenceModel, "SensorInterfaces.sldd");
referenceModel.save

linkToModel (componentSensor, "mobileSensor");

Sensor D
= mobileSensar =

[ MolionData SarmsorData [

Apply a stereotype to the architecture and component of the linked reference model.

referenceModel.applyProfile("GeneralProfile");
referenceArch.applyStereotype("GeneralProfile.softwareComponent");
batchApplyStereotype(referenceArch, 'Component', "GeneralProfile.projectElement")

Add ports and connections to the reference component.

sensorPorts = addPort(componentSensor.Architecture,{'MotionData', 'SensorData'},{'in','out'});
sensorPorts(2).setInterface(interface)

connect(arch, componentSensor, componentPlanning, 'Rule', 'interfaces');

connect(arch, componentMotion, componentSensor);

Save the models.

referenceModel. save
model.save

Make Variant Component

You can convert the Planning component to a variant component using the makeVariant function.
The original component is embedded within a variant component as one of the available variant
choices. You can design other variant choices within the variant component and toggle the active
choice. Variant components allow you to choose behavioral designs programmatically in an
architecture model to perform trade studies and analysis.

[variantComp,choicel] = makeVariant(componentPlanning);
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Add an additional variant choice named PlanningAlt. The second argument defines the name, and
the third argument defines the label. The label identifies the choice. The active choice is controlled by
the label.

choice2 = addChoice(variantComp,{'PlanningAlt'},{'PlanningAlt'});

Create the necessary ports on PlanningAlt.

setActiveChoice(variantComp, choice2)

planningAltPorts = addPort(choice2.Architecture,{'Command', 'SensorDatal', 'MotionCommand'},{'in",
planningAltPorts(2).setInterface(interface)

Make PlanningAlt the active variant.

setActiveChoice(variantComp, 'PlanningAlt"')

Arrange the layout by pressing Ctrl+Shift+A or using this command.

Simulink.BlockDiagram.arrangeSystem( 'mobileRobotAPI/Planning');

Planning (Variant)

Planning
Command
MotisnCommand
PlanningAlt
B Comrmand
SensorDatal MotionCommand [
[ SensorDatat
= oh

Save the model.
model.save

Clean Up

Uncomment this code and run it to clean up the artifacts created by this example.

bdclose('mobileRobotAPI')
bdclose('mobileSensor')
Simulink.data.dictionary.closeAll
systemcomposer.profile.Profile.closeAll

o® o° o° o°
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%

elete('Profile.xml"')

d
delete('SensorInterfaces.sldd')

%

See Also

Functions

createModel | createDictionary | addInterface | addValueType | addElement | setType |
createOwnedType | LinkDictionary | addComponent | addPort | setInterface | connect |
save | getPort | createProfile | addStereotype | addProperty | save | applyProfile |
applyStereotype | batchApplyStereotype | setProperty | lLinkToModel | makeVariant |
addChoice | setActiveChoice | closeAll

Blocks
Component | Reference Component | Variant Component

More About

. “Compose Architecture Visually” on page 1-2
. “Define Profiles and Stereotypes” on page 4-2
. “Use Stereotypes and Profiles” on page 4-9

. “Decompose and Reuse Components” on page 1-16
. “Create Interfaces” on page 3-4
. “Organize System Composer Files in a Project” on page 1-37

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Modeling System Architecture of Small UAV

Overview

This example shows how to use System Composer to set up the architecture for a small unmanned
aerial vehicle, composed of six top-level components. Learn how to refine your architecture design by
authoring interfaces, inspect linked textual requirements, define profiles and stereotypes, and run a
static analysis on such an architecture model.

Open the project.
>> scExampleSmallUAV

Starting: Simulink

scExampleSmallUAVModel

Flight Support Components

portDats
D
ADSBData

Payload Data Link[{>

GPSDataGPSSup;

ADSBData

I operatorCmds Data Link ) —4@Dats Link

FlightComputer

Propulsion
Payload Cmds B Airframe

ghtCmds [ B lightCmds

Telemetry >
SupervisoryComputer

P FuelData

B EngineStatus

Copyright 2018 The MathWorks, Inc.

Each top-level component is decomposed into its subcomponents. Navigate through the hierarchy to
view the composition for each component. The root component, scExampleSmallUAVModel, has
input and output ports that represent data exchange between the system and its environment.

Author Interfaces

Define interfaces for domain-specific data between connections. The information shared between two
ports defined by interface element property values further enhances the specification. In the
Modeling tab in the toolstrip, select Design, then click Interface Editor.
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Click the GS Commands port on the architecture model to highlight the
architecture_gsCommands interface and indicate the assignment of the interface.

S <

@M

7]

ol o Payload

© a

- ‘E M

2 58| & -

o < < > operatorCmds
F v v & £

FlightComputer

GS Commands [ [\/_%GS Commands

< dT

ST,

> EngineStatus

Payload Cmds P

.

Contral Surface Cmds B>

Airframe

Winy|

B ctriSricDeflection

Lo
[ FuelLevel ___ ’
Tail n
lightCmds > [> lightCmds
> PwrStatus
>
0 £
&
o
ES
Interfaces ?
’EEHX@_H@_‘ ’F”;‘ ; - @lSeamh L.{“ Dictionary View - |
Type Dimensions Units Complexity Minimum Maximum Description
- 5'9 scExampleSmallUAVModel.six
Iﬁ architecture_gsCommands
~ apConfigParams (param_value_bus) | param_value_bus 1 real n 0
param_count uint16 1 real n 0 Total number of onboard parameters
param_id int8 16 real n 0 Onboard parameter id, terminated by NULL if the length is less than 16 human-|
param_index uint16 1 real i} ] Index of this onboard parameter
param_type uintg 1 real i} ] Onboard parameter type: see the MAV_PARAM_TYPE enum for supported datg]
param_value single 1 real i} ] Onboard parameter value
~ gsCommands (gs_commands_bus) gs_commands_bus 1 real 0 0
RTB uintd 1 real n 0 Return to Base Command
Uce single 1 real n 0 Airspeed Commanded by the GS
guidanceMode uintd 1 real n 0
h_c_midLevel single 1 real i} ] Commanded altitude when in Mid Level Commands Mode. Also used as the alti
isManualModeOn uintg 1 real i} ]
psiDot_c_mdiLevel single 1 real i} ] Turnrate command when in mid Level Commands guidance mode

Inspect Requirements

A Simulink Requirements license is required to inspect requirements in a System Composer
architecture model.
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Components in the architecture model link to system requirements defined in
smallUAVReqs.slregx. Open the Requirements Manager. In the bottom right corner of the
model pane, click Show Perspectives. Then, click Requirements.

Enter perspective

C

Ll

Code

Enter perspactive

Requiremeants

Select components on the model to see the requirement they link to, or, conversely, select items in the
Requirements view to see which components implement them. Requirements can also be linked to

connectors or ports to allow traceability throughout your design artifacts. To edit the requirements in
smallUAVRegs.slreqx, select the Requirements Editor from the menu.

The Carrying Capacity requirement highlights the total mass able to be carried by the aircraft.
This requirement, along with the weight of the aircraft, is part of the mass rollup analysis performed
for early verification and validation.

Requirements - scExampleSmallUAYModel 4
View: |Requirements ~ | [ 3 H & E = S
A~
& 1.1.11 #25 Flight Computer
= 1.1.12 #4 Enduance
¥ E 12 #11 Communications
E 1.2.1 #12 Flight Control
= 1.2.2 #13 Payload
¥ E 1.3 #14 Payload Capabilities
B 131 #17 Carrying Capacity
= 1.3.2 #16 Payload Bay Capacirty
E 133 #18 Default Payload b
£ >

Define Profiles and Stereotypes

To complete specifications and enable analysis later in the design process, stereotypes add custom
metadata to architecture model elements. This model has stereotypes for these elements:

* On-board element, applicable to components

* RF connector, applicable to ports

* RF wiring, applicable to connectors
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Stereotypes are defined in . xm1 files by using Profiles. The profile UAVComponent.xml is attached to
this model. Edit a profile by using the Profile Editor. On the Modeling tab, click Profile Editor.

The display appears below.

[=] System Compaoser Profile Editor - m] X
-~
=/ System Composer Profile Editor
Describe architecture profiles, stereotypes and custom property sets for use with System Compeser architecture models show more...
Profile EE New Profile —j] Open | | | Save |« Stereotype EE} New Stereotype 2@ Import into | Select | @
Profile Browser Stereotype Properties
Filter profiles: | <all> - Name: ‘OnboardElement |
Applies to: | Component - =2 Icon &
v [=] UAVComponent
*% OnboardElement Base stereotype: | <nothing> -
= RFConnector
RFWiring [ Abstract sterectype
Description: |Represents the base component of UAVComponent
} Default Stereotypes for Composition
ar % v
Property name Type Name Unit Default
1 Mass double ¥ [nfa kg 0
2 Power double T [nfa mW 0
3 RFHarnessLength double ~|n/a cm 0
[ show inherited properties (read-only)
v

Analyze the Model

To run static analyses on your system, create an Analysis Model from your architecture model. An

Analysis Model is a tree of instances generated from the elements of the architecture model in which
all referenced models are flattened out, and all variants are resolved.

Click Analysis Model on the Views menu.

Run a mass rollup on this model. In the dialog, select the stereotypes that you want to include in your

analysis. Select the analysis function by browsing to utilities/massRollUp.m. Set the model
iteration mode to Bottom-up.
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Instantiate Architecture Model >

Description

Create an instance model from this architecture model by flattening out all referenced models and their components. Such an ©)
instance model may be used for system-level analysis expressed as MATLAB functions. E

Step 1: Select Stereotypes Step 2: Configure Analysis
Select the sterectypes to make available on Function
the instance model Analysis function:
[massRollup |13 |4 @
A UAVComponent Function arguments (comma-separated):
OnboardElement | |
RFConnectar
i »» massRollUp(instance
RFWiring P )
Model Iteration
Iteration Order: |Bottom-up -
Instance Model Properties
Mame: |scExampleSmallUA\.fM0del
[ Normalize Units
[] Strict Mode
Don't see your profile? |Profile Editor ... 23 Cancel p Instantiate

Uncheck Strict Mode so that all components can have a Mass property instantiated to facilitate
calculation of total mass. Click Instantiate to generate an analysis.
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I=7 Instances Mass Power RFHarnessLength Length
4 [ scExampleSmallUAVModel 15.462 0 0
4 [ Airframe 9.25 0 0
o Fuselage 1.7 0 0
o LandingGear 1.65 0 0
g Tail and Boom 27 0 0
o Wings 32 0 0
= Airframe:ctrlSricDeflection-=LandingGear:Brake i[5=
= Airframe:ctrlSricDeflection->Tail and Boom:dR_dE =
+= Airframe:ctriSricDeflection-=Wings:dA_dF 0%
= Airframe:lightCmds->Tail and Boom:Landing Strobe =
= Airframe:lightCmds->Wings:MNavigation Lights =
4 E Flight Support Components 0.629 0 0
4 [ ADSB Module 0.156 0 0
O ABDSE Antenna 0.058 0 0
o ADSE Board 0.093 0 0
= ADSB Board:RF Signal->ABDSB Antenna:RF Signal 7505
= ADSB Module:ADSBData->ADSE Board:ADSBData iE=
4 [ GPS Module 0.398 0 0
O GPS Antenna 0.128 0 0
o GPS Board 0.27 0 0
= GPS Board:GPSData->GPS Module: GPSModeuleData 1E=
= GPS Board:RFSignal-=GPS Antenna:RFSignal RLi=
o Pitot Tube Module 0.075 0 0
= Flight Support Components:ADSBData->ADSE Module:ADSBData I[E=
= GPS Module:GPSModeuleData->Flight Support Components:GPSSupportData I[=
= Pitot Tube Module:AirData->Flight Support Components:AirData I[=
4 [(3 FlightComputer 0.388 0 0
o Main Board 0.145 0 0
O Protective Case 0.195 0 0
o Telemetry Antenna 0.048 0 0
= FlightComputerAirData->Main Board:AirData 0

Once on the Analysis Viewer screen, click Analyze. The analysis function iterates through model
elements bottom up, assigning the Mass property of each component as a sum of the Mass properties
of its subcomponents. The overall weight of the system is assigned to the Mass property of the top
level component, scExampleSmallUAVModel.

See Also
setInterface | createProfile | addStereotype | addProperty | applyStereotype |
instantiate

More About

. “Create Interfaces” on page 3-4

. “Manage Requirements” on page 2-8

. “Define Profiles and Stereotypes” on page 4-2

. “Analyze Architecture” on page 6-10

. “Organize System Composer Files in a Project” on page 1-37
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Organize System Composer Files in a Project

Use projects to organize your work, manage files and settings, and interact with source control.
Using System Composer generates multiple files, including but not limited to:

e Architecture models (.s1x)

* Simulink Requirements™ links (. slmx) and requirement sets (.slregx)

» Allocation sets (.mldatx)

» Profiles (.xml)

» Interface data dictionaries (.sldd)

o Simulink Test™ files (.mldatx)

* MATLAB functions (.m) and live scripts (. mlx)

¢ Simulink behavior models (.s1x)

To help organize these files, use projects.

Use Projects to Organize Files and Folders
Create a project from a folder with supporting files and folders.

For example, this folder structure represents typical steps in the process of model-based systems
engineering: models, profiles, interfaces, requirements, tools, tests, livescripts

The models folder can include architecture models, Simulink behavior models, and requirement
links. If architecture models and behavior models are constructed separately, you can split the
models folder into two folders, architectures and simulation, and decompose the folders
further to represent the different stages of architectural model-based design. The tools folder can
include functions and scripts for trade studies and analyses.

1 In MATLAB, navigate to the directory where your model files and artifacts are located.

2 Select New > Project > From Folder. Enter a name for your project.

4\ MNew Project >

Project name: |SpaceCraftMBSESeries

Project folder: Documents' Projects\ Workflow Examples\SpaceCraftMBSESer| 13

Create Cancel

3 The files in the folder you specify are added to the project, and the Project menu appears. To
generate your own project shortcuts, on the Project Shortcuts tab, click New Shortcut or
Organize Groups.

4  You can open the project again using the generated . prj file in your directory.
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Project - SpaceCraftMBSESeries
Views

f&, Dependency Analyzer

Labels ~
Git A

Current branch: master
Branch status: Mormal
Coincident with /origin/master

Al

=

Project (76) | Modified (3)

Name
livescripts
5| BatterySolarArmraySizingAnalysis.mb
E‘ groundTrackVisualization.mix
15| Overview.mb
5] powerRollUpDeme.mix
models
requirements
%3] ACSRequirements.slreqx
| | CubeSatRequirements.reqif
4| OMGRefArchModel.slmx
[%] PowerSystemRequirements.siregx
|| SystemRequirements.sireqx
resources
tests

+myTestPkg
3] groundCoverageMLTest.m
|#| groundCoverageMLTest.simx
|4 systemTests.mldatx
%] systemTests.slmx
tools
work

=] .gitattributes

=l .gitignore

|| README.md

| =1 SpaceCraftMBSESeries.prj

LRSS IR IR
]

0r

We &%

Classification

Design
Design
Design
Design

Design

Test

Git

pIY

® x

Layout: | Tree ~ a-

Any changes you make will be organized in the project. You can manage changes to files with multiple
contributors using source control. For more information on source control with projects, see “About
Source Control with Projects”.

To illustrate file dependencies across the project, use the Dependency Analyzer. For more
information, see “Dependency Analysis for Projects”. To check and upgrade the project, use the Run
Checks option.

See Also

More About

. “Project Management”
. “Modeling System Architecture of Small UAV” on page 1-31

. “Modeling System Architecture of Keyless Entry System” on page 8-26
. “Allocate Architectures in Tire Pressure Monitoring System” on page 6-5

1-38




Requirements

* “Link and Trace Requirements” on page 2-2
* “Manage Requirements” on page 2-8



2 Requirements

Link and Trace Requirements

2-2

This example shows how to work with requirements in an architecture model.

Allocate functional requirements to components to establish traceability. By creating a link between a
component and the related requirement, you can track whether all requirements are represented in
the architecture. You can also keep requirements and design in sync, for example, if a requirement
changes or if the design warrants a revision of the requirements. You can link components to
requirements in Simulink® Requirements™, test cases in Simulink Test™, or selections in MATLAB®,
Microsoft® Excel®, or Microsoft Word.

A Simulink Requirements license is required to link, trace, and manage requirements in System
Composer™.

Open the model exMobileRobot.
systemcomposer.openModel ( 'exMobileRobot');

Manage requirements and architecture together in the Requirements Manager from Simulink
Requirements. Navigate to Apps > Requirements Manager. You are now in the Requirements
perspective in System Composer.



Link and Trace Requirements

g exMobileRobot B E
S| ® |[E]exmobilerobot A g
] =
2 g
= | & exMobileRobot ‘5
IEI Communication a Command 1= m‘
D [#25: Docking station Ey - -
[P —— b Sensdfaty Fasdback o —qiFesdback SansorData 4 b INBEE™  SanscrData [
kil
- A A A
'l 2 u
E g [E1- Mafion L] g
, . 5
Docking | = [ ] 2 Feadback b
: Battery | _lllulnr |
I‘_f' 5: Budgets 5
"]\ MELERIER CuiBlus b b InBus MotianDiata b
|
| W MPLEMEN
&15: Battery life i
[T
» | ke =
a s
Requirement links - exMobileRobot P x

P = &

Labe Source Type Destination
hd |l'£| exMobileRobiot.slm:x Changed source: 0/12 Changed destination: 0/12
59 Communication (MobileRobotRe... Communication Implements Communication
59 Maotion (MobileRobotRequireme...  exMobilzRobot Implements Maotion
5-7 Audible signals (MobileRobotRe...  AlertGeneration Implements Audible signals
59 Trajectory Planning (MobileRob... Command Implements Trajectory Planning
C’ Battery life (MobileRobotReguire... Battery Implements Battery life
5-7 Sensing (MobileRobotRequirem...  Command Implements Sensing
59 Obstacle reaction (MobileRobot... Command Implements Obstacle reaction
C’ Sensing (MobileRobotRequirem...  Sensor Implements Sensing
C-') Absolute position sensing (Mobil... GPS Implements Absolute position sensing
59 Budgets (MobileRobotReguirem...  exMobileRobot Implements Budgets
C’ Docking station (MobileRobotRe...  exMobileRobot Implements Diocking station
59 Battery charging (MobileRobotR... Battery Implements Battery charging
Ready 80% VariableStepAuto

Links can be created and managed through the Requirements perspective. For more information, see
“Manage Requirements” on page 2-8. This example shows an alternative approach using the
Requirements Editor.

Open the requirements in the Requirements Editor.

slreq.open('MobileRobotRequirements');

Select the requirement to be linked.
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Requirement: #10

Inde IC Details
Al |h| MobileRobotRegquirements * Properties
v E1 #1 Motion Type: Functional -
B 11 #6 Top speed Index: -
B 12 #7 Load capacity T |:1:
B 13 #8 Position accuracy
Summary: |Audib|e signals
> B 2 #4 Trajectory Planning
v E 3 #2 Communication Description | Rationale
v B 31 %10  Audible signals b | Ava viw v|B 7z U ]l E = = =
E 311 #18 Path error Device shall convey operation errors via audible signals.
E 312 =#19 Mechanical errar
E 313 #20 Battery drain
> B 3.2 #16 Command interface
> B 4 #3 Obstacle avoidance
> B s #23 Power
> El 6 #5 Budgets

Keywords:

» Revision information:

¥ Links

El ¢= Implemented by:
D AlertGeneration

Select the component to be linked in the architecture model. Right-click and select Requirements >

Link to Selection in Requirements Browser.
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Link and Trace Requirements

Explore
Open In New Tab

Open In New Window

4 cut Ctrl+X
By cCopy Ctrl+C
[ Ppaste Ctrl+V

Save As Architecture Model...
Create Software Architecture Maodel...
Link to Model...

Add Variant Choice

Apply Stereatype b

Create Spotlight From Component

Format

1. "Sensing"

Link to Selection in MATLAB Editor

Link to Selection in Word
Link to Selection in Excel

Select for Linking with Simulink
Add Link to Selected Object(s)

Open Outgoing Links dialog ...
Delete All Qutgoing Links ..

Copy URL to Clipboard

When you first link a requirement in an architecture model, a link set file with extension .slmx is
created to store requirement links. The Requirements context menu displays the linked
requirements.

You can also create a link using the Requirements Editor. First, select the component in the
architecture model. Then, in the Requirements Editor, right-click the requirement and select Link
from "<Component Name>" (Component).

2-5



2 Requirements

u Requirement: #2

Details
w %] MobileRobotRequirements ~ Properties
v E1 #1 Mation Type: Functiona] -
B 11 #6 Top speed Indec: 3
B 1z #7 Load capacity Custom ID: |2
B 13 #8 Position accuracy
Summary: |Comrnunication
E 2 #4 Trajectory Planning
viE 3 #2 Communication Description Rationale
v B 31 #10 Audible sigr Cut Ctrl+X
El 311 #18  Pathermor Copy Cirl+C
E 312 #19  Mechanical [eEE Ctrl+V
B 313 #20  Baterydra Tass Del
E 32 #16 Command i Add Child Requirement
E 4 #3 Obstacle av Add Requirement after
B s #23 Power Move up
B s #5 Budgets Mave down
Expand All
Collapse All

Link from "Communication” (Component)
Link from Selected Architecture View Element D?

Select for Linking with Requirement

=

You can also create requirement links with blocks and subsystems in Simulink models. for more
information, see “Link Blocks and Requirements” (Simulink Requirements).

The =l badge on a component indicates that it is linked to a requirement. This badge also shows at

the lower-left corner of the architecture model.

Sensor

L%]

> InBUs

SensorData >




Link and Trace Requirements

To trace requirement links to a component, right-click the Command component and select
Requirements > Open Outgoing Links dialog. Here, you can create new requirements, delete
existing ones, and change their order.

Outgoing Links: Comrmand >
Requirements  Document Index
New Trajectory Planning (MobileRobotRequirements#4)
Sensing (MobileRobotRequirements#29)
Up Obstacle reaction (MobileRobotRequirements£30)
Down
Delete
Copy
Description: |Traject=:+r\,-' Planning (MobileRobotRequirements#4) |
Document type: | Requirement Set = Use current
Document: | MobileRobotRequirements.slregx ~ Browse...
Location: ;
(Type/Identifier) Named item #4 |
Keywords: | W |
Cancel Help Apply
See Also

updateLinksToReferenceRequirements

More About

. “Manage Requirements” on page 2-8

. “Organize System Composer Files in a Project” on page 1-37

. “View Simulink Requirements Links Associated with Model Elements”

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Manage Requirements

Requirements are a collection of statements describing the desired behavior and characteristics of a
system. Requirements ensure system design integrity and are achievable, verifiable, unambiguous,
and consistent with each other. Each level of design should have appropriate requirements. A
Simulink Requirements license is required to link, trace, and manage requirements in System
Composer.

To enhance traceability of requirements, link system, functional, customer, performance, or design
requirements to components and ports. Link requirements to each other to represent derived or
allocated requirements. Manage requirements from the Requirements Manager on an architecture
model or through custom views. Assign test cases to requirements using the Test Manager for
verification and validation. A Simulink Test license is required to use the Test Manager and to create
test harnesses for components in System Composer.

A requirement set is a collection of requirements. You can structure the requirements hierarchically
and link them to components or ports. Use the Requirements Editor to edit and refine requirements
in a requirement set. Requirement sets are stored in . slreqx files. You can create a new
requirement set and author requirements using Simulink Requirements, or import requirements from
supported third-party tools.

A link is an object that relates two model-based design elements. A requirement link is a link where
the destination is a requirement. You can link requirements to components or ports. View links using
the Requirements perspective in System Composer. Select a requirement in the Requirements
Browser to highlight the component or the port to which the requirement is assigned. Links are
stored externally as .slmx files.

Mobile Robot Architecture Model

This example shows a mobile robot platform architecture.

Manage Requirements
Manage requirements and architecture together in the Requirements Manager from Simulink

Requirements. Navigate to Apps > Requirements Manager. You are now in the Requirements
perspective in System Composer.
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exMobileRobot it
® | exMobileRobot P ¥
@ | exMobileRobot
IE [le‘lﬂl‘ﬂﬁn |-q Command ‘i _Eumr _i
D b Sensdfifala Feedback :~ —ifiFeedback SensarDaka ‘.. b IndiliE Lanzaiia b
& Fs &
- -
Decking l;: @: a Feedoack{ >
= :
E
Battery L |Ilutnr
Ousius b P oinBus  MotionData b
R
L
Requirements - exMobileRobot L
View: |Requirements ~ | | %k 3 l@—‘ Search
s
Index 1D summa
bt |h| MaobileRobotRequirements
» B 1 #1 Mation
» B 3 #2 Communication
> E 4 #3 Obstacle avoidance
> E 2 #4 Trajectory Planning
» B 6 #5 Budgets
> B 5 #23 Power

Trace Requirements

When you click a component in the Requirements perspective, linked requirements are highlighted.
Conversely, when you click a requirement, the linked components are shown.
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'g exMobileRobat B
2| & |E)exmobilerabot b v
)
-l
= | @ | |exMobileRobot
D Communication = Command = Sensor |
EES: Docking station 3 - . ~ ~
E "T\ MPLEMENT b SensorDals Feedback b | —diFesdback SensorDala < (N SehsorDals
Y & &
A 4 F a
g [ Mafien Y a
A g
2
Diseking Battery = Motor Feedback [ [+
[5: Budgets B
I:l " u CutBus [ > InBus  MotionData [
i#15: Battary life 1
[F
« |leh/S
A ] |
Requirements - exMobileRobot ?
view: [reauremenss ~ | [53]|0][@] [E] - (=] [4[&] (@ [[€
A
v (%] MobileRobotRequirements
B 1 #1 Mation
B 2 #4 Trajectory Planning
E 3 #2 Communication
E 4 #3 Obstacle avoidance v

Requirements Traceability Diagram

Visualize traceability of requirements and how they are related using a traceability diagram. For
more information, see “Visualize Links with a Traceability Diagram” (Simulink Requirements).

Change the View option on the Requirements Manager from Requirements to Links. Right-click
the Trajectory Planning requirement link and select View Traceability Diagram.
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I Trajectory Planning ‘ ‘ —I Sensing ‘ ‘ | Obstacle reaction

Implements Implements

Implements

D Command

According to this traceability diagram, the Command component implements the three requirements
Trajectory Planning, Sensing, and Obstacle reaction.

Change the View option on the Requirements Manager from Links back to Requirements.

Link Requirements

To directly create a link, drag a requirement onto a component or port.
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B

........

Battery

[l

QutBus [

(2] Bl [

|
Y IMPLEMENTS
l#15: Battery life Ly

O B &

iz

L4

L=}
5

Reguirements - exMobileRobot

View: |Requirements ~ | [% O - E=] d ﬁl (Ey

v E 4 #3 Obstacle avoidance
E 41 #29 Sensing
El 42 #30 Obstacle reaction
v E s #23 Power
B 5.1 #15 Battery life
El 52 b #25 Docking station

You can close the annotation that shows the link as necessary. This action does not delete the link.

You can exit the Requirements perspective by clicking the perspectives menu on the lower-right
corner of the architecture model and selecting Exit perspective.
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@

e EEs

O B

-]

exMobileRobot

exMobiIeRobot 14

« | B

exMobileRobot
Communication = Command = Sansor E|
[#25: Docking station 3
I Seasorata Fesdback [ —F sedback SensorData < > WBOE  SehsorDels b
] fea: Mofion ] 2
Docking Battery El Motor Feedback [+
[.!'5 Budgeis \
i OuiBus > [ InBus ModionData [
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L I ]
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e Review Manager Requiremen

For more information on managing requirements from external documents, see “Manage Navigation
Backlinks in External Requirements Documents” (Simulink Requirements). To integrate the
requirement links to the model, see “Update Reference Requirement Links from Imported File”.

Verify and Validate Requirements Using Test Harnesses on
Components

Use Simulink Test to perform requirement-based testing workflows that include inputs, expected
outputs, and acceptance criteria. For more information on using Simulink Test with Simulink
Requirements, see “Link to Test Cases from Requirements” (Simulink Requirements).

Create a test harness for a System Composer component to validate simulation results and verify
design. For more information, see “Create a Test Harness” (Simulink Test). The Interface Editor is
accessible in System Composer test harness models to enable behavior testing and implementation-
independent interface testing.

Note Test harnesses are not supported for Adapter blocks in architecture models or Component
blocks that contain reference components in software architecture models.

This example uses the architecture model for an unmanned aerial vehicle (UAV) to create a test
harness for a System Composer component. In the MATLAB Command Window, enter this command.

scExampleSmallUAV

To create a test harness for the Airframe component, right-click the component and select Test
Harness > Create for 'Airframe’.In the Create Test Harness dialog box, specify the name of

2-13



2 Requirements

your test harness and click OK. Your test harness opens in a new window, and the Harness menu is
available in the toolstrip.

Tip If the model component is not fully wired and in an early step in the design process, you can
select the Advanced Properties tab in the Create Test Harness dialog box and select Create
without compiling the model.

scExampleSmallUAVModel_Hamess1 HEEH
@® |[*&|scExamplesmalluavMaodel_Harness1 P -
&
= 2 >
L ciiSricDeflection
7]
L] (2} - lightCmds
[l
[ 1]
Signal spec. Airfrarme
and routing
» ||EHE
[[1 ]

Use the Test Manager with the test harness to create test files and test cases. For more information,
see “Test Harness and Model Relationship” (Simulink Test) and “Create Test Harnesses and Select
Properties” (Simulink Test).

See Also
updateLinksToReferenceRequirements

More About

. “Link and Trace Requirements” on page 2-2

. “Link Blocks and Requirements” (Simulink Requirements)

. “Import and Export Architectures” on page 6-19

. “Compose Architecture Visually” on page 1-2

. “Organize System Composer Files in a Project” on page 1-37
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Interface Management

* “Define Port Interfaces Between Components” on page 3-2
* “Create Interfaces” on page 3-4

* “Assign Interfaces to Ports” on page 3-9

* “Interface Adapter” on page 3-15

* “Manage Interfaces with Data Dictionaries” on page 3-19
+ “Reference Data Dictionaries” on page 3-22
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Interface Management

Define Port Interfaces Between Components

3-2

A system engineering solution in System Composer includes a formal definition of the interfaces
between components. A connection shows that two components have an output-to-input relationship,
and an interface defines the type, dimensions, units, and structure of the data.

A data interface defines the kind of information that flows through a port. The same interface can be
assigned to multiple ports. A data interface can be composite, meaning that it can include data
elements that describe the properties of an interface signal. Data interfaces represent the
information that is shared through a connector and enters or exits a component through a port. Use
the Interface Editor to create and manage data interfaces and data elements and store them in an
interface data dictionary for reuse between models.

A data element describes a portion of an interface, such as a communication message, a calculated or
measured parameter, or other decomposition of that interface. Data interfaces are decomposed into
data elements:

* Pins or wires in a connector or harness.
* Messages transmitted across a bus.
* Data structures shared between components.

A value type can be used as a port interface to define the atomic piece of data that flows through that
port and has a top-level type, dimension, unit, complexity, minimum, maximum, and description. You
can also assign the type of data elements in data interfaces to value types. Add value types to data
dictionaries using the Interface Editor so that you can reuse the value types as interfaces or data
elements.

Use interfaces to describe information transmitted across connections through ports between
components.

* “Create Interfaces” on page 3-4: Design interfaces and nested interfaces in the Interface Editor
with data interfaces, data elements, and value types.

* “Assign Interfaces to Ports” on page 3-9: Assign data interfaces and data elements to ports.
Define owned interfaces local to ports.

* “Manage Interfaces with Data Dictionaries” on page 3-19: Save external interface data
dictionaries to reuse between different models, link data dictionaries to architecture models, and
delete data interfaces from data dictionaries.

+ “Reference Data Dictionaries” on page 3-22: Reference data dictionaries so you can selectively
share interface definitions among models. Manage referenced data dictionaries in the Model
Explorer.

* “Interface Adapter” on page 3-15: Use an Adapter block to help connect two components with
incompatible port interfaces by mapping between the two interfaces. Use the Interface Adapter
dialog by double-clicking the Adapter block to map between interfaces, apply an interface
conversion that breaks algebraic loops with unit delays, or insert a rate transition for different
sample time rates.

The architecture model below represents an adapter, an interface data dictionary, a data interface, a
data element, and a value type.
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archModel X Roobat

[ archModel ¥

&
(sl
R
3
|
B
=
Power Robot
Choice
= PowerSourcep— > PowerSource Wireln B> e Rl Bl > WireOut —
'E' adapter Y
]
= | & .
2 >
Interfaces L -
&= % @] & -]@-]@] [&]-]Ee~][searen Q[ ictionary view -
interface data dictionary Type Dimensions Units
= @ archDictionary.sidd
* & Charger data interface
Voltage (VoltageType)  data element ValtageType w
Wiring doubie m
[ voltageType value type double w
+* & RobotFower
RobofVoitage (Voltage Type) VoiltapeType W
Wires double m

Note System Composer interfaces mirror Simulink interfaces that use buses and value types. For
more information, see “Simplify Subsystem and Model Interfaces with Buses”, “Specify Application-
Specific Signal Properties”, and “Describe Component Behavior Using Simulink” on page 5-2.
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Create Interfaces

3-4

In this section...

“Mobile Robot Architecture Model” on page 3-4
“Open the Interface Editor” on page 3-4
“Create Composite Data Interfaces” on page 3-5
“Create Value Types as Interfaces” on page 3-6
“Nest Interfaces to Reuse Data” on page 3-7

You can create interfaces between components in System Composer to structure transmitted data.
Use composite data interfaces with data elements or value types to manage data defined on ports.
Assign a data interface or value type to a data element so the data element inherits attributes and
reuses data. Use the model below as a starting point before adding interfaces using the Interface
Editor.

For interfaces terminology, see “Define Port Interfaces Between Components” on page 3-2.

To manage interfaces shared between models in data dictionaries, see “Manage Interfaces with Data
Dictionaries” on page 3-19.

Mobile Robot Architecture Model

This example shows a mobile robot platform architecture.

Open the Interface Editor

To open the Interface Editor, navigate to Modeling > Design > Interface Editor. The Interface
Editor will open at the bottom of the canvas.
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exMobileRobot B
@® |exMobilerobot ¥ hd
@ exMobileRobot
Communication Command Sensor
E b SenzoData Feedback [ .Fee-:lt-ack SensorData B InB3s SensorData [
A A A
@ ] o
Docking ? ? E Feedback [+ b
=
| Battery Motor
OutBus f» [ InBus MotionData [»
[T
» [ aha
Interfaces L
< &~ - |B® v|| Search L_g|| Dictionary View - |
Type Dimensions Units Complexity Minimum Maximum Description
@ exMobileRobot slx

Note The System Composer Interface Editor is a web-based widget and might appear blank when
you first launch it. If this occurs, save the model and relaunch MATLAB with the command line option
-cefdisablegpu.

Create Composite Data Interfaces

[ra—
To add a new data interface definition, click the =& icon. Name the data interface sensordata.

* @ exMobileRobot.slx

&= sensordata

To add a data element to the data interface, click the " icon. Data interface and data element
names must be valid MATLAB variable names.
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* . exMobiieRobot.six

¥ -é sensordala
coordinates

motorspeed

You can delete data interfaces and data elements in the Interface Editor using the S button.

You can view and edit the properties of an element in the Property Inspector. Right-click the data
element and select Inspect Properties. For data interfaces, use the Property Inspector to apply

stereotypes.
Property Inspector ¥ o=
Interface : sensordata | Element : motorSpeed
Properties
Type double
Dimensions 1
Units
Complexity real
Minimum 0
Maximum M
Description

For a comparative view, you can edit data element properties from the relevant Interface Editor

columns.
Type Dimensions Units Complexity Minimum Maximum Description
¥ @ exMobileRobot.shx
- § sensordata
coordinates double 1 real i} il
motorSpeed double 1 ’m';—| real 1] 1]

Create Value Types as Interfaces

To add a value type in the Interface Editor, select the down arrow next to the =7 icon and select

Value Type. Name the value type motorSpeedType. Value type names must be valid MATLAB
variable names.

Interfaces
%qﬁ K| & -|e -~ e |~ || Search (|| Dictionary View -
% E;dn:jgﬁf::feg:;: Interface Type Dimensions Uinits Complexity Minimurm

[ Value Type
Add value type

{cl Physical Interface
Add physical interface
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Right-click the motorSpeed data element and select Set '"Type' > motorSpeedType. The data
element motorSpeed is assigned to the value type motorSpeedType.

Type Dimensions Units Complexity
~ @ exMobileRobot slx
~ & sensordata
coordinates double 1 real
motorspeed Hmeits 1 mis real
Inspect Properties. ..

1] motorSpeedTy 1 real

Set Type + | motorSpeedTy pﬂ

Ly

Any data changes on the motorSpeedType value type is propagated to the motorSpeed data
element. You can reuse value types any number of times. Data changes on a value type will propagate
to each data element that uses the value type.

Nest Interfaces to Reuse Data

A nested interface contains another data interface. Create a nested data interface by assigning a data
interface as the type of a data element. For information about the corresponding buses, see “Nest Bus
Objects Using the Bus Editor”.

For example, let coordinates be a data interface that consists of x, y, and z coordinates. The
GPSdata data interface includes location and a timestamp. If the location data element is in
the same format as the coordinates interface, you can set its type to coordinates. Right-click
location and select Set 'Type' > coordinates. The available interface options include all value
types and all data interfaces in the model, except the parent of the data element.

Type Dimensions Units Complexity Minimum Maximum
~ i@ exMobileRobot skx
~ & sensordata
coordinates double 3 cm rea 0 0
motorSpeed (motorSpeedType) motorSpeedType 1 mis rea 0 35
[z] motorSpeedType double 1 = rea 0 35
~ & coordinates
X double 1 cm rea 0
double 1 cm rea 0 100
z double 1 cm rea 0 100
~ & GPSdata
timestamp double = rea ] 1l
sensordata
location doublo real 1] 1l

Inspect Properties... | motorSpeedType

The nested data interface displays the inherited data elements.
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Type Dimensions Units Complexity Minimum Maximum
~ & @GPSdata
timestamp double 1 real 1 I
* location (coordinates) coordinates 1 real 1] 1
X double 1 cm real 0 100
¥ double 1 cm real 0 100
z double 1 cm real 0 100

Note To change the number of columns that display in the Interface Editor, click the E‘!‘ icon.
Select or clear the desired columns to show or hide them.

Interfaces R
g el & ~al- ﬂ$T| Search (|| Dictionary View -
SHOW HIDE COLUMNS
Type & Inits
| Type

~ @ exMobileRobot slx 7 Dimensions

» & sensordata

v Units
[&] motorSpeedType | double _ m/'s
Complexity
» & coordinates
Minimum
} & GPSdata
Mazximum
Description
See Also
Functions
addInterface | removeInterface | addElement | removeElement | connect | setInterface |
addValueType
Blocks
Component
More About
. “Assign Interfaces to Ports” on page 3-9
. “Interface Adapter” on page 3-15
. “Manage Interfaces with Data Dictionaries” on page 3-19

. “Specify Physical Interfaces on the Ports” on page 5-55
. “Modeling System Architecture of Small UAV” on page 1-31
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Assign Interfaces to Ports

In this section...

“Mobile Robot Architecture Model with Interfaces” on page 3-9

“Associate a Port with an Interface in the Property Inspector” on page 3-9

“Define Owned Interfaces Local to Ports” on page 3-10

“Select Multiple Ports and Assign a Data Interface” on page 3-12

“Specify a Source Element or Destination Element for Ports on a Connection” on page 3-13

A port interface describes the data that can be passed between ports in a System Composer
architecture model. Data elements within the interface describe characteristics of the data
transmitted across the interface. Data elements can describe the composition of a data interface,
messages transmitted, or data structures shared between components.

For interfaces terminology, see “Define Port Interfaces Between Components” on page 3-2.
This topic will show you how to:

» Use the Property Inspector to assign data interfaces to one port at a time or the Interface Editor
to assign data interfaces to multiple ports.

* Manage owned interfaces that are local to a port and not shared in a data dictionary.

* Assign interfaces to multiple ports at the same time.

* Connect components through ports and specify the source element or the destination element for
the connection.

Incompatible data interfaces on either end of a connection can be reconciled with an Adapter block
using the “Interface Adapter” on page 3-15.

To manage interfaces shared between models in data dictionaries, see “Manage Interfaces with Data
Dictionaries” on page 3-19.

Mobile Robot Architecture Model with Interfaces

This example shows a mobile robot platform architecture with interfaces.

Associate a Port with an Interface in the Property Inspector

To assign data interfaces or value types to one port at a time, use the Property Inspector. To open the
Property Inspector, navigate to Modeling > Design > Property Inspector. To show the
SensorData port properties, select the port in the model. Expand Interface, and from the Name
list, select sensordata to associate the sensordata interface with the SensorData port.
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Property Inspector (¥
Port

Architecture Irific

~ Main
Mame SensorData
~ Interface
Mame Create or Selact . e
Actior data
Open in Interface Editor mntc-rSpEEde,'pE
coordinates
Stereotype GPSdata
<owned =
<empty=>

Define Owned Interfaces Local to Ports

You can select a value type or data interface from the model data dictionary in the Property Inspector,
or you can create an owned interface. An owned interface is a locally defined interface that is local to
a specific port and not shared in a data dictionary or the model dictionary. Create an owned interface
to represent a value type or data interface that is local to a port.

Note Owned interfaces and value types do not have their own names because they are local to a port
and not shared. The name of the owned interface is derived from the port name.

Manage Owned Interfaces Using the Property Inspector

You can edit the data for the owned interface in the Property Inspector. Select the Docking
architecture port. In the Property Inspector, under Interface, from the Name list, select <owned>.
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Property Inspector (=)
Port
Architecture Info
¥ Main
Name Docking
v Interface
Mame Create or Select ... ~
Action GPSdata
S i Interf coordinates
pen in Interface... R LTy e
Stereotype 'sensordata

 <owned >
<empty:>

By default, the owned interface Docking becomes an owned value type. Edit interface attributes

directly in the Property Inspector, or select Open in Interface Editor to edit the owned value

type interface.

Interfaces

& Docking

|

Type

double

Search

(|| Port Interface View -

Dimensions

Units

To convert the owned value type into an owned data interface, click “Z to add a data element.

Manage Owned Interfaces Using the Interface Editor

You can also work exclusively from the Interface Editor. Select the component port named Feedback.
In the Interface Editor, change from Dictionary Viewto Port Interface View.

Interfaces

S~

b i exMobileRobot slx

Be ~

Type

Search

Dimensions

(|| Dictionary View

- |

Dictionary View

Fort Interface View M

Click ¥ to add data elements to the owned data interface.
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Interfaces
& e |d& (e~ Bs.| v || Search Q| Port Interface View  ~
Type Dimensions Units
+ 'O Feedback |
ComputedSignal double
Userinput double

To convert the owned data interface to an owned value type, change the Type for Feedback to a valid
MATLAB data type, such as double.

Select Multiple Ports and Assign a Data Interface

Multiple ports, whether they are connected or not, can use the same data interface definition. When
you assign a data interface to a port, the interface is automatically propagated to connected ports,
provided they do not already have assignments. To simplify batch assignments, select multiple ports,
right-click the data interface, and select Assign to Selected Port(s).

Highlight the ports that use a data interface definition by clicking the interface name in the Interface
Editor.
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exMaobileRobot

® |F2exMobileRabot P

exMobileRobot

1

\

[ Bl [

-y

InBus

Daocking

O B

= ©

» [ &k

Communication

"E\- SengorData Feedback [=

Battery

4 Feadback

CutBus [»

Command

SensorData -ED

=y

IrBus

Motor

Sensor

b ImBis

[ ImBus MotionData [:)

SénsarData [:)

A

"/

Feadback{ 1>

MationDiata

Interfaces

& -]

~ @ exMobileRobot slx

| ~ & sensordata

coordinates
motorSpeed (motorSpeedType)
] motorSpeedType
b = GPSdata
¢+ & coordinates

. |E-3> v|| Search

u.g|| Dictionary View

-

Type
double
motorSpeedType
double

Dimensions

cm
mi's

mis

Units

Specify a Source Element or Destination Element for Ports on a

Connection

For connections between the root architecture and a component within the architecture model, you
can add a source element or destination element to the ports.

1 Create a component called Motor and connect it to the root architecture with ports named
MotionData and SpeedData.

Define the data interface Wheel with the data elements RotationSpeed and MaxSpeed.

Assign the Wheel data interface to the ports on the connection.
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4 Select the MotionData port name on the component. A dot and a list of data elements appear.
From the list, select the source element RotationSpeed.

5 Assign the MaxSpeed destination element to the SpeedData port.

exMobileRobot s
® |2 exMobileRobot
© | exMobileRobot
3l
Motor
|
i~ Ml SpeedData MotionData [ [
E SpeedData . MaxSpeed p— > SpeedData MotionData | )—4MotionData . RotationSpeed
Interfaces ?
S~ | |& |- Bg.|~ || Search Q|| Dictionary View -
Type Dimensions Units
~ & exMobileRobof six
v & Wheel
RotationSpeed double 1 mis
MaxSpeed double 1 mis

See Also

Functions

connect | getDestinationElement | getSourceElement | createOwnedType |

createlnterface

Blocks

Component

More About

. “Create Interfaces” on page 3-4

. “Manage Interfaces with Data Dictionaries” on page 3-19

. “Interface Adapter” on page 3-15

. “Specify Physical Interfaces on the Ports” on page 5-55
. “Modeling System Architecture of Small UAV” on page 1-31
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Interface Adapter

In this section...

“Map Similar Interfaces” on page 3-15
“Use Unit Delay to Break Algebraic Loop” on page 3-17

“Use Rate Transition Between Simulink Behaviors” on page 3-17

A source port and its destination port may be defined by different data interfaces. Such a connection
can represent an intermediate point in design, where components from different sources come
together. To connect components with different data interfaces, use an Adapter block from the
component palette and the Interface Adapter.

For interfaces terminology, see “Define Port Interfaces Between Components” on page 3-2.

An adapter helps connect two components with incompatible port interfaces by mapping between the
two interfaces. Use the Adapter block to implement an adapter. Launch the Interface Adapter by
double-clicking an Adapter block on the connection between the ports.

Use the Interface Adapter in System Composer to map interface elements between two ports. You can
also use the Interface Adapter to apply an interface conversion that breaks algebraic loops with unit
delays, or insert a rate transition for different sample time rates.

Map Similar Interfaces

When two connected components with Simulink behaviors have the same number of signals with
different names, use an Adapter block and the Interface Adapter to define the port connections.

1 Add an Adapter block to your model on the connection between the two components.

2 Double-click the block to open the Interface Adapter dialog box.

3 In the Select input box, select a data element. In the Select output box, select a data element.
4  Click the Map button.
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exMobileRobot =
@ | exMobileRobot b -
(]
L=l
= exMobileRobot
=
Communication Seneer
i
O
[> SensorData Feedback > —4{fFeedback SensorData < b InBus = SensarData [>
7 Edit Interface Mappings : Interface Adapter - o x
Create and edit mappings between input and output interfaces. I A
o]
Mappings (unsaved changes ***) Create new mapping 8 Feedback [ >
=
Input QOutput Select input Select output -2
=]
1 MotorData RotationSpeed MotionData RotationMetrics v MotarData ~ MationData =
. MaxSpeed RotationMetrics
2 MotorData MaxSpeed MotionData. Speed
otorata Maxspes! otiontataspee RotationSpeed Speed
Map
~
H SR
MotorData MotionData
Remove
| 'MotorData.MaxSpeed' 'MotionData.Speed' mapped to A
Apply interface conversion: | None - mapped to "MotionData Speed' "MotorData.Maxspeed'
:
Cancel Hel Appl
« 18 P PPl

You can use an Adapter block to map similar interfaces for an N: 1 connection (an Adapter with more
than one input port and a single output port). A data element from each input connection maps to the
output connection data elements.

Change the number of input ports on an Adapter block the same way you add and remove component
ports. For more information, see “Ports” on page 1-9.
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exMobileRobot
@ [Fexmobilerobot ¥
El n
exMobileRobot
=
=
B
= Communication Command Sensor
= = §
- B> SensorData F;—:_t_g:_t_(_:lback > —4lFeedback SensorData 4 b Sensot SefsorData b
=)
O
A A A
[} @
= E & X B Q
£ £ Command .7 Sensor 5
7 Edit Interface Mappings : Interface Adapter - m} X . =
=] =
Create and edit mappings between input and output interfaces. §
Mappings (unsaved changes ***) Create new mapping
Input Qutput Select input Select output ,g
1 Motor.Routing Sensor.Router v Motar v Sensor =
2 Command.Signal Sensor.Connection Routing Router a
Speed Connection Motor
~ Command Map and
Signal Ovenwrite
Switch
> Command MotionData [>
Remove
'Sensor.Connection’ mapped
Apply interface conversion:  None - to 'Command.Signal'
OK Cancel Help Apply

Use Unit Delay to Break Algebraic Loop

When connecting two components with port connections in both directions, an algebraic loop can
occur. To break the algebraic loop, use an Adapter block to insert a unit delay between the
components.

1 Add an Adapter block to your model on the connection between the two components.

2 Double-click the block to open the Interface Adapter dialog box.

3 From the Apply interface conversion list, select UnitDelay.

Use Rate Transition Between Simulink Behaviors

When connecting two reference components, the Simulink models they reference can have different
sample time rates. For compatibility, use an Adapter block to insert a rate transition between the
components.

1 Add an Adapter block to your model on the connection between the two components.
2 Double-click the block to open the Interface Adapter dialog box.

3 From the Apply interface conversion list, select RateTransition.

See Also

Blocks

Adapter
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More About

“Create Interfaces” on page 3-4

“Assign Interfaces to Ports” on page 3-9

“Manage Interfaces with Data Dictionaries” on page 3-19
“Define Port Interfaces Between Components” on page 3-2
“Modeling System Architecture of Small UAV” on page 1-31
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Manage Interfaces with Data Dictionaries

In this section...

“Mobile Robot Architecture Model with Interfaces” on page 3-19

“Save, Link, and Delete Interfaces” on page 3-19

Engineering systems often share interface definitions across multiple components or subsystems.

Data interfaces in System Composer can be stored either locally in a model or in a data dictionary,
depending on the maturity of your system.

For interfaces terminology, see “Define Port Interfaces Between Components” on page 3-2.

An interface data dictionary is a consolidated list of all the interfaces and value types in an
architecture and where they are used. Local interfaces on a System Composer model can be saved in
an interface data dictionary using the Interface Editor.

Interface dictionaries can be reused between models that need to use a given set of interfaces,
elements, and value types. Data dictionaries are stored in separate SLDD files.

For more advanced dictionary referencing techniques, see “Reference Data Dictionaries” on page 3-
22.

Mobile Robot Architecture Model with Interfaces

This example shows a mobile robot platform architecture with interfaces.

Save, Link, and Delete Interfaces

By default, interfaces are stored within the architecture model and are not visible outside the model.
If you are in the initial stages of building a system model, store interfaces locally to limit the number
of files that need to be managed. However, if your model is mature to the point of leveraging
componentization workflows like reference architectures and behaviors, storing interfaces in a data
dictionary gives you the ability to share interface definitions across the model hierarchy.

Use the o menu to save a data interface to a new or existing data dictionary. To create a new data
dictionary, select Save to new dictionary. Provide a dictionary name.

Interfaces ¥ X
=R | | ~|gdl~ ||| || ~||Es| || Search (|| Dictionary View -
Type Dimensions Units
* [ robotinterfaces sldd
» & sensordata
] motorSpeedType double 1 m/'s

} & GPSdata
» & coordinates
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You can also add the interface definitions in the model to an existing data dictionary by selecting
Link existing dictionary.

Use the ¥ button to import interface definitions from a Simulink bus object, either from a MAT-file or
the workspace.

Delete a data interface from a dictionary using the &S| button. If the data interface is already being
used by ports in a currently open model, the software returns a warning message. The data interface
is then removed from any ports in the open model that are associated with the data interface.

If a data interface is deleted from a dictionary upon opening another model that shares the dictionary,
a warning will be presented on startup if the deleted interface is used by ports in that model. The
Diagnostic Viewer offers an option to remove the deleted interface from all ports that are still using
it. You can also select ports individually and delete their missing interfaces.

Interfaces P X
& ~ |5 @L@ A v g~ ||/ | |iE| ~||Bs ~||Search Y| Dictionary View -
Type Dimensions Units
v tﬁ' robotinterfaces. sidd
» & sensordata :
4. Confirm delete interface — x

1] motorSpeedType d

} &= (GPSdata

b é coordinates This will remove interface from all ports associated with that interface.

Are you sure you want to delete interface: "sensordata™?

This action cannot be undone.

Yes, delete interface MNio Help
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A System Composer model and a data dictionary are separate artifacts. Even when the data
dictionary is linked to the model, changes to the data dictionary (a .sldd file) must be saved
separately from changes to the model (a . sx file). To save changes to a linked data dictionary, use

the = button and select Save dictionary. Once a data dictionary is saved, other models can use
its interface definitions by linking to the data dictionary, allowing multiple models to share the same
interface definitions.

See Also

createDictionary | openDictionary | saveToDictionary | linkDictionary |
unlinkDictionary

More About
. “Create Interfaces” on page 3-4
. “Assign Interfaces to Ports” on page 3-9

. “Interface Adapter” on page 3-15
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“Reference Data Dictionaries” on page 3-22
“Specify Physical Interfaces on the Ports” on page 5-55
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Reference Data Dictionaries

In this section...

“Add Referenced Data Dictionaries” on page 3-22

“Use Referenced Data Dictionaries for Projects with Multiple Models” on page 3-23

Referenced dictionaries in System Composer may be useful when multiple models need to share
some, but not all, interface definitions. and to allow communication between the models. A data
dictionary can reference one or more other data dictionaries. The interface definitions in the
referenced dictionaries are visible in the parent dictionary and can be used by a model that is linked
to the parent dictionary.

For interfaces terminology, see “Define Port Interfaces Between Components” on page 3-2.

To create a data dictionary from interfaces in a model dictionary, see “Manage Interfaces with Data
Dictionaries” on page 3-19.

Add Referenced Data Dictionaries

To add a dictionary reference, open the Model Explorer by clicking Fg, or by navigating to Modeling
> Design > Model Explorer.

On the right side of the Model Explorer window, click Add, then select the file name of the data
dictionary to add as a referenced dictionary. To remove a dictionary reference, highlight the
referenced dictionary, then click Remove.

B O @

Model Hierarchy |£| = E Contents of: ..ictionary 'D:\Examples\myDictionary.sldd'  (only)

Data Dictionary: myDictionary

~ P Simulink Root

Column View: | Dictionary Objects ¥ | Show Details D object(s) ﬂ‘ Information for: myDictionary
Base Workspace N
L e .“. e File: D:\Examples\myDictionary.sldd
& mypictionany” Created: 2020-12-22 08:15
exMobileRobat Last Modified: 2020-12-22 08:16

Last Saved: 2020-12-22 08:15
Unsaved Changes: yes (ShowChanges)

£ >

Referenced Dicticnaries

miyDictionary Add
otherDictionary (4) View Hierarchy
Remove

Open

|:| Enable dictionary access to base workspace

Help

< > Contents Search Results
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The Interface Editor shows all interfaces accessible to a model, grouped based on their data
dictionary files. In this example, myDictionary. sldd is the data dictionary linked to the model, and
otherDictionary.sldd is a referenced dictionary.

Type Dimensions Units Complexity Minimum Maximum Description

~ i@ myDictionary sldd
& Feedback
& MotionData
& sensorData

~ |g otherDictionary sldd
& Docking
& Otherinteriace

& Ctherinterface2

The model can use any of the interfaces listed. However, you cannot modify the contents of the
referenced dictionaries from the model.

Note Referenced dictionaries can reference other data dictionaries. A model that links to a
dictionary has access to all interface definitions in referenced dictionaries, including indirectly
referenced dictionaries.

Use Referenced Data Dictionaries for Projects with Multiple Models

A project may contain multiple models, and it may be useful for the models to share interface
definitions that are relevant to data flows and other communications between models. For more
information, see “Organize System Composer Files in a Project” on page 1-37,

At the same time, each model may have interface definitions that are relevant only to its internal
operations. For example, different components of a system may be represented by different models,
with different teams or different suppliers working on each model, with a system integrator working
on the "top" model that incorporates the various components. Referenced data dictionaries provide a
way for models to share some but not all interface definitions.

In such a multiple-team project, set up a "shared artifacts" data dictionary to store interface
definitions that will be shared by different teams, then set up a data dictionary for each model within
the project to store its own interface definitions. Each data dictionary can then add the shared data
dictionary as a referenced data dictionary. Alternatively, if a model does not need its own interface
definitions, that model can link directly to the shared data dictionary.
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mSystem.slx
Simulink Model

S

mSupplierA skx mSupplierB slx
Simulink Model Simulink Model
- O O

dSystem sldd dSupplierA.sldd
Simulink Data Dictionary Simulink Data Dictionary
W WS
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dShared.sldd
Simulink Data Dictionary

The above diagram depicts a project with three models. The model mSystem. s1x represents a
system integration model, and mSupplierA.slx and mSuppierB.slx represent supplier models.
The data dictionary dShared. sldd contains interface definitions shared by all the models. The
system integration model is linked to the data dictionary dSystem. sldd, and the Supplier A model is
linked to the data dictionary dSupplierA.sldd; each data dictionary contains interface definitions
relevant to the corresponding model's internal workflow. The data dictionaries dSystem. sldd and
dSupplierA.sldd both reference the shared dictionary dShared.sldd. The Supplier B model, by
contrast, is linked directly to the shared dictionary dShared. sldd. In this way, all three models have
access to the interface definitions in dShared. sldd.

The following diagrams show the system integration model mSystem, along with the Interface Editor.
Interface definitions contained in the referenced dictionary dShared are associated with the ports
used to communicate between the models mSupplierA and mSupplierB and the rest of the system
integration model.
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mSystem Jrisd]

® (F]msystem # hd

mSystem

supplierd
< mESupplier >
supplierA s
= mEupplierd >
roatOEMOuUL b —drootOEMCu
aSuppl b fromSupplient
inFrocessind

receCEMINI—{ & roctOEMIn

G e N |

taPracessinfo b

b ireotOE MIn rootOEMOut 1

O B @

procinfa

b FomSuppiE

b fromSupnis

« ||Ed&h

Interfaces L4

&~ ~ & - '| &} | ~ | |Bs| = || searcn Q| ictionary view -

Type Dimensions Units Complexity Minimum Maximum Description

& dSystem sidd |

~ [@ dShared sidd
& rootCommsin
& rootCommsQut
& supplAProcinfo
é supplBProcinfo
& supplSharedComms

The following diagrams show the supplier model mSupplierA, along with the Interface Editor.
Interface definitions contained in the referenced dictionary dShared are associated with the ports
used to communicate externally, while interface definitions in the private dictionary dSupplierA are
associated with ports whose use is internal to the mSupplierA model.
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<4 “r  supplierd

®
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mSupplierA

U
3

to_cB =

-:c-.tEer.—(b roGtEMIn

to_cC B

2 El [

WIDEM In

O B @

cC

« |8

b from_cA oSupplE b —4@ioSupplB

b from_cA  toProcessinfo b —dltoProcessinfo

toSupplB I+ >

toProcess(nfo b

Interfaces
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& dSystem.sldd
~ @ dShared sidd

é rootCommsin
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Complexity Minimum

Maximum Description

See Also
addReference | removeReference

More About

. “Create Interfaces” on page 3-4
. “Assign Interfaces to Ports” on page 3-9

. “Manage Interfaces with Data Dictionaries” on page 3-19

. “Specify Physical Interfaces on the Ports” on page 5-55
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“Organize System Composer Files in a Project” on page 1-37
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* “Define Profiles and Stereotypes” on page 4-2

* “Use Stereotypes and Profiles” on page 4-9

* “Simulate Mobile Robot with System Composer Workflow” on page 4-21
* “Organize and Link Requirements” on page 4-23

* “Design Architectural Models” on page 4-26

* “Define Stereotypes and Perform Analysis” on page 4-33

* “Simulate Architectural Behavior” on page 4-43
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Define Profiles and Stereotypes

4-2

To verify structural and functional requirements, you must capture nonfunctional properties on
elements in a System Composer architecture model. To capture these properties, use stereotyping.

For example, if there is a limit on the total power consumption of a system, the model must be able to
capture the power rating of each electrical component. To define component-specific property values
requires extending built-in model element types with properties corresponding to requirements. In
this case, an electrical component type as an extension of components is a stereotype. By extending
the definition of regular components, you introduce a custom modeling language and framework that
includes specific concepts and terminologies important for the architecture model. Capturing the
individual properties also sets the scene for early parametric analyses and to define custom views.

A stereotype is a custom extension of the modeling language. Stereotypes provide a mechanism to
extend the architecture language elements by adding domain-specific metadata. Apply stereotypes to
elements: root-level architecture, component architecture, connectors, ports, data interfaces, and
value types of a model. A model element can have multiple stereotypes. Stereotypes provide model
elements with a common set of property fields, such as mass, cost, and power.

A property is a field in a stereotype. For each element the stereotype is applied to, specific property
values are specified. Use properties to store quantitative characteristics, such as weight or speed,
that are associated with a model element. Properties can also be descriptive or represent a status.
You can view and edit the properties of each element in the architecture model using the Property
Inspector. Open the Property Inspector by navigating to Modeling > Design > Property Inspector.

A profile is a package of stereotypes to create a self-consistent domain of element types. Author
profiles and apply profiles to a model using the Profile Editor. You can store stereotypes for a project
in one profile or in several. Profiles are stored in XML files when they are saved.

In this topic, you will learn how to:

Create a profile and define stereotypes with properties.

2 Define default stereotypes in a profile to be added to any new element in a model with that
applied profile.

3  Use stereotype-based styling that enhances the appearance of the model based upon specific
features each element represents.

Create a Profile and Add Stereotypes

Create a profile to define a set of component, port, and connection types to be used in an architecture
model. For example, a profile for an electromechanical system, such as a robot, could consist of these

types:
* Component types:

* Electrical component
* Mechanical component
* Software component

* Connection types:

* Analog signal connection
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¢ Data connection
* Port types

* Data port

Define a profile using the Profile Editor by navigating to Modeling > Profiles > Profile Editor.
Click New Profile. Select new profile to start editing.

Name the profile and provide a description. Add stereotypes by clicking New Stereotype. You can
v
delete stereotypes and profiles by clicking the Z\; button in their respective menus.

Save the profile. The file name is the same as the profile name.

Add Properties with Stereotypes

Select a stereotype in a profile to define it:

* Name — The name of the stereotype, for example, ElectricalComponent.

* Applies to — The model element type to which the stereotype applies. This field can be an <all>,
component, port, connector, or interface. You can apply this stereotype only to a model element of
this type.

* Icon — Icon to be shown on the model element with color, if applicable.
* Connector Style — Line style of the connector to be shown on the model with color, if applicable.
* Base stereotype — Other stereotype on which this stereotype is based. This can be empty.

* Abstract stereotype — A stereotype that is not intended to be applied directly to a model
element. You can use abstract stereotypes only as the base stereotype for other stereotypes.

Add properties to a stereotype using the “ir' button. Define these fields for each property:

* Property name — Valid variable name

* Type — Numeric, string, or enumeration data type

* Name — Name of the enumerated type, if applicable
* Unit — Value units as a string

» Default — Default value
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B Systern Composer Profile Editor

- m| *
(=] system Composer Profile Editor
Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models. show more...
Profile [L:[Il_, New Profile '_'_=|] Open | | ol Save |v Stereotype EE}, New Stereotype % Import into | Select @
Profile Browser Stereotype Properties
Filter profiles: | <all> - Name: |SignaIPort |

- Applies to: | Port -

v [=] ProjectProfile

AnalogConnection Connector style: | — ]

> DataPort

{F ElectricalComponent Base stereotype: | <nothing> e

e‘: MechanicalComponent

O ProjectComponent L] Abstract stereotype

o

Szl Description: |
Property name Type Mame Unit Default

[ show inherited properties (read-only)

Saved profile: 'ProjectProfile’

Add, delete, and reorder properties using the property toolstrip: gt K AN

You can create a stereotype that applies to all model element types by setting the Applies to field to

<all>. With these stereotypes, you can add properties to elements regardless of whether they are
components, ports, connectors, or interfaces.
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Stereotype Properties

Name: | GeneralElement

Applies to: | <all=

Base stereotype: | <nothing= -
[] Abstract sterectype
Description: |
o
Property name Type Mame Unit Default
1 RefNumber int8 * | nfa 1

Default Stereotypes

Each profile can have a set of default stereotypes. Use default stereotypes when each new element of
a certain type must assume the same stereotype. System Composer applies a default stereotype to
the root architecture when you import the profile. You can set this default as ProjectComponent in

the Profile Editor using the Stereotype applied to root on import field.

E] Systemn Composer Profile Editor

= System Composer Profile Editor
Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models.

Praofile [ELNEW Profile "._jOpen =l Save = %

Profile Browser

Filter profiles: | <all>

hd [_fl ProjectProfile
AnalogConnection
= DataPort
{E ElectricalComponent
ol MechanicalComponent
O ProjectCompaonent
B SignalPert

Profile Properties

Stereotype EE} New Stereotype %

Import into | Select @

show more...

Name: | ProjectProfile

Friendly name (can contain spaces etc.):

Stereotype applied to root on import:

Description:

noneg

none
ElectricalComponent

MechanicalCompanent

ProjectComponent
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This default stereotype is for the top-level architecture. If a model imports multiple profiles, the
default component stereotype for all profiles apply to the architecture.

Each component stereotype can also have defaults for the components, ports, and connections added
to its architecture. For example, if you want all new connections in a project component to be analog
connections, set AnalogConnection as a default stereotype for the ProjectComponent stereotype.

| =] System Composer Profile Editor

- O *
=] System Composer Profile Editor
Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models. show more...
Profile EEL New Profile —'j] Open | | |l Save |» Stereotype EE} New Stereotype 23 Import into | Select @

Profile Browser Stereotype Properties

Filter profiles: | <all>

Name: | ProjectComponent

Applies to:  Component = O 1con &
v =] ProjectProfile

AnalogConnection Base stereotype: | <nothing>

> DataPort
{F ElectricalComponent [] Abstract sterectype
[*] .
Ws MechanicalComponent o
De: 5
O ProjectCompanent SELFEE |
& SignalPort

¥ Default Stereotypes for Composition

Component stereotype: | ElectricalComponent

Port stereotype: | SignalPort

Connector stereotype: | AnalogConnection

an

Property name Type
1 PowerRating string T |nfa

Name Unit Default

[ show inherited properties (read-only)

Saved profile: 'ProjectProfile’

4-6

After you import the profile ProjectProfile into a model, the ProjectComponent stereotype is
applied to the root architecture. Thus, all new components in the architecture model assume the

ElectricalComponent stereotype, all new ports assume the SignalPort stereotype, and all new
connections assume the AnalogConnection stereotype.
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Stereotype-Based Styling

Profiles and stereotypes are used to apply custom metadata on the architecture model elements.
Element styling is an additional visual cue that indicates applied stereotypes.

You can use provided icons for the component stereotypes or use you own custom icon images.

Custom icons support .png, .jpeg, or .svg image files of size 16-by-16 pixels. The custom icons are
displayed as badges on the components for which the stereotypes are applied.

Pick an icon
O 15| =
£ & B
< &
€0 &)

Custom

Accepted icon size: 16x16 pixels

You can associate a color with component stereotypes. Element styling is an additional visual cue that
indicates applied stereotypes.

| = System Composer Profile Editor _ O e

[=] System Composer Profile Editor =

Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models. show more...

Profile L-Lu*,New Profile | | |Open | =i Save |» Stereotype E% New Stereotype 2.5  Import into | Select ~ 2

Profile Browser Stereotype Properties

Filter profiles: <all> < Name: ‘stereatype ‘

Applies to: Component - 5 Icon V)
v | =] Profile*
g Stereotype Base stereotype: |<nothing> -

Use a preconfigured set of color options for component stereotypes to style the architecture
component headers. See “Use Stereotypes and Profiles” on page 4-9 to learn how to use
stereotypes in your model.

- _
ComponentA = ComponentB e
B 1 <vdp >
out1 p
out2

Similarly, you can style architecture connectors using the stereotype settings. You can style
connectors by using connector, port, or port interface stereotypes. Customize styling provides various
color and line style choices. Connector styles are also reflected in architecture and spotlight views.
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Stereotype Properties

Name: [Stereotype

Applies to: Connector =
Connector style: ==+ | 1

Base stereotype: <nothing> -

[ Abstract stereotype

Description: | |

Connector styling is sourced from the highest-priority stereotype that defines style information.
Connector stereotypes have the highest priority, followed by port stereotypes and then interface
stereotypes.

When two connectors with different styling merge, if the styling is incompatible, the resulting
connector is displayed in black.

ComponentB
—— D> InBus
7ComponentA
OutBus p ————o
ComponentC
> InBus

See Also

hasStereotype | hasProperty | editor | systemcomposer.profile.Profile |
systemcomposer.profile.Property | systemcomposer.profile.Stereotype

More About

. “Use Stereotypes and Profiles” on page 4-9

. “Analyze Architecture” on page 6-10

. “Modeling System Architecture of Small UAV” on page 1-31

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Use Stereotypes and Profiles

Use profiles to add properties to components, ports, and connectors in System Composer. Import an
existing profile, apply stereotypes, and add property values. To create a profile, see “Define Profiles
and Stereotypes” on page 4-2.

In this topic, you will learn how to:

Import profiles into a model or a dictionary.
Apply a stereotype to a model element and add property values.
Remove stereotypes using the Property Inspector.

A W N R

Extend stereotypes with other stereotypes to include their properties through an inherited
mechanism. For example, a UserInterface stereotype can be an extension of a
SoftwareComponent stereotype, and add a property called ScreenResolution.

Import Profiles

The Profile Editor is independent from the model that opens it, so you must explicitly import a new
profile into a model. The profile must first be saved with an . xml extension. Navigate to Modeling >

Profiles > Import B . Select the profile to import. An architecture model can use multiple profiles
at once.

Alternatively, open the Profile Editor by navigating to Modeling > Profiles > Profile Editor. You can
import a profile into any open dictionaries or models.
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|Z| System Composer Profile Editor

E | System Composer Profile Editor

Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models.

Profile EEL New Profile '_'_=|] Open | | ol Save |» Stereotype E% New Stereotype 23 Import into

Select...
Profile Browser Stereotype Properties
model.sk
Filter profiles: | <all> o Name: |ProjectComponent dictionary.sldd
o Applies to: | Component O3 1con
v [=] ProjectProfile*
AnalogConnection Base stereotype: | <nothing>
= DataPort
{F ElectricalComponent [ Abstract stereotype
InterfaceStereotype L
De: 5
O Mechan icalComponent seription |
ProjectC t
E Sir:]ﬂzlpo?tmponen b Default Sterectypes for Composition
a8
Property name Type Name Unit Default

;E

[ show inherited properties (read-only)

Note For a System Composer component that is linked to a Simulink behavior model, the profile
must be imported into the Simulink model before applying a stereotype from it to the component.

Since the Property Inspector on the Simulink side does not display stereotypes, this workflow is not

finalized.

To manage profiles after they have been imported, navigate to Modeling > Profiles > Manage

=

ad
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Linked profiles — O *
Impaort or remove profiles.
Mame Linked to
1 ProjectProfile model.slx
2 ProjectProfile dictionary.sldd
lirt, Import 2+ Remove

Apply a Stereotype

Once the profile is available in the model, open the Property Inspector by navigating to Modeling >
Design > Property Inspector. Select a model element.
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- RobotWithReqgs Property Inspector o
,% ® |[FRobotwithRegs b *| | port g
g ‘ @ Successfully imported architecture profile "Functional Architecture'. x| * Architecture Info ﬁ
= Q MUUULVVILIIMREYDS E
E3 ~ Main B
Name SensorData
O Sensor L
Trajectory plan s Interface
Sterectype Add.
A\
8
5
w
c
Cl & User Interface
> SensorData
[
=1 etn 1 v
« ¢ 3
Ready 119% VariableStepAuto

In the Stereotype field, use the drop-down to select the stereotype. Only the stereotypes that apply

to the current element type (for example, a port) are available for selection. If no stereotype exists,
you can use the <new / edit> option to open the Profile Editor and create one.

Property Inspector = X
Port
Architecture Info
* Main
MName SensorData
Tags
» Interface
Stereotype Select w
1.F PO .
FunctionalArchitecture. SignalPort
<new J edit=

4-12
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Model Browser

When you apply a stereotype to an element, a new set of properties appears in the Property Inspector
under the name of the stereotype. To edit the properties, expand this set.

Property Inspector
Port

Architecture Inifice

=

~ Main
Name
Tags

» Interface

Sterectype
* DataPort
BitR.ate

ol

SensorData

Add..
Select

E |

b i o B A

You can set multiple stereotypes for each element.

RobotWithReqgs

T W6 |

B E OB &E

A

RobotWithReqgs P

RobotWithReqs

Sensor

CutBus

User Interfa:

[» InBus

Property Inspector
Component

Architecture Info

* Main
Mame Sensor
Stereotype Add.. v
> ElectronicComponent Select -
» GeneralElement Select -
> SharedArtifact Select il

You can also apply component, port, connector, and interface stereotypes to all applicable elements at

the same architecture level. Navigate to Modeling > Profiles > Apply Stereotypes. In Apply
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Stereotypes, from Apply stereotype(s) to, select Top-level architecture, All elements,
Components, Ports, Connectors, or Interfaces.

Note The Interfaces option is only available if interfaces are defined in the Interface Editor. For
more information, see “Create Interfaces” on page 3-4.

Apply Stereotypes — 0 %

Apply sterectypes to selected elements, all elements in the current
layer, or the entire model.

Apply stereotype(s) to: | Top-level architecture -
Top-level architecture
Scope: All elements
. Components
Include childrer Ports
ProjectProfile.ElectricalC Connectors
Interfaces

ProjectProfile.MechanicalComponent

ProjectProfile.ProjectComponent

Apply Close Help

You can also apply stereotypes by selecting a single model element. From Scope, select Selection,
This layer, or Entire model.
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Apply Stereotypes — O >

Apply sterectypes to selected elements, all elements in the current
layer, or the entire model.

Apply stereotype(s) to: Components -
Scope: |Selection -
L] Inclu This layer

Project] Entire model N

ProjectProfile.MechanicalComponent

ProjectProfile.ProjectComponent

Apply Close Help

You can also apply stereotypes to data interfaces or value types. When interfaces are locally defined

and you select one or more interfaces in the Interface Editor, the options for Scope are Selection
and Local interfaces.
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Apply Sterectypes — O x

Apply stereotypes to selected elements, all elements in the current
layer, or the entire model.

Apply stereotype(s) to: | Interfaces

Scope: | Selection

[}
Inclu Local interfaces

ProjectProfile.InterfaceStereotype

Apply Close Help

When interfaces are stored and shared across a data dictionary and you select one or more interfaces

in the Interface Editor, the options for Scope are Selection and either dictionary.sldd or the
name of the dictionary currently in use.
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Apply Sterectypes — O et

Apply stereotypes to selected elements, all elements in the current
layer, or the entire model.

Apply sterectype(s) to: | Interfaces h

Scope: |Selection h

Selection
Inclu 'dictionary.sldd’

ProjectProfile InterfaceStereotype

Apply Close Help

Note For the stereotypes to display for interfaces in a dictionary, in the Apply Stereotypes dialog box,
the profile must be imported into the dictionary.

You can also create a new component with an applied stereotype using the quick-insert menu. Select
the stereotype as a fully qualified name. A component with that stereotype is created.
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Component

Systerm Compose

Reference Component

— Component D
Warniant Component 1

Interface Adapter -
Profile.Stereotype %

Create Annotation

Components Actions (Ctrl+.)

Remove a Stereotype

If a stereotype is no longer required for an element, remove it using the Property Inspector. Click
Select next to the stereotype and choose Remove.

Property Inspector ¥ x

Component

Architecture Inificy

Main

MName Sensors
Stereotype Add.. 7
sysComponent | hd

Extend a Stereotype

You can extend a stereotype by creating a new stereotype based on the existing one, allowing you to
control properties in a structural manner. For example, all components in a project may have a part
number, but only electrical components have a power rating, and only electronic components — a
subset of electrical components — have manufacturer information. You can use an abstract
stereotype to serve solely as a base for other stereotypes and not as a stereotype for any architecture
model elements.
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For example, create a new stereotype called ElectronicComponent in the Profile Editor. Select its
base stereotype as FunctionalArchitecture.ElectricalComponent. Define properties you are
adding to those of the base stereotype. Check Show inherited properties at the bottom of the
property list to show the properties of the base stereotype. You can edit only the properties of the

selected stereotype, not the base stereotype.

[=] System Composer Profile Editor

=] System Composer Profile Editor

Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models.

Profile EELNew Profile E]Open ol Save |» Stereotype EE} New Stereotype % Import into | Select |»

Profile Browser Stereotype Properties

Filter profiles: | <all> A

show more...

Name: |EIectr0n|'cComponent

Applies to: Component
v [=] FunctionalArchitecture*

AnalogConnection
> DataPort
DigitalConnection [] Abstract stereotype

ﬁ ElecticalComponent

Base stereotype: | FunctionalArchitecture.ElecticalComponent

. Description:
ﬁ ElectronicComponent Pt |

EI FSx:I;EZT\;;a:IComponent » Default Stereotypes for Composition
O softwa reComponent

o | &

Property name Type
1 Manufacturer string MILE]
2

Name Unit

Pc

owerRating double n/a

Default

Show inherited properties (read-only)

When you apply the new stereotype, it carries its defined properties in addition
stereotype.

to those of its base
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4-20

Property Inspector A X

Component

Architecture Inifiy

* Main
MName Sensor
Tags
Sterectype Add.. hd
* ElectronicComponent Select
Manufacturer
PowerRating 0 VA

e
1

See Also

editor | hasStereotype | hasProperty | systemcomposer.profile.Profile |
systemcomposer.profile.Property | systemcomposer.profile.Stereotype

More About

. “Define Profiles and Stereotypes” on page 4-2

. “Analyze Architecture” on page 6-10

. “Modeling System Architecture of Small UAV” on page 1-31

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Simulate Mobile Robot with System Composer Workflow

Along with other tools, System Composer™ can help you organize and link requirements, design and
allocate architecture models, analyze the system, and implement the design in Simulink®. This
example provides model files, requirement links, requirement sets, a profile, an allocation set, and an
analysis function. You can use these files for the steps of the following tutorial presenting the early
phase of development of an autonomous mobile robot.

1

“Organize and Link Requirements” on page 4-23: Set up the requirements based on market
research.

“Design Architectural Models” on page 4-26: Create architecture models to help organize
algorithms and hardware.

“Define Stereotypes and Perform Analysis” on page 4-33: Define stereotypes and performing
system analysis to ensure that the life expectancy of the durable components in the robot meets
the customer-specified mean time before repair.

“Simulate Architectural Behavior” on page 4-43: Create a Simulink model to simulate realistic
behavior of the mobile robot.

This workflow is represented by the left side of the model-based systems engineering (MBSE) design
diagram.
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. . Complete
Onganl:'.je and |tJr‘lk System Integration and
equirements Specification Test

High-Level
-
Design =sian
Architectural System Integration
Models and Test

Low-Level
Design

Subsystem
Integration and
Test

Define Stereotypes
and Perform
Analysis

Simulate
Architectural
Behavior

See Also

More About
. “Model-Based Design with Simulink”
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Organize and Link Requirements

The first step in model-based systems engineering (MBSE) design using System Composer is to set up
requirements. Requirements are a collection of statements describing the desired behavior and
characteristics of a system. Requirements ensure system design integrity and are achievable,
verifiable, unambiguous, and consistent with each other. Each level of design should have appropriate
requirements. This example has three sets of requirements.

1 Stakeholder needs — A set of end-user needs. Stakeholders are interested in attributes of the
mobile robot associated with endurance, payload, speed, autonomy, and reliability.

2 System requirements — A set of requirements that are linked closely with system-level design.
System requirements include the derived requirements that describe how the system responds to
stakeholder needs.

3 Implementation requirements — A set of requirements that specify subsystems in the model.
Implementation requirements include specifications for the battery, structure, propulsion, path
generation, position, controller, and component life for individual subsystems.

By linking one requirement set to another, each high-level requirement can be traced to
implementation. As the MBSE design evolves, you can use iterative requirements analysis to enhance
requirement traceability and coverage. You can use the Traceability Diagram to visualize requirement
traceability. See “Visualize Links with a Traceability Diagram” (Simulink Requirements).

Link Stakeholder Requirements to System Requirements

To access the models and supporting files used in this example, see “Simulate Mobile Robot with
System Composer Workflow” on page 4-21. After loading the example, run this code in the MATLAB
Command Window.

% Load systems in memory to view requirement links

systemcomposer.loadModel('scMobileRobotHardwareArchitecture');
systemcomposer.loadModel('scMobileRobotFunctionalArchitecture');

% Load the requirement sets into memory
slreq.load('scMobileRobotStakeholderNeeds');
slreq.load('scMobileRobotRequirements');
slreq.load('scMobileRobotSubsystemRequirements');

% Open the Requirements Editor
slreq.editor

The requirement sets open in the Requirements Editor. You can link stakeholder needs to derived
requirements to keep track of high-level goals. The Mean Time Before Repair requirement,
STAKEHOLDER-07, is refined by the Battery Life requirement, SYSTEM-REQ-09.
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@ Requirement: STAKEHOLDER-07
It Details
hd h, scMobileRobotRequirements * Properties
B 1 B Endurance Type: Informational ~
E 2 - Payload and Speed . -
gs - Autonomy Custom ID: | STAKEHOLDER-07 |
E 4 - Life Expectancy

Summary: | MTER |

v Iﬁl scMobileRobotStakeholderNeeds

E1 STAKEHOLDER-01 Endurance Desoription  [Ratimkg
B 2 STAKEHOLDER-02 Payload lutly B ;7 Ul E=E=E~»
E 3 STAKEHOLDER-03 Operating Speed The robot should have a Mean Time Before Repair of 2 years.

v B 4 - Autonomy

El 4.1 STAKEHOLDER-04 Transportation

E 4.2 STAKEHOLDER-05 Autonomous Charging

[El 4.3 STAKEHOLDER-06 Collision Avoidance
v B s - Reliability

E 5.1 STAKEHOLDER-07 MTER

[E 5.2 STAKEHOLDER-08 MTBF

hd h, scMobileRobotSubsystemRequirements

E 1 _ Battery Keywords:
E 2 - Structure } Revision information:
B 3 - Propulsicn
¥ Links
E 4 - Path Generation
E s Position Determination B ¢= Refined by:
E s - Controller E SYSTEM-REQ-09 Battery Life
B7 - Component Life E SYSTEM-REQ-10 Sensor Life

You can set a specific link type. To change link types, in the Requirements Editor, select Show Links.
Change the type of the Localization requirement link, SYSTEM-REQ-05, from Related to to
Implements, for the Transportation requirement, STAKEHOLDER - 04. For more information, see
“Link Types” (Simulink Requirements).

® | Link:
=
Label Source Type Destination Details
v |4 scMobileRobotFunctionalArchitecture.simx  Changed source: 0/4 Changed destination: 0/4 ¥ Properties
C’ link #1 Self Localization Sensor Fusion Implements  SYSTEM-REQ-05 Localization Source: D Path Follower
C’ link #2 Path Planning Implements  SYSTEM-REQ-06 Path Generation Type: Related to =
& link #3 Path Planning Implements  SYSTEM-REQ-12 Path Gen Time Destination: E‘;:E:‘;Ed By
c’ link #4 Path Follower Related to SYSTEM-REQ-07 Path Following Description Reflmes
v |4 scMobileRobotHardwareArchitecture.simx  Changed source: 0/4 Changed destination: 0/4
C? link #1 Charge Board Implements  SYSTEM-REQ-09 Battery Life
C? link #2 RGB Camera Implements  SYSTEM-REQ-10 Sensor Life
C’ link #3 Lidar Sensor Implements  SYSTEM-REQ-10 Sensor Life
67 link #4 Wheels Implements  SYSTEM-REQ-11 Mechanical Component Life
v |4 scMobileRobotRequirements.simx Changed source: 0/4 Changed destination: 0/4
C‘? link #1 SYSTEM-REQ-09 Battery Life Refines STAKEHOLDER-07 MTBR
Keywords:
C‘? link #2 SYSTEM-REQ-10 Sensor Life Refines STAKEHOLDER-07 MTBR
. P Revision information:
C? link #3 SYSTEM-REQ-11 Mechanical Component Life  Refines STAKEHOLDER-08 MTBF
C’ link #4 SYSTEM-REQ-05 Localization Refines STAKEHOLDER-04 Transportation » Comments

To return to interacting with requirements, in the Requirements Editor, select Show Requirements.
The Transportation stakeholder needs requirement, STAKEHOLDER- 04, will be implemented by the
Localization system requirement, SYSTEM-REQ-05. The robot must be able to determine its current
position with a specified tolerance. Right-click SYSTEM-REQ-05 and select Select for Linking
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with Requirement. Then, right-click on STAKEHOLDER-04 and select Create a link from
SYSTEM-REQ-05 to STAKEHOLDER-04.

For more information on linking requirements to components, see “Link Requirements to
Components” on page 4-28.

See Also
systemcomposer.updateLinksToReferenceRequirements

More About
. “Manage Requirements” on page 2-8
. “Link and Trace Requirements” on page 2-2
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Design Architectural Models

Architecture models in System Composer describe a system at different levels of abstraction. This
mobile robot example presents three architectures:

1 Functional architecture describes high-level functions.

2  Hardware architecture describes the physical hardware or platform needed for the robot.

3 Logical architecture describes data exchange.

To access the models and supporting files used in this example, see “Simulate Mobile Robot with
System Composer Workflow” on page 4-21.

Functional Architecture Model for Mobile Robot

The functional architecture model describes functional dependencies: controlling a mobile robot
autonomously, localization, path-planning, and path-following. To open the functional architecture
model, double-click the file or enter this command in the MATLAB Command Window.

% Open the functional architecture model for the mobile robot
systemcomposer.openModel ('scMobileRobotFunctionalArchitecture');

scMobileRobotFunctionalArchitecture

[C] scMobiIeRobotFunctionaIArchite:ture 4

L]

(@ &l E1 1

O m

vERE

Lidar Sensor Scan Matching Algorithm Self Localization Sensor Fusion

Wheel Kinematics. Wheel Sensors
b Lidar Scan

Wheel State < o Whes! State

RGE Camera Alignment Sensor

Battery Safety Observation Path Planning

User Interface

B MaEARIATENATL Veioc e Tage Su
Target State o 4 Target St

ecuting Sadaty Sty

Motor Driver

Path Follower
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Hardware Architecture Model for Mobile Robot

The hardware architecture model describes the hardware components — the sensor, actuators, and

embedded processor — and their connections. The colors and icons indicate the stereotypes used for
each element. To open the hardware architecture model, double-click the file or enter this command
in the MATLAB Command Window.

% Open the hardware architecture model for the mobile robot
systemcomposer.openModel('scMobileRobotHardwareArchitecture');

H|

2 @ [

OB @

v

scMobileRobotHardwareArchitecture

scMobileRobotHardwareArchitecture P

scMobileRobotHardwareArchitecture

. |}

Lidar Sensor

Emergency Switch O

RGB Camera )
mage [~
&
:{_. [
Controller L
User Input >

Mobile Robot Case O
|
i
|
i
I
|
|
|
i
-
E i
7
Target Machine {E
Encoder Reading 1 <f--------- -3 Wheels
i
| .
e e ey <l Enceder Raading 1
b= Commands Encoder Reading 2 Jf---------r--=——-—==-——-—-+ <] Encoder Reading 2
jmm o I+ Actuater Input
i a
Actuator Input B F--------—--—s B
g
&
]
g
o g
] 5
& &
Battery O | Power Supply Board O Charge Board D|
Power [> [> Batiery Power Power <] <1 Power
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Logical Architecture Model for Mobile Robot

The logical architecture model describes the behavior of the mobile robot system — trajectory
generator, trajectory follower, motor controller, sensor algorithm, and robot and environment — for
simulation. The connections represent the interactions in the system. To open the logical architecture
model, double-click the file or enter this command in the MATLAB Command Window.

% Open the logical architecture model for the mobile robot
systemcomposer.openModel('scMobileRobotLogicalArchitecture');

«|B

scMobileRobatLogicalArchitecture

@® |[FdscmMobilerobotiogicalarchitecture b
@ scMobileRobotLogical Architecture
£
[

Trajectory Gemarator{>a
D | =< TrajectoryGeneralor >
= Trajectory b
B
O
« | e

Trajectory Follower

_Da Robot and Environment

Motor Controller < MultibodyMobileRobot =

< MotorConiroller >

> Target
Controlinput > > Motor Input

B Measurement

Sensor Algorithm bﬁ
< SensorAlgorithm >

< xy Sensor Reading 1 <

<4q Sensor Reading 2 <

ic

sor Reading 1 B

or Reading 2 1>

Measurement [

Link Requirements to Components

Requirement traceability involves linking technical requirements to components and ports in
architecture models, thereby allowing the connection between an early requirements phase and
system-level design. You can easily track whether a requirement is met by connecting components
back to stakeholder needs. You can add requirement links by dragging requirements to a component.

To view requirements, open the Requirements Manager by navigating to Apps > Requirements

Manager.

The Self Localization Sensor Fusion component in the functional architecture model
implements the Localization requirement, SYSTEM-REQ-05. To show or hide linked requirements,
click the requirement icon on the top-right corner of a component.
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scMobileRabotFunctional Architecture B
[F2) seMobileRobotFunctional Architecture ¥ A
scM -
@
] e
[=l: Lidar Senser Scan Matching Algarithm J Self Localization Sensor Fusion 3 g SYSTEM-REQ-05 Localization
Wheel Kinematics | "Wheel Sensors
D Licar Scan b b Lidar Scan |
‘Wheel Siate 4 4 Wiheel St
= RGB Camera AR |
mage [ b Image K
i
E
= i
¥
3 & -
= r W -
- [n - Safety Observation ] Path Planning E R
g [Userintertace nm v
< 3
Requirements - scMobileRobotFunctionalArchitecture ?ox
v [ =] |03 (SIS [ a Qe
hd H scMobileRobotRequirements
> B
> B2
v E:3
E 31 SYSTEM-REQ-05
B 32 SYSTEM-REQ-06
E 33 SYSTEM-REQ-12
E 34 SYSTEM-REQ-07
E 35 SYSTEM-REQ-08
=l 4

You can view the requirements linked to the hardware architecture model in the Requirements
Browser. After selecting SYSTEM-REQ- 10, only requirements related to Sensor Life are shown.
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scMobileRobotHardwareArchitecture B Property Inspector ¥ x
® |2 scMobileRobotHardwareArchitecture ¥ v Enter Search String ~
L A
@ . . Requirement: SYSTEM-REQ-10
@ scMobileRobotHardwareArchitecture
[] ~ Properties
= |SYSTEM-REQ-10: Sensor Life 5 Type: Container =

FLENMENTS é]'l) Index: 4.2
D Lidar Sensor Custom ID: |5YSTEM-REQ-10 |
Summary: |5ensor Life |
E Point Cloud  [» p======c=ccceccccnaaq 1 Description Rationale
|
| ® 5 70 M >
A i
= The robot sensors shall be able to operate
=|s) _ i P
RGB Camera =~ ) g ! without failing for 2 years.
[ o i
i
|
O Image [»F-=---=-=---=-=-fF--------omm oo I
i !
i |
A H !
5 1 i !
z i i
g | ER
A2 o | 2
& g ! o
E £ lim v
» e >
Reguirements - scMobileRobotHardwareArchitecture ¥ x
View: |Requirements ¥ = == i c
Ga EXIE=]gR ] S S
» Revision information:
v h, scMobileRobotRequirements
B 1 ¥ Links
82 B ¢ Implemented by:
3
= ™ RGB Camera
v E=s B3 Lidar Sensor
E 41 SYSTEM-REQ-09 B = Implements:
4.2 SYSTEM-REQ-10
e e E STAKEHOLDER-07 MTBR
E 43 SYSTEM-REQ-11
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For more information on linking requirements, see “Link and Trace Requirements” on page 2-2.

Allocate Functional Components to Hardware Components

You can allocate functional components to hardware components using model-to-model allocations in
the Allocation Editor. To open the Allocation Editor, navigate to Modeling > Views > Allocation
Editor, or enter this command in the MATLAB Command Window.

% Open the Allocation Editor
systemcomposer.allocation.editor

% Load the allocation set
allocSet = systemcomposer.allocation.load('scAllocationFunctionalHardware');

Click on Scenario 1. Select Component in the Row Filter and Column Filter sections. The
Allocation Editor allows you to link components between different architecture models to establish
traceability for your project. Double-click the boxes in the allocation matrix to allocate or deallocate
two elements.




Design Architectural Models

Scenario 1
L
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- E] scMobileRobotFunctionalArchitecture
~ =] Motor Gontrol 4 A
~ [™] User Interface 4
~ [=] Path Follower 4
~ [™] Wheel Kinematics 4
~ [™] Wheel Sensors
[ Wheel Encoder2 A
[ wheel Encoder1 A
~ [=] Lidar Sensor Py
~ [™] Path Planning
[ Reach Target State Py
[=] obstacle Avoidance A
~ [™] Battery A
~ [™] Scan Matching Algorithm A
~ [*] RGB Camera 4
- ﬁ Self Localization Sensor Fusion
~ [=] safety Observation 4
~ [™] Alignment Sensor
~ [™] Motor Driver A 4

The autonomy of a vehicle is mostly handled by a target machine, which is an embedded computer
responsible for processing sensor readings to calculate control inputs. Therefore, many functional
components like Path Follower, Wheel Kinematics, and Scan Matching Algorithms are
allocated to the Target Machine component in the hardware architecture model. You can also add
allocations for ports and connectors. For more information, see “Allocate Architectures in Tire
Pressure Monitoring System” on page 6-5.

See Also
allocate | addComponent | addPort | connect

More About

. “Compose Architecture Visually” on page 1-2
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. “Decompose and Reuse Components” on page 1-16
. “Organize System Composer Files in a Project” on page 1-37
. “Create and Manage Allocations” on page 6-2
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Define Stereotypes and Perform Analysis

Stereotypes add an additional layer of metadata to components, ports, and connectors in System
Composer. A stereotype is a custom extension of the modeling language. Stereotypes provide a
mechanism to extend the architectural language elements by adding domain-specific metadata. The
hardware architecture model provides a basis to understand the applied stereotypes, create filtered
views based on the stereotypes, and perform an analysis on the model.

To access the models and supporting files used in this example, see “Simulate Mobile Robot with
System Composer Workflow” on page 4-21.

Hardware Architecture Model for Mobile Robot

The hardware architecture model describes the hardware components — the sensor, actuators, and
embedded processor — and their connections. The colors and icons indicate the stereotypes used for
each element. To open the hardware architecture model, double-click the file or enter this command
in the MATLAB Command Window.

% Open the hardware architecture model for the mobile robot
systemcomposer.openModel('scMobileRobotHardwareArchitecture');
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scMobileRobotHardwareArchitecture
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View Stereotypes and Properties in Profile Editor

In this example, the HardwareBaseStereotype stereotype is defined as an abstract stereotype and
is extended to connector and component stereotypes. For example, a DataConnector stereotype is a

connector stereotype that inherits the HardwareBaseStereotype. In addition to properties like

name and mass, the DataConnector stereotype has a property, TypeOfConnection, that describes
which of the three connection types it uses: RS232, Ethernet, or USB.

To focus on expected time before first maintenance, define properties such as UsagePerDay,

UsagePerYear, and Life. Setting these properties allows you to analyze each hardware component

to make sure the mobile robot will last until first expected year of maintenance. To open the Profile
Editor, navigate to Modeling > Profiles > Profile Editor.
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[ =] System Composer Profile Editor - [m} x
=] System Composer Profile Editor
Describe architecture profiles, stereotypes and custom property sets for use with System Composer architecture models. show more...
Profile EELNEW Profile EOpen ol Save | Stereotype E% New Stereotype % Import into | Select |~ @
Profile Browser Stereotype Properties
Filter profiles:  <all> b Name: ‘HardwareBaseStereot‘,‘pE |
Applies to: | <all> -
v [ MobileRobotProfile
€7 Actuator Base stereotype: | <nothing> -
é Controller
DataConnector Abstract stereotype
grmir:::\iis\é‘::;zszm Description: |Base stereotype used for Hardware Architecture
PowerConnector —
O PowerSupply CIlE. v
%E ;’;izzf.sor Property name Type MName Unit Default
1 Name string ¥ |n/fa n/a
2 Mass double T |n/a kg 0
3 Life double T [nfa hours 999999
4 UsagePerDay double T |n/a hours 0
5 UsagePerYear double T |n/fa days 0
6 ExceedExpectedMaint.. |boolean > |n/fa n/a O
[ show inherited properties (read-only)

Apply Stereotypes to Elements in Model

Once you define stereotypes in the Profile Editor, you can apply them to components, ports, and

connectors. Apply stereotypes using the Property Inspector. To open the Property Inspector, navigate
to Modeling > Design > Property Inspector.

To add stereotypes to elements, select the element in the diagram. In the Property Inspector, select

Main > Stereotype. You can apply multiple stereotypes to the same element. Apply the
MobileRobotProfile.Sensor stereotype to the Lidar Sensor component to add properties.
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scMobileRobotHardwareArchitecture

Referenced Files

(& B 1

O B [

schobileRobotHardwareArchitecture W

Lidar Sensor

Power

Paint Cloud [> ---

Property Inspector

Component

Architecture

Info

* Main
Mame

Stereotype

Lidar Sensor

Add.. ~

MobileRobotProfile Actuator
MaobileRobotProfile.Controller
MobileRobotProfile. Mechanica
MobileRobotProfile. PowerSupg
MaobileRobotProfile Processor
MobileRobotProfile. Sensor k
<Mew / Edit>
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Some components remain in use for longer periods of time than others. The Lidar Sensor
component is used for obstacle avoidance in this scenario, so it is always in use except when it is
charging. The RGB Camera only aligns the robot to the charging station, so it is in use for a shorter
period per day. You can change values for the UsagePerDay, UsagePerYear, and Life properties to
determine the expected maintenance time for components that are each used with different

frequency.
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®

ENE NE N

O &

= &

scMobileRobotHardwareArchitecture Property Inspector

«|B

schMobileRobotHardwareArchitecture ¥ Component

A Architecture Info

“ Main

Name

stereotype

¥ Sensor
s Mame
Lidar Sensor ") Mass
Life
UsagePerDay

Point Cloud prr-—---—-—=———- UsagePerYear

RGB Camera )

Image [ F--=—=mmmmmmmm e ,

Power

L b

Lidar Sensor
Add..
Select

0kg

10000 hours
20 hours
365 days

[ exceedexpectedMaintenance

The property ExceedExpectedMaintenance is set to false by default. This property will update

when you run your analysis.

Architecture Views for Hardware Architecture Model

Use the Architecture Views Gallery to review changes you make in the architecture model.
Architecture views allow you to create filtered views and thereby focus on few elements of the model,

which enables you to navigate a complex model more easily.

For example, an electrical engineer might be interested only in the electrical components of the

hardware architecture. The engineer could apply a filter to show only components with electrical

stereotypes.

1 To open the Architecture Views Gallery, navigate to Modeling > Architecture Views.

2 Select New > View to create a new view.

3 Name the view in the View Properties pane on the right.

4 In the bottom pane, under View Configurations > Filter, select from the list Add Component

Filter > Select All Components to show all components in the view.

Select Apply v

6 Select the Component Hierarchy view. The hierarchy of the components is flattened to show all

subcomponents in one view.
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[l Mobile Robot

'y

‘ Controller
«<Controllers
«<HardwareBaseStereolypes

ExceedExpeciediaintenance: boolean = faise

FA

=

Emergency Switch
<HardwareBaseStereotype
ExceedExpeciediaintenance: boolean = false:

)

Lidar Senser

<HardwareBaseStereotypes

X 1
) ‘ Mobile Robot Case

8

Life- double (hours)
Mass: double (kg
Name: siring

UsagePerDay: double (hours)

UsagePervear. double (days)
Ports

aut User Input

7

Life: double (hours) = 999999
Mass: double (kg) = 0
Name: string
UsagePerDay: double (nours) = 0
UsagePerYear double (days) = 0
sMechanicalComponents
Ports

ExceedExpectedMaintenance: boolean = false
Life: double (hours) = 10000
Mass: double (kg) = 0
Hame: shing
UsagePerDay: double (hours) = 20
UsagePerYear double (days) = 365
Sensors
Ports
i Power
out Point Cloud

<HardwareBassStersotypes
ExceedExpectedMaintenance: boolean = faise
Life: double (hours) = 999999
Mass: double (kg) = 0
Name: string
UsagePerDay. double (hours}
UsagePerVear double (days)

«MechanicalComponent

Ports

Power Supply Board
«HardwareBaseStereotypes
ExceedExpeciediaintenance: boolean = false
Life: double (hours) = 999999
Mass: double (kg) = 0
Name: string
UsagePerDay: double (nours) = 0
UsagePerYear. double (days) = 0
«PowerSupplys
Ports
in  Batiery Poer
in Power
out 12V DC
out 5V DC

o { RGE Camera

<HardwareBaseStereotypes

ExceedExpectedMaintenance: boolean = false

Life: double (hours) = 1000
Mass: double (kg) = 0
Hame: string
UsagePerDay: double (hours
UsagePerYear double (days)

«Sensors

Ports

in Power
out Image

Non-actuated Wheel
Ports

Wheel Unit1
<ActuatorSet>
Ports

i Actuator Input
in Power
out Encoder Reading

!

Encoder
«HardwareBaseStereolypes
ExceedExpeciediaintenance: boolean = false
Life: double (hours) = 15000
Mass: double (kg) = &
Name: siring
UsagePerDay: double (hours) = 20
UsagePervear. double (days) = 365

«Sensors

Gear

«HardwareBase Stereotypes
ExceedExpectediaintenance: boolean = false
Life: double (hours) - 999999
Mass: double (kg) =0
Name: siring
UsagePerDay: double (hours) =0
UsagePervear double (days) = 0

«lechanicalComponents

o |

Motor
«Actuators
«HardwareBaseStereotypes

ExcesdExpectedMaintenance: boolean = faise

Mass: double (kg) = 0

Hame: string

UsageRerDay: double (hours) = 20
UsagePerYear double (days) = 365

8

You can apply a filter to view components with the Life Expectancy requirement. Select New >
View and name the view in the View Properties pane on the right.

In the bottom pane under View Configurations > Filter, select Add Component Filter.
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Life Expectancy
Views kb Life Expectancy

é A
I Life Expectancy

Stereotype
; Name

MobileRobotProfile. HardwareEaseStereotype Name

~onfigurations MobileRobotProfile HardwareBaseStereotype Mass _

FILTER GROUPING | MobileRobotProfile HardwareBaseStereotype. Life |

|m’ Add Component Filter '| |}15 Add Port Filter v| |Q? RDD|Y| MobileRobotProﬂIe.Hard\f.'areBaseStereotype.UsagePle}Day
MobileRobotProfile. HardwareEaseStereotype UsagePeryear

[ COMPONENT FILTER _ )
MobileRobotProfile. HardwareBaseStereotype. ExceedExpectedMaintenance

Select | Components - | Where |MobiIeRobotProﬂIe.Hard\-‘.'areBaseSte... | - | = - | |999999 | |Lrit

%

Select Apply 4
10 Observe the components with the Life property defined.
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Life Expectancy

Mobile Robot Case [

Wheel Unitl/Gear [

Wheel Unit2iGear [

Charge Board O

Fawer

Battery [w}
Pousr
Emergency Switch ]

Wheel Unit2/Wheel

Wheel Unit1/Wheel

Power Supply Board a

Battery Power 12VDC ¢

Paowar avoc

Target Machine

Commands
Encoder Reading 1
Encoder Reading 2
Image

Point Cloud

> Power

Wheel Unit1/Motor Driver

. Actustor Input

Wheel Unit2/Motor Driver

(> Actuator Input

The components with the Life property defined are components for which expected time before
first maintenance is a concern.

Analyze Hardware Components for Life Expectancy

Analyze the system to check if the components and connectors will last longer than the expected time
before first maintenance. This value is set to two years in the analysis function. Navigate to
Modeling > Views > Analysis Model to open the Instantiate Architecture Model dialog box.

Select all stereotypes to make them available on the instance model. Select
scMobileRobotAnalysis.m as the analysis function. The iteration order determines in what order

the component hierarchy is analyzed. However, since each component is analyzed separately, the
order does not matter. Select the default Pre-order.
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Instantiate Architecture Model

Description

Create an instance model from this architecture model by flattening out all referenced models and their components. Such an
instance model may be used for system-level analysis expressed as MATLAB functions.

Step 1: Select Stereotypes

Select the stereotypes to make available on
the instance model

v MebileRobotProfile
Actuator
Controller
DataConnector
HardwareBaseStereotype
MechanicalComponent
PowerConnector
PowerSupply
Processor
Sensor

Strict Mode

Don't see your profile? | Profile Editor ...

Step 2: Configure Analysis
Function

Analysis function:

|scHobileRobotAnalysis

Function arguments (comma-separated):

=

Q@

o

»> scMobileRobotAnalysis(instance)

Model Tteration

Iteration Order: | Pre-order

Instance Model Properties

Name: |5cHob:'L1ERobotHar‘dwar*eAr‘chitectur*e

] Mormalize Units

33 Cancel b Instantiate

Click Instantiate to instantiate the model. Relevant components and connectors with stereotypes are
shown. Since all stereotypes are selected, all elements with stereotypes are shown in the instance

model. Model analysis will calculate which components and connectors will last longer than the

expected two years. Click Analyze to perform the calculation.
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=7 Instances
4 [ scMobileRobotHardwareArchitecture
O Battery
O Charge Board
o Controller
O Emergency Switch
O Lidar Sensor
O Mobile Robot Case
O Power Supply Board
O RGB Camera
O Target Machine
4 (g Wheels
+ (3 Wheel Unit1
o Encoder
o Gear
o Motor
o Motor Driver
o Whee
4 B Wheel Unit2
O Encoder
o Gear
o Motor
o Motor Driver
o Whee
- Battery:Power->Power Supply Board:Battery Power
= Charge Board:Power->Power Supply Board:Power
-+ ControllerUser Input->Target Machine:Commands
= Lidar Sensor:Point Cloud->Target Machine:Point Cloud
-= Power Supply Board:12V DC->Target Machine:Power
-= Power Supply Board:12V DC->Wheels:Power
= Power Supply Board:5V DC-»Lidar Sensor:Power
= Power Supply Board 5V DC->RGE Camera:Power
+= RGB Camera:lmage->Target Machine:Image
= Target Machine:Actuator Input->Wheels:Actuator Input
= Wheels:Encoder Reading 1->Target Machine:Encoder Reading 1

TypeOfConnection

USB
Ethernet

UsB
RS232
RS232

= Wheels:Encoder Reading 2->Target Machine:Encoder Reading 2 |RS232
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The components for which usage is not defined are components that last significantly longer than the
expected time and are therefore excluded from analysis. The analysis function calculates whether the
time before first maintenance for each component and connector will exceed Life, which is set to
two years. The unchecked boxes indicate that components and connectors will need maintenance

within two years.

To refresh the instance model in the Analysis Viewer, select Overwrite, then click Refresh. This
action will retrieve the values back from the source model, in this case, the hardware architecture
model. Since ExceedExpectedMaintenance was the only property changed, it reverts back to its
default value. Conversely, when you click Update the property values in the hardware architecture

source update according to the instance model.

See Also

applyProfile | applyStereotype | openViews | instantiate

More About

. “Define Profiles and Stereotypes” on page 4-2

. “Use Stereotypes and Profiles” on page 4-9

. “Create Architecture Views Interactively” on page 8-5
. “Analyze Architecture” on page 6-10
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Simulate Architectural Behavior

To simulate the mobile robot logical architecture, link Simulink models to the components. These
linked models act as Simulink behaviors and can be simulated in System Composer by selecting Run.
To access the models and supporting files used in this example, see “Simulate Mobile Robot with
System Composer Workflow” on page 4-21.

Add Simulink Behavior to Architecture Models with Bus Ports

The initial logical architecture model describes the behavior of the mobile robot system — trajectory
generator, trajectory follower, motor controller, and robot and environment — for simulation. The
connections represent the interactions in the system. To open the initial logical architecture model,
double-click the file or enter this command in the MATLAB Command Window.

% Open the initial logical architecture model for the mobile robot
systemcomposer.openModel('scMobileRobotLogicalArchitectureInitial');

.
Trajectory Generator & =
= TrajectoryGenerator = Trajectory Follower u > Robot and Environment *
S UE e Motor Controller o < MultibodyhabilaRiabat >
= MatorCantrollar =

Trajectory B b+ Waypoints
Sensor Reading 1 b
TargeiSpeed [» b Measurament E I i
. Controlinput > > Maotor Input. . Sénsar Reading 2 b
b Targei
WhasalMaasurement B

The structure of the logical architecture is similar to that of a Simulink model because simulation
models are designed based on the flow of information. The components of the logical architecture
model are linked to behavior models so that the architecture model can be simulated.

Each component is responsible for one or more functions defined in the functional architecture
model. The Trajectory Follower component is responsible for calculating the wheel speed of the
robot based on the path the generator created. The lower-level Motor Controller component
controls the speed of each actuator motor according to the output from the Trajectory Follower
component.

Note that some components are omitted from this example model. For example, sensor models like
Lidar Sensor and RGB Camera are not required in this model because the true value from
simulation gets the x-y position and orientation of the robot. For more complex simulations, you can
add sensor models like RGB Camera to test different algorithms, such as object recognition. If you
were to add such a sensor model, Lidar Sensor, another behavior component, would be required to
decipher the sensor data in the Scan Matching Algorithm component.

Add Sensor Algorithm Component with Simulink Behavior

Simulate the logical architecture model by adding Simulink behavior to a Sensor Algorithm
component.

1 Create a Sensor Algorithm component. Add two input ports on the right side called Sensor
Reading 1 and Sensor Reading 2. Add two output ports on the left side called xy for x-y
position and q for quaternion.
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Trajectory Generater #EI
< TrajectoryGenerator = Trajectory Follower t"i.'u
Al il Motor Controllar b

< MotorController >
Trajectory B

b Waypaoints

by k TargatSpeed [ b Mazaurament

Caontrolingut >

> Target

Sensor Algorithm

<] ®y Sensor Reading 1

44q SensorResding 2 4

2

Robot and Environment -PEI
= hMuttibodyhdobileRobot =

Senzor Reading 1 >
B Matar Input - | Sansor Reading 2

WheelMeaasurement B

To create a new Simulink behavior, right-click the Sensor Algorithm component and select

Create Simulink Behavior. From the Type list, select Model Reference. Choose a new

model name. In this example, it is SensorAlgorithm.

Create Simulink behavior

Create a Simulink behavior and, optionally,
export local interfaces to a new shared data dictionary.

Type Model Reference

New file name: SensorAlgorithm

From Simulink template:
Default

New data dictionary name:

OK Cancel

0 X

Browse...

Help

Click OK. The new Simulink model is saved in the current folder. The component is converted to

a reference component.
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Trajectory Generator "'EI
< TrajectoryGenerator > Trajectory Follower {'ﬁ _ba

Robot and Environment

-
Motor Controller G < MultibodyhaobileRobat >
< MuotorController =

= TrajectoryFollower =

Trajectory B b+ Waypoints )
Sensor Reading 1 b
b xy I TargetSpeed b= I Measurement . i 1
. Controlinput B> B+ Motar Input. - Sensor Reading 2 [+
B q b Target
WhealMeasurement [

=
Sensor Algorithm O
< SensorAlgorithm =

< wy Sensor Resding 1 <

<4 q SensorReeding 2 4

To edit the behavioral model, double-click the Sensor Algorithm component. Observe that bus
element ports are created during the conversion process. For more information on setting bus
ports, see “Explore Simulink Bus Capabilities”.

Sansor Reading 1 ” ’ xy
Sensor Reading 2 ” ’ q

Any port block can be used to connect different components. Convert the Sensor Reading 2
bus port and the q bus port into regular Inport and Outport blocks by deleting them and
recreating them as Inport and Outport.

Sansor Reading 1 il oy

D »(2)

Sensor Reading 2

Double-click the Sensor Reading 1 bus port to view its properties, then pause on the name
Sensor Reading 1 and click the pencil icon to open Attributes. Set the Dimensions to 2.
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Properties of input port: Sensor Reading 1 *

Attributes of "Sensor Reading 1"

Data type: | Inherit: auto

Dimensions: | 2]

Dims mode: [Inherit
Unit: | inherit

Sample time:

Complexity:

Minimum:

Maximum:

6 Double-click the Sensor Reading 2 port to open Block Parameters, then switch to the
Signal Attributes tab. Set the Sensor Reading 2 port Port dimensions to 4.
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Block Parameters: 5ensor Reading 2 Y
Inport

Provide an input port for a subsystem or model.

For Triggered Subsystems, 'Latch input by delaying outside signal’ produces
the value of the subsystem input at the previous time step.

For Function-Call Subsystems, turning 'On’ the ‘Latch input for feedback
signals of function-call subsystem outputs' prevents the input value to this
subsystem from changing during its execution.

The other parameters can be used to explicitly specify the input signal
attributes.

Main  Signal Attributes
[ output function call

Minimum: Maximum:
[ BRI
Data type: | Inherit: auto w|d >>

[ Lock output data type setting against changes by the fixed-point tools
Unit (e.g., m, m/s*2, N*m): SI, English, ...
| inherit |

Port dimensions (-1 for inherited):
[+ [E

Variable-size signal: | Inherit -
Sample time (-1 for inherited):
[1

Signal type: |auto -

" ] Cancel Help Apply

7 Return to the logical architecture and connect the components. The result should look like
scMobileRobotLogicalArchitecture.slx in the next section.

Logical Architecture Model for Mobile Robot

The logical architecture model describes the behavior of the mobile robot system — trajectory
generator, trajectory follower, motor controller, sensor algorithm, and robot and environment — for
simulation. The connections represent the interactions in the system. To open the logical architecture
model, double-click the file or enter this command in the MATLAB Command Window.

% Open the logical architecture model for the mobile robot
systemcomposer.openModel('scMobileRobotLogicalArchitecture');

4-47



4 Define Architectural Properties

scMobileRobatLogicaldrchitecture

®

scMobileRobotLogicalArchitecture ¥

B e e e Ee

Bl [
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A 2 E

< TrajectoryGeneralor =

scMobileRobotLogicalArchitecture

Trajectory Generator &

Trajectory Follower i ¥ Robot and Environment i
< TrajectoryFollower > Motor Controller < MultibedyMabileRabat >
< MotorController >
Trajectory [ > Waypoints
Sensor Reading 1 [>
[T TargetSpead > > Target
Controlinput > > Motor Input Sensor Reading 2 [
[} > Measurement
WheelMeasurement [

Sensor Algorithm bﬁ
| < SensorAlgorithm > |

< xy Sensor Reading 1 <1

dq Sensor Reading 2 <
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A behavior algorithm is created based on port information only. When designing a logical
architecture, you can set the interface of the port to define the information in more detail. For
example, if you know that 800 x 600 RGB images captured at 24 frames per second are transferred
from the camera sensor, then you can set the corresponding port interfaces accordingly to ensure
efficient data transfer. For more information about setting interfaces, see “Define Port Interfaces
Between Components” on page 3-2.

Running Simulation Using Logical Architecture

Once behavior models are linked, you can simulate the architecture model just like any other
Simulink model by clicking Run. Simulation verifies requirements such as Transportation,
Collision Avoidance, and Path Generation.

The scope from the MotorController component behavior shows how well a simple P-gain
controller performs to follow the reference velocity for one of the wheels on the robot.

«|H
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4. Scope - [scMobileRobotLogical Architecture2] — O *

File  Tools  View  Simulation  Help u

G- AP ® = A& 05 FH-

Ready Sample based T=10.000

Run this script to observe how well the robot follows the waypoints.

out = sim('scMobileRobotLogicalArchitecture.slx"');
% waypoints are manually defined in Constant block
waypoints = eval(get param('TrajectoryGenerator/Manual Waypoints', 'Value'));

figure

hold on
plot(out.pose.Data(:,1),out.pose.Data(:,2))
plot(waypoints(:,1),waypoints(:,2))

hold off

xlabel('X Position (m)"')

ylabel('Y Position (m)"')

legend('Actual Trajectory', 'Commanded Trajectory')
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See Also
createSimulinkBehavior
More About
. “Define Port Interfaces Between Components” on page 3-2
. “Explore Simulink Bus Capabilities”
. “Describe Component Behavior Using Simulink” on page 5-2
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Use Simulink Models with System
Composer

* “Describe Component Behavior Using Simulink” on page 5-2

» “Extract Architecture of Simulink Model Using System Composer” on page 5-10
* “Describe Component Behavior Using Stateflow Charts” on page 5-16

» “Extract Architecture from Simulink Model” on page 5-21

* “Describe System Behavior Using Sequence Diagrams” on page 5-25

* “Use Sequence Diagrams with Architecture Models” on page 5-41

* “Describe Component Behavior Using Simscape” on page 5-54



5 Use Simulink Models with System Composer

Describe Component Behavior Using Simulink

System design and architecture definitions can involve a behavior definition for some components,
such as the algorithm for a data processing component. Define components in System Composer
architecture models as inlined behaviors using Simulink subsystem components, or referenced
behaviors by linking components to Simulink models.

You can simulate the Simulink component implementations in System Composer. To observe
simulation results, see “View Data in the Simulation Data Inspector”.

Create Simulink Behavior with Robot Arm Model

This example shows how to use a robot arm model to create Simulink® behavior from the Motion
component.

1. Open the Robot. s1x model.

model = systemcomposer.openModel('Robot');

5-2



Describe Component Behavior Using Simulink

Robot i)
® [[Z]robat ¥ hd
Robot
3l
[:
Sensor
E Encodar <
N \i
t> 4l TargetPosition -E
g
(=] .
Trajectory Planning E Motion
&
I:‘ — Sensarflata q\ ﬂ:- SensorData
TargetPosition b—{ > Targe on ” \ Encader b }—
MotionCommand = [ MotionCommand
[T
» | Heh
Interfaces LD 4
& -] (&[]][] seeren q
Type Uniis
~ @ RobotDD.sldd
= [i] sensordata
timestamp double seconds
direction double degrees
direction2 double degrees
distance double meters
distance2 double meters
position1 double degrees
position2 double degrees

The Robot model has an interface sensordata applied on the ports SensorData.

2. Look up the Motion component.
motionComp = lookup(model, 'Path', 'Robot/Motion');
3. Create a Simulink behavior.

motionComp.createSimulinkBehavior('MotionSimulink');
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Create Referenced Simulink Behavior Model

When a component does not require decomposition from an architecture standpoint, you can design
and define its behavior in Simulink. When you link to a Simulink behavior, the Component block
becomes a Reference Component block. A reference component represents a logical hierarchy of
other compositions. You can reuse compositions in the model by using reference components.

1 Right-click the Motion component and select Create Simulink Behavior. Alternatively,
navigate to Modeling > Component > Create Simulink Behavior.

2  From the Type list, select Model Reference. Provide the model name MotionSimulink. The
default name is the name of the component.

Create Simulink behavior

Create a Simulink behavior and, optionally,

export local interfaces to a new shared data dictionary.

Type Model Reference

New file name:

MotionSimulink

From Simulink template:

Default

New data dictionary name:

RobotDD.sldd

OK

Cancel

0 X

Browse...

Help

3 A new Simulink model with the provided name is created. The root level ports of the Simulink
model reflect the ports of the component. The component in the architecture model is linked to

the Simulink model. The e icon on the component indicates that the component has a Simulink
behavior.

Motion
< MationSimulink =

b= SensorData

[+ MotionCommand

iIc

=

Encoder b

B U E e

Bl

g O

‘W Motion

B

Robot 4 @Motion (MotionSimulink)

4

SensorData @

MotionCommand @

@ Encoder
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4  You can continue to provide specific dynamics and algorithms in the referenced Simulink model.
Adding root-level ports in the Simulink model creates additional ports on the System Composer
Reference Component block.

To view the interfaces on the SensorData port converted into Simulink bus elements, double-click on
the port in Simulink.

® |2Rrobat P [ Matian (MotionSimulink)

@ I B e

O @

SensorDala@

MotionCommand @

You can access and edit a referenced Simulink model by double-clicking the component in the

Properties of input port: SensorData

Select elements of a bus or the entire bus, signal, or message from the
input port.

Port name: | SensorData Port number: | 1 Set color ~

Sl | Filter...

timestamp  (dt: d

direction
direction2 (d
distance1
distance2
position1

position2

architecture model. When you save the architecture model, all unsaved Simulink behavior models it

references are also saved, and all linked components are updated.

Create Simulink Behavior Using Simulink Subsystem

A subsystem component is a Simulink subsystem that is part of the parent System Composer
architecture model. Add Simulink subsystem behavior to a component to author a subsystem
component in System Composer. You cannot synchronize and reuse subsystem components as
Reference Component blocks because the component is part of the parent model.

1 Right-click the Sensor component and select Create Simulink Behavior. Alternatively,
navigate to Modeling > Component > Create Simulink Behavior.

2 From the Type list, select Subsystem.
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Create Simulink behavior — ] X

Create a Simulink behavior and, optionally,
export local interfaces to a new shared data dictionary.

Type Subsystem M
New file name: Sensor Browse...

From Simulink template:
Default M

New data dictionary name:
RobotDD.sldd

OK Cancel Help

3 The Sensor component is now a Simulink subsystem of the same name that is part of the parent
System Composer architecture model.

The root-level ports of the Simulink model reflect the ports of the component. The i icon on the
component indicates that the component has a Simulink subsystem behavior.

<& 4 Sensor B
® DRobot ¥ P& Sensor v
@
e =
Sensor -
Bl
>@ SensorData -
Encoder <) ===/ (& >@ SensorData
Encoder @) O
v Encoder @)
-
[-H
«

4  You can continue to provide specific dynamics and algorithms in the inlined Simulink behavior
model. Adding root-level ports in the inlined Simulink model creates additional ports on the
Simulink subsystem component.

Subsystem components are required to author Simscape™ component behaviors with physical ports,
connections, and blocks. For example, this amplifier physical system uses electrical domain blocks
inside a subsystem component in a System Composer architecture model.
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_Amplifier {ba

|

i\ i <| — B

For more information, see “Describe Component Behavior Using Simscape” on page 5-54.

Link to an Existing Simulink Behavior Model

You can link to an existing Simulink behavior model from a System Composer component, provided
that the component is not already linked to a reference architecture. Right-click the component and
select Link to Model. Type in or browse for the name of a Simulink model.

Link to model - O *

Link to the specified model.

Model name: hodels\MotionSimulink.st Browse...

Cancel Help

Any subcomponents and ports in the components are deleted when the component links to a Simulink
model. A prompt displays to continue and lose subcomponents and ports.

Note Linking a System Composer component to a Simulink model with root-level enable or trigger
ports is not supported.

You can link protected Simulink models (. s1xp) to create component behaviors. You can also convert
an already linked Simulink behavior model to a protected model. The change is reflected when you
refresh the model.

Create a Simulink Behavior from Template for a Component

To create user-defined templates for Simulink models, see “Create Template from Model”.
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After creating and saving a user-defined template, you can link the template to a Simulink behavior.
Right-click the component and select Create Simulink Behavior, or, navigate to Modeling >

Component > Create Simulink Behavior.

Create Simulink behavior —

Create a Simulink behavior model and, optionally,
export local interfaces to a new shared data dictionary.

[] Create inlined behavior component.

New model name: Component

From Simulink template:
TemplateSimulink ©
New data dictionary name:

ExampleModelDD

Cancel

Browse...

Help

On the Create Simulink behavior dialog, choose the template and enter a new data dictionary
name if local interfaces are defined. Click OK. The component exhibits a Simulink behavior according
to the template with shared interfaces, if present. Blocks and lines in the template are excluded, and
only configuration settings are preserved. Configuration settings include annotations and styling.

Note that you can use architecture templates by right-clicking a component and selecting Save As
Architecture Model, or navigating to Modeling > Component > Save As Architecture Model.

Save component as an architecture model O

Save architecture model and, optionally, export local
interfaces to a new shared data dictionary.

New model name: |Component

From architecture template:

Robot =
New data dictionary name:

RobotDD

Cancel

Browse...

Help

X

See Also

Functions

createSimulinkBehavior | createSubsystemBehavior | lLinkToModel |

createArchitectureModel

Blocks
Reference Component

More About

. “Decompose and Reuse Components” on page 1-16
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“Describe Component Behavior Using Stateflow Charts” on page 5-16
“Describe Component Behavior Using Simscape” on page 5-54
“Describe System Behavior Using Sequence Diagrams” on page 5-25
“Organize System Composer Files in a Project” on page 1-37

“Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Extract Architecture of Simulink Model Using System
Composer

5-10

Export an existing Simulink® model to a System Composer™ architecture model. The algorithmic
sections of the original model are removed and structural information is preserved during this
process. Requirements links, if any, are also preserved.

Convert Simulink Model to System Composer Architecture

System Composer converts structural constructs in a Simulink model to equivalent architecture
model constructs:

* Subsystems to components

* Variant subsystems to variant components

* Bus objects to interfaces

* Referenced models to reference components

Open the Model

Open the Simulink model of the VR Power Window Model.

slexPowerWindowStart



Extract Architecture of Simulink Model Using System Composer

g o || = || ER
File View Viewpoints Mavigation Rendering Simulation Recording Help o
Main View ~ | Examine 4.' il B ] Cf o} Ei b =

hain i T=0.00 Examine Pos:[-500.00 -25.00 -1:30.00] Dir:[0.59 0.00 0.43]

open_system('slexPowerWindowExample');
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| Open Interactive Test Model i

ammiatura_current
Continuous
. . | Pasition EI
driver_switch v ammature_current ]
— move_up —| move_up - ampture_current "
Mormal neutral Je| diriver_neutral armature_current
up Je| diriver_up position .- ] —
position
™ down | driver_down move_down position
|_. 4
p ]
Maormal nautral | pasEenger_nautral foree force "
maove_down
up | pasEEnger_up
) objact_prasent gear_anghe | gear angle
|__,'- down (o ger_down -
L ™
passenger_switch - L= =
power_window _control_systemn window_system .
present objact_prasent
CF—- G
|_. 4

II'—’-Q/G window_world
absent abject
Copyright 2013-2016 The MathWorks, Inc.

Export the Model

Extract an architecture model from the original model.

systemcomposer.extractArchitectureFromSimulink('slexPowerWindowExample', 'PowerWindowArchModel"');
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Chd o || = || E8
File  View Viewpoints Mavigation Rendering Simulation Recording Help o
Main View ~ | Examine 4.' ol B ] Cf a, Ei b =

hain i T=0.00 Examine Pos:[-500.00 -25.00 -1:30.00] Dir:[0.59 0.00 0.43]

Simulink.BlockDiagram.arrangeSystem('PowerWindowArchModel");
systemcomposer.openModel ('PowerWindowArchModel');
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PowerWindowArchModel

Architecture extracted from Simulink model: 'slexPowerWindowExample'. [26-Aug-2020 08:35:11]

window_system

— '[:- mowve_up

move_down

{ :t:- abject_present

armaturs_current b

i
[

farce b )

=

gear_angle [:’.—

window_world
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_ neumslb)—— power_window_control_system
['.
— e I;E L armature_current
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1 . e .
(= driver_neutral move_up e —
) ——
{ B driver_up
passenger_switch - e
(B driver_dawn |
. e e
— neutral f (B passenger_neutral | v o D)
L ; _down b)—
e up, > | {b» passenger_up
[ ;
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r -
More Info1 |
ah

extractArchitectureFromSimulink

More About

. “Extract Architecture from Simulink Model” on page 5-21

. “Compose Architecture Visually” on page 1-2

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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“Modeling System Architecture of Small UAV” on page 1-31
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Describe Component Behavior Using Stateflow Charts

5-16

A state chart diagram demonstrates the state-dependent behavior of a component throughout its
state lifecycle and the events that can trigger a transition between states. Add Stateflow chart
behavior to describe a System Composer component using state machines. You cannot synchronize
and reuse Stateflow chart behaviors as Reference Component blocks because the component is part
of the parent model.

You can simulate the Stateflow component implementations in System Composer. To observe
simulation results, see “View Data in the Simulation Data Inspector”.

State charts consist of a finite set of states with transitions between them to capture the modes of
operation for the component. Charts allow you to design for different modes, internal states, and
event-based logic of a system. You can also use charts as stubs to mock a complex component
implementation during top-down integration testing. This functionality requires a Stateflow license.
For more information, see “Stateflow”.

Add State Chart Behavior to a Component

A System Composer component with stereotypes, interfaces, requirement links, and ports, is
preserved when you add Stateflow Chart behavior.

1 This example uses the architecture model for an unmanned aerial vehicle (UAV) to add state
chart behavior to a component. In the MATLAB Command Window, enter the following command:
scExampleSmallUAV

2 Double-click the Airframe component. Select the LandingGear component on the System
Composer composition editor.

3  Select the Brake port. Open the Interface Editor from the toolstrip Design > Interface Editor.
Right-click the interface operatorCmds and select Assign to Selected Port(s).

4 Right-click the LandingGear component and select Create Stateflow Chart Behavior.
Alternatively, navigate to Modeling > Component > Create Stateflow Chart Behavior.
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Airframe

b ctriSrfcDeflection

b +lightCmds

lightCmds . NavigationLights [

ctriSrfcDeflection . dA_dF

ctriSrfcDeflection . Brake [

lightCmds . LandingStrobe [

ctriSrfcDeflection . dR_dE [

Wings

p> Navigation Lights

b dA dF

LandingGear

P Brake

Tail anc ub';

W

ey
> Landing M=

B> dR_dE

< Fuselage <
Explore
Open In New Tab

Open In New Window

Cut
Copy
Paste

Delete

Save As Architecture Model...

Create Software Architecture Model...
Create Simulink Behavior...

Create Stateflow Chart Behavior

Link to Model...

Ctrl+X
Ctrl+C
Ctrl+V
Del

(s

Double-click LandingGear, which has the Stateflow icon. Navigate to Modeling > Design Data
> Symbols Pane to view the Stateflow symbols. The input port Brake appears as input data in

the symbols pane.

Note Some Stateflow objects remain local to Stateflow charts. Input and output event ports are
not supported in System Composer. Only local events are supported.
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Model Browser = ¥ %

¥ | scExampleSmalluavModel
hd D Airframe
D Fuselage
Fé LandingGear
D Tail and Boom
D Wings
> D Flight Support Components
> D FlightComputer
> D Payload
hd D Propulsion
> D Engine
> D Fuel System
> D Power Madule
™ Prop

> D SupervisoryComputer

Property Inspector

Enter Search String

Component

Architecture Properties Info

&,'_I o LandingGear

] scExampIESmaIIUA\l’Model 4 DAirframe 3 %L.andingGear
Q)

E3

O

"

u

Interfaces

& -]&-]

- |E® v|| Search

Q

|v @3 scExampleSmallUAVModel.shx

» [ architecture_gsCommands
b [ ciriSricDeflection

» [:l gz commands bus

¥ Main
Mame LandingGear
Stereotype Add..
¥ OnbeardElement Select
Mass 1.65 kg
Power 0 mW
RFHarnessLength Oem
Symbols

@eEeE@-T
TYPE NAME VALUE  PORT

Brake 1

Since Stateflow ports show up as input and output data objects, they must follow Stateflow
naming conventions. Ports are automatically renamed to follow Stateflow naming conventions.
For more information, see “Guidelines for Naming Stateflow Objects” (Stateflow).

6 Select the Brake input and view the interface in the Property Inspector. The interface can be
accessed like a Simulink bus signal. For information on how to use bus signals in Stateflow, see
“Index and Assign Values to Stateflow Structures” (Stateflow).

Property Inspector I BES
Brake
Properties Infio
Scope Input -
Port 1 -
Size | -1 |

b Advanced

Type I Bus: operatorCmds e

Symbols

7  You can populate the Stateflow canvas to represent the internal states of the LandingGear.
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fe=] ur LlandingGear *  FlightComputer Fuel System Engine Flight Support Components Payload i
® scExampIeSmaIIUA\-’Model » DAirframe » tPéLandingGear h
@

EZ

O

o3

\ Switch == true

= | (Deployed h [ ] Stowed

@)

5 [Switch == false]

N\

4H

[

Remove Stateflow Chart Behavior from Component

You can remove Stateflow chart behavior from a component to delete the contents inside the
Stateflow chart while preserving interfaces on the component.

1

Right-click on the LandingGear component and select Inline Behavior.

. Brakelp— > Brake

dR_dElr— > dR_dE

| LandingGear

. " & Cut
Tail and 50]1 2 Copy

jStobel (> Landing Strob I

ﬂ'\-.
Fuselage

Explore

Open

Open In New Tab
Open In New Window

Ctri+X
Ciri+-C
Ctri+V
Del

i} Paste

Delete

Add Variant Choice

Apply Sterectype ]
Create Spotlight From Component

Eacnunid S

To confirm the operation to delete all the content inside the Stateflow chart, click OK.
The Stateflow chart behavior on the component is removed. Interfaces on the component are

preserved.
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5-20

LandingGear

ctriSrfcDeflection . Brake P > Brake

See Also
createStateflowChartBehavior | inlineComponent

More About

“Compose Architecture Visually” on page 1-2

“Decompose and Reuse Components” on page 1-16

“Describe Component Behavior Using Simulink” on page 5-2
“Describe Component Behavior Using Simscape” on page 5-54
“Extract Architecture from Simulink Model” on page 5-21

“Describe System Behavior Using Sequence Diagrams” on page 5-25



Extract Architecture from Simulink Model

Extract Architecture from Simulink Model

You can use System Composer architecture editing and analysis capabilities on Simulink models. To
do so, extract the architecture from a Simulink model. Model and Subsystem blocks, as well as all
ports in a Simulink model represent architectural constructs, while all other blocks represent some
kind of dynamic or algorithmic behavior. In the architecture model that you obtain from a Simulink
model, you can choose to represent architectural constructs or link to behavior models.

1

3

Open an example model.

openExample('ReferenceFilesForCollaborationExample')

On the Simulation tab, click the Save arrow. From the Export Model To list, select
Architecture Model.

*L ex_modeling_compaonent_reuse - Simulink prerelease use — O X
SIMULATION
O~ OE Stop Time | 30 o~ = e
ar) E | | (ﬂ ) 0> - b
E ™ Hormal - he
l . FREFARE _ ik Stop Data
- - Forward Inspector
il ﬁ Save Cir+5 = REVIEW RESULTS ry
ex_m
@ odvie ape MEIEls = v = » -
I Save as...
€3 Save Viewmark Cirl+Shift+D
— ~ Caplure model's current view for fulure access
EXPORT MODEL TO
eeortmopeLo [N
Web View...
Ig Export model to browser-enabled read-only view
sen:
O - Protected Model... N
Create an IP-protected copy of this model
Template...
== Create reusable template from this medel
& Previous Version... Mechanical System
= Export model to previous version of Simulink
Architecture Model...
b ﬁ Expart model to Architecture I} flerke, fae
Ready 80% VariableStepAuto

Provide a name and path for the architecture model.
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Export To Architecture model -
Description

Create a new model that contains the structural architecture
(components and interfaces) of the current model for use with System
Composer.

Configuration

Source model(s): |ex_modeling_component_reuse

Architecture model name: |ex_mc:deling_cnmponent_reus.e_arch.slx |

Destination folder: |H:\Sy5tern Composer\ymodels | L 3
(2) Help 2% Cancel | | < Export

4 Click Export. A System Composer Editor window opens with an architecture model

corresponding to the Simulink model.
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{'i ex_madeling_component_reuse_arch * - Simulink — O >
SIMULATION MODELING
L - I % Stop Time | 10.0 o -
- B H & =
! e Mariage COMFONENT | VIEWS | COMPILE |N°”'”a' h | O
G - B - 0@ Fast Restart
v v v _
MAMNAGE DESIGN PROFILES SIMULATE F Y
= ex_modeling_component_reuse_arch
% ® Ex_modeling_cnmponem_reuse_arm 4 -
o
= ~
g i@ ex_modeling_component_reuse_arch
. Architeciure extracied from Simulink model: “ex_modeling_companent_reuss tempExporiWaridlow’. [22-May-2019 11:17:39]
= bl Mechanical System
Operator ey
Mass-Sprmg-Damper, La
B sensor poal I+ B goal
E =s=miral [+ > oo
B+ sensor
sensor [+
Environment Mass-Sprisg-Damper, Rij
disturbancea [+ > dix
[T
i v
» ¢ 3
Ready 60% VariableStepAuto

Each subsystem in the Simulink model corresponds to a component in the architecture model so that
the hierarchy in the architecture model reflects the hierarchy of the behavior model.

The requirements for subsystems and Model blocks in the Simulink model are preserved in the
architecture model.

Any Model block in the Simulink model that references another model corresponds to a component
that links to that same referenced model.
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= - < Controller 'D'a|
&x_medeling_cantroller < ex_maodaling_conironer &
E=—_ gual
[= goal
contral
control =
F=p{sensar
[* sensor
7
L 2z

Confraller

Buses at subsystem and Model block ports, as well as their dictionary links are preserved in the
architecture model.

You can use the exported model to add architecture-related information such as interface definitions,
nonfunctional properties for model elements and analyze the design.

See Also
extractArchitectureFromSimulink

More About

. “Extract Architecture of Simulink Model Using System Composer” on page 5-10
. “Describe Component Behavior Using Simulink” on page 5-2

. “Describe Component Behavior Using Stateflow Charts” on page 5-16

. “Describe Component Behavior Using Simscape” on page 5-54

. “Describe System Behavior Using Sequence Diagrams” on page 5-25

. “Decompose and Reuse Components” on page 1-16

. “Compose Architecture Visually” on page 1-2
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Describe System Behavior Using Sequence Diagrams

A sequence diagram is a behavior diagram that represents the interaction between structural
elements of an architecture as a sequence of message exchanges. You can use sequence diagrams to
describe how the parts of a static system interact.

You can use sequence diagrams in System Composer by accessing the Architecture Views Gallery.
Sequence diagrams are integrated with architecture models. For more information on how to create
and use sequence diagrams with an architectural model, see “Use Sequence Diagrams with
Architecture Models” on page 5-41.

In this example, you will learn about the basic terminology and functions of a sequence diagram in
two stages.

* Add lifelines and messages with message labels including triggers and constraints to represent
interactions.

* Include fragments and operands with constraints to further specify the behavior of the interaction.

A lifeline in a sequence diagram represents a component in the architecture. A message represents a
communication across a path between the source lifeline and destination lifeline. The path for a
message must consist of at least two ports and one connector from the architecture model. With
nested messages, the path is more complex due to the hierarchy to be navigated.

This figure shows a traffic light architecture model and a corresponding sequence diagram that
describes one operative scenario. The traffic light model describes a cycling traffic light, the
pedestrian crossing button being pressed, and the lights changing so pedestrians can cross.

Note The traffic light example uses blocks from Stateflow. If you do not have a Stateflow license, you
can open and simulate the model, but you can only make basic changes, such as modifying block
parameters.
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Open the Model

This example shows a traffic light example that contains sequence diagrams to describe pedestrians
crossing an intersection. Use this example to construct your own sequence diagrams.

Add Lifelines and Messages

5-26

Open the Architecture Views Gallery by navigating to Modeling > Architecture Views.
To create a new sequence diagram, click New > Sequence Diagram.

A new sequence diagram called SequenceDiagraml is created in the View Browser, and the
Sequence Diagram tab becomes active. Under Element Properties, rename the sequence
diagram Inhibit.
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4 Select Component > Add Lifeline to add a lifeline. A new lifeline with no name is created and
is indicated by a dotted line.

SEQUENCE DIAGRAM (S 7

== nm @

Add Delete Adc L Check
Lifeline = Operand - Consistency
COMPOMNENT FRAGMENT | MAVIGATE SYMNCHROMIZE ry
View Browser Inhibit Sequence Diagram Properties
B0 Views Name Value
4 [F7] Sequence Diagrams | - ‘ 4 Main
1
1
1
1
1
1
1
1
1
Model Components X
1
14 1 kl

5 Click the down arrow and select source. The source lifeline detects when the pedestrian
presses the crossing button. Add four more lifelines using the down arrow named poller,
switch, controller, and lampController. The poller lifeline checks if the pedestrian
crossing button has been pressed, switch processes the signal, controller determines which
color the pedestrian lamp and traffic light should display, and lampController changes the
traffic light colors.

Inhibit

3

switch L] ‘ lampController ?D

source -p?l‘ ‘ poller 0 ‘ controller '?5

6 Draw a line from the source lifeline to the poller lifeline. Start to type sw in the To box, which
will automatically fill in as you type. Once the text has filled in, select sw.
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Inhibit

source p-ﬁ] l poller o

switchout

Since the switchout port and sw port are connected in the model, a message is created from
the switchout port to the sw port in the sequence diagram.

A message label has a trigger and a constraint. A trigger determines whether the message
occurs, and a constraint determines whether the message is valid. For signal messages, the
trigger is called an edge.

You can enter a condition that specifies a triggering edge with a direction and an expression. You
can also optionally add a constraint in square brackets to the message. Constraints consist of a
MATLAB Boolean expression acting on the inputs of the destination lifeline.

direction(signalPort(+]|-)positiveReal) [booleanExpression]
There are three directions for edges:

* crossing — The edge expression is either rising or falling past zero.

* rising — The edge expression is rising from strictly below zero to a value equal to or greater
than zero.

+ falling — The edge expression is falling from strictly below zero to a value equal to or less
than zero.

Click on the message and double-click on the empty message label that appears. Enter this
condition and constraint.

rising(sw-1) [sw==1]

The message will be triggered when the sw signal rises from below 1 to a value of 1 or above.
The constraint in square brackets indicates that if sw is not equal to 1, the message is invalid.

Note Only destination elements are supported for message labels. In this example, switchout
is a source element and cannot be included.




Describe System Behavior Using Sequence Diagrams

Inhibit

source #&] [ poller )

nsing(sw-1)[sw==1]

switchout

’ESW

The signal name sw is valid input data on the port for a Stateflow chart behavior. The poller
component with state chart behavior has sw in the Symbols pane.

® |1

a0 @8e

| ¢ B & @ 0O ¢

[=]
[

4 poller = | Symbols
le » 55 poll vl == =
% Detection n TYPE NAME VALUE  PORT
after(0.1, sec) after(0.3, sec) [sw > 0] & 1
= switchEvent 1
/Debounce ‘ \
1
[sw > 0]
[sw < 0]
- J
[sw < 0] after(0.1, sec)
v

Note The signal name can also be a data element on a data interface on a port. Enter Tab to
autocomplete the port and data element names. For more information, see “Represent System
Interaction Using Sequence Diagrams”.

In this example, when the sw signal becomes 1, the pedestrian crossing button has been pressed,
and a message to the poller lifeline is recognized.
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8 In addition to signal events, sequence diagrams also support message events. Create a message
by drawing a line from the poller lifeline to the switch lifeline. Start typing switchEvent in

the To box until switchEvent is available to select.

Inhibit

source

switch ‘t:’_é,

& poller ?é,l

‘ controller

~0

rising(sw-1)[sw==1]

switchout

Sw

e R —

SWi

| switchEvent .
by

I NS E——
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Since there is an existing connection in the architecture model, a message is created from source
port switchEvent.

9 Click the message and double-click the empty message label that appears. Enter this condition

representing the port and constraint.

switchEvent[switchEvent==1]




Describe System Behavior Using Sequence Diagrams

Inhibit
source J’hl [ poller ?::‘, | switch EE;

| | I
1 | I
[ 1 [
| i I
| | (] i
[ | I
[ 1 [
1 rising(sw-1)[sw==1] 1 I

switchout : ’:sw :
1 [} [
I switchEvent[switchEvent==1]
: switchEvent | P: switchEvent
[
[

When the message switchEvent is received and its value is 1, the message has occurred and is
valid.

Add Fragments and Operands

You can use fragments to describe more complex sequences such as alternatives. Fragments have one
or more operands depending on the kind of fragment. Operands can contain messages and additional
fragments. You can express the precondition of an operand as a MATLAB Boolean expression using
the inputs of any lifeline.

To access the menu of fragments:

1 (Click and drag to select two messages.
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Inhibit

switch ?&,

source ’a} ‘ poller ?&,

‘ controller ?E‘,

‘ lampController ?é,

nsing(sw-1)[sw==1]

N b
switchout Plsw

]
switchEvent[switchEveni==1]

switchEvent | V; switchEvent
1 1
I 1 pedRequest
: switchPush | P, pedRequest
1 1 1
I 1 switchPed[switchPed==1]
: lampColor
1
1
|
1
1

PN . [ —

switchPed

2 Pause on the ellipsis (...) that appears to access the action bar.

Inhibit

source ’ﬁl ‘ poller ?é

switch ‘g&, ‘ controller ?é)

‘ lampGontroller ?é,

nsing(sw-1)[sw==1]

. A
switchout 7 sw

switchEvent[switchEvent==1]

e e Y e e ——————————— -

switchEvent | '; switchEvent
] 1
I 1 pedRequest
: switchPush | ?\ pedRequest
1 1 1
1 1 switchPed[switchPed==1]
: lampColor ¥ .
I
]
I
1

switchPed

©
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3  Alist of composite fragments appears:

+ Alt Fragment

* Opt Fragment

* Loop Fragment

* Seq Fragment

* Strict Fragment
* Par Fragment

Select Alt Fragment.




Describe System Behavior Using Sequence Diagrams

switch ?&,’ ‘ controller ?&,‘ | lampController ?&,

I 1 I
I I I
I I I
I I 1
| 1 ]
I I I
I I I
I I I
I I I
I I I
1 | 1
rwitchEvent==1] | I
_': switchEvent : |
I I I
I pedRequest | I
switchPush | ": pedRequest :
I ' I
I switchPed[switchPed==1] I

IampColori 1 ’:switchped

1 I I L1l =1l
I I I
| 1 |

4 The Alt Fragment fragment is added to the sequence diagram with a single operand that
contains the selected messages.

[ Tinnioi

source ’i‘ ‘ poller ?‘3’ | switch ?&l ‘ controller ?‘5‘ | lampController ?a

rising(sw-1)[sw==1]

switchout SW

. S

]
switchEvent[switchEvent==1]

switchEvent F ;; switchEvent

Alt |1
1

e e e T

pedRequest Al

FipedRequest
1

switchPed[switchPed==1]
1

switchPush

lamp{Color switchPed

P . AR [ Sy —
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Select the fragment to enter an operand condition. Choose a fully qualified name for input data

and use a constraint condition relation.
switch/inhibit==0

The constraint is a precondition that determines when the operand is active. This constraint
specifies that the inhibit flag is set to 0. Thus, pedestrian crossing is allowed at this
intersection using a pedestrian lamp.

Inhibit

source *ﬁ‘ ‘ poller ?é, switch L]

(=]
‘ controller 2 ‘ lampController

to

Qo
L]

rising(sw-1)[sw==1]

B b
switchout Pl sw

switchEvent[switchEvent==1]
switchEvent | P switchEvent

Alt

1
1
1
I
1
i
1
1
1
1
1
1
1
1
1
|
1
1
[ switch/inhibit==0 ] :

1
[

1

1

1

1

I

1

: | pedRequest Al
[ switchPush FipedRequest
1

1

1

1

1

1

[

1

1

1

switchPed[switchPed==1]
] L4

i i iy R

lampColor switc

hPed
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The messages inside an operand can only be executed if the constraint condition is true.

Highlight the first operand under the Alt Fragment fragment and select Fragment > Add
Operand > Insert After. A second operand is added.

Add a constraint condition relation to the second operand. The second operand in an Alt
Fragment fragment represents an elseif condition for which the message will be executed.

switch/inhibit==

This condition represents when the inhibit flag is set to 1. Thus, pedestrian crossing is not
controlled by a walk signal on that intersection.

Create a message with a message label inside the second operand.




Describe System Behavior Using Sequence Diagrams

Inhibit
source %ﬁ‘ ‘ poller ?&, switch Eg ‘ controller 'E'é, ‘ lampController ?é,
| [ 1 1 1
] [ 1 1 1
| [ 1 1 1
| ] | 1 1
] | 1 I ]
I [ 1 1 1
| I 1 1 1
1 rising(sw-1)[sw==1] | 1 I 1
switchout Msw ! ! !
| I 1 1 1
] ) ! 1 1
I switchEvent[switchEvent==1] I 1
: switchEvent | P\ switchEvent : :
| I 1 1 1
| I 1 1 1
1 1 T i T
| I Alt 1 1
| [ L 1 1 1
: : [ switch/inhibit==0 ] : :
: : : pedRequest L: :
| [ switchPush | FipedRequest 1
| [ 1 1 1
| : : switchPed[switchPed==1] L:
I I lampiColor i I Vi switchPed
| I 1 1 1
] [ 1 1 1
| I | 1 1 1
: : [ switch/inhibit==1 ] : :
| : | switchPed[switchPed==2] K
| [ lampjColor 1 Pi switchPed
| I 1
| [ 1
| I 1
| [ T
I [ 1
| I 1
1 1 1

For the first alternative operand, since the inhibit flag is set to 0, the first message to the
controller lifeline is recognized when the pedRequest message is activated. Then, when the
switchPed message value is 1, the LampController lifeline will make the pedestrian lamp
turn green.

For the second alternative operand, since the inhibit flag is set to 1, the switch bypasses the
controller, and the message switchPed with a value of 2 goes directly to the
lampcontroller. The switchPed message value of 2 does not affect the traffic signal.

Traffic Light Example for Sequence Diagrams

This traffic light example contains sequence diagrams to describe pedestrians crossing an
intersection. The model describes these steps:

1 The traffic signal cycles from red to yellow to green.

2 When the pedestrian crossing button is pressed, if the traffic signal is green, the traffic signal
transitions from yellow to red for a limited time.

3 The pedestrians cross while the walk signal is active.

Open the System Composer model that contains the sequence diagrams.

model = systemcomposer.openModel('TLExample');
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Open the Architecture Views Gallery to view the sequence diagrams.
openViews (model)
The sequence diagrams in this example represent operative scenarios in the architecture model.

1. PressDetection sequence diagram: The pedestrian presses the pedestrian crossing button and
the signal sw rises to 1. The poller lifeline is activated, and a switchEvent message occurs on the
switch lifeline to change the traffic signals to allow the pedestrian to cross.

PressDetection

source %ﬁ‘ [ poller '{g switch ‘Eé

| [ : I
| [ [
| [ [
| | I
1 | |
! [ 1
| o | I
I rising(sw-1) I [

switchout ’: SW :
| [ . 1
I I switchEvent [
: switchEvent | ’:switchEve nt
| | I
| [ I
| [ [

2. SignalSequence sequence diagram: The pedestrian presses the pedestrian crossing button, and
the signal sw rises to 1. After some intermediary events, the LampController lifeline transmits a
trigger signal to the ped lamp lifeline to change pedestrian lamp traffic colors from RED (stop) to
GREEN (go), allowing pedestrians to cross.
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SignalSequence

=)

source ’}ﬁ‘ ‘ poller L oY T

lampController T4

‘ ped lamp 4

rising(sw-1)

switchout SW

crossing(trigger)[colour==trafficColors. RED]
pSwitch | ¥, ingger

1 (]

crossing(trigger)[colour==trafficColors. GREEN]
pSwitch | ¥ trigger

QR (S E—

3. PedestrianCross sequence diagram: First, the traffic value is 3, which indicates that the
traffic light color is green. The traffic light loops from yellow (2) to red (1) to green (3) and again.
When the pedestrian crossing button is pressed and the controller lifeline recognizes a valid
pedRequest message, the traffic lamp changes from yellow (2) to red (1), which allows the
pedestrians to cross. Then, the main loop continues.
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| | FedestrianCross
switch ?&] | controller ?3‘ [ lampController ?&,
I [ I
1 ] 1
| | |
I 1 I
1 ] 1
I 1 I
- 1 I .
Loop [ |
| | [ |
1 1 1
I 1 I
: : traffic[traffic==3] '
. trafficColor | Y traffic
I 1 1
I [ I
[ p 1 L \
I I
- Loop -
I T T A
1 ] 1
1 1 1
I 1 trafﬂc[trafﬁC::E] 1
: traffigColor : }: traffig
1 ] 1
) I trafiic[traffic==1] [
: traffigColor : ): traffig
I 1 I
[ 1 traffic[traffic==3] [
: traffigColor . }: traffig
1 1 I
I [ I
1 T T g
I 1 I
1 ] 1
I 1 I
T T )
B : |
1 1 1
I 1 I
: pedRequest ! :
swittHPush | P pedRequest .
1 1 1
: : traffic[traffic==2] !
. trafficColor | P, traffic
1 ] 1
: ' tafiicfrafic==1] !
I trafficColor ”, traffid
I 1 I
1 ] 1
h, ! ] [l '
1 ] 1
1 1 1
I [ I
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Describe System Behavior Using Sequence Diagrams

4. Inhibit sequence diagram: The inhibit flag determines whether a pedestrian crossing button is
set up for pedestrians to press to control the traffic lamp signal on an intersection and cross. When

inhibit is set to 0, the crossing button exists. When inhibit is set to 1, the crossing button does

not exist. The switchEvent value is 1, which indicates that the pedestrians would like to cross. Once
the switchEvent value is set to 1, if inhibit is 0, the controller lifeline recognizes the
pedRequest message to initiate a change in the pedestrian lamp color. Additionally, the switchPed
value is 1, so the traffic lamp will change from yellow to red. Otherwise, if inhibit is 1, the
switchPed value is 2, so the traffic lamp will continue normal operation and not change to red to
specifically allow the pedestrians to cross.

Inhibit

poller ?é, ‘ switch ?&, ‘ lampController %E,‘ ‘ controller ?,},

[ I I I
1 I 1 |
[ I I I
1 | 1 1
] 1 I 1
1 1 I |
! ' [ |
switchEvent[switchEvent==1] I 1
switchEvent " switchEvent : :
1 I |
| 1 1
r 1 1 ]
Alt 1 I I
— ! | 1
[ switch/inhibit==0 ] | |
I 1 1
: pedRequest '

switchPush I ’: pedRequest

lamp{Color

lamp{Color

;switchPed[switchPed:ﬂ]l'

[ switch/inhibit==1]

¥, switchPed
[

I'switchPed[switchPed==2]"

1 switchPed

(R S ——

Simulate Architecture Model

You can execute the model after setting these variables.
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5-40

createWorkSpaceVar("SwitchInputs",[0 11 18],[-1 1 -1]);
createWorkSpaceVar("inhibitFlag",1,0);

See Also

More About

“Use Sequence Diagrams with Architecture Models” on page 5-41
“Compose Architecture Visually” on page 1-2

“Describe Component Behavior Using Simulink” on page 5-2
“Describe Component Behavior Using Stateflow Charts” on page 5-16
“Describe Component Behavior Using Simscape” on page 5-54
“Define Port Interfaces Between Components” on page 3-2



Use Sequence Diagrams with Architecture Models

Use Sequence Diagrams with Architecture Models

You can author sequence diagrams to describe expected system behavior as a sequence of
interactions between components of a System Composer architecture model. Lifelines correspond to
components in an architecture model, and messages correspond to the connectors between the
components. You can create multiple sequence diagrams to represent different operational scenarios
of the system. Sequence diagrams are integrated into the Architecture Views Gallery in System
Composer.

For sequence diagram definitions, see “Describe System Behavior Using Sequence Diagrams” on
page 5-25.

This traffic light example will show you how to:

* Create a sequence diagram.

* Add child lifelines in a sequence diagram.

* Interact with root architecture ports in a sequence diagram using gates.

* Co-create components and keep the architecture model and the sequence diagram in sync.
* Create messages in a sequence diagram.

* Use the model browser to add components.

Note The traffic light example uses blocks from Stateflow. If you do not have a Stateflow license, you
can open and simulate the model, but you can only make basic changes, such as modifying block
parameters.

Open the Model

This example shows a traffic light example that contains sequence diagrams to describe pedestrians
crossing an intersection. Use this example to construct your own sequence diagrams.

Create a Sequence Diagram

Use an architecture model in System Composer to represent a traffic light example.
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Tmf‘ﬁcL\ ght ¥

TrafficLight
pSwitchfi{ >
Controller lampSubsystem
I 1 | pColor s b
InputSubsystem pedColor > > trafficPed pSwitch b —@pSwitch
I 1 BinValue 7
L_on P =3 == pedColor - —4lpColor
trafficColor p» b traffic
Inhibit On B> N trafficColor - —¢@tColor
B> Inhibit On e > Swich 1) @iSwich tColor i >
tSwitch i b
&
1 Navigate to Modeling > Architecture Views to open the Architecture Views Gallery.
2 To create a new sequence diagram, click New > Sequence Diagram.
3 In Element Properties on the right, enter the name PedLoop.
4 Select Component > Add Lifeline from the menu. A box with a vertical dotted line appears on

the canvas. This is the new lifeline.

5 Click the down arrow on the lifeline to view available options. Select the component named
lampSubsystem to be represented by the lifeline.

== @

Add Delete Adao | Check
Lifeline - Operand - Consistency

COMPOMNENT FRAGMENT | MAVIGATE SYMCHROMIZE

View Browser PedLoop

4 50 Views
v ] View 1 W - '
4 [F]] Sequence Diagrams Controller

[f| PedLoop InputSubsystem
lamp3ubsystem

i

1
Model Components i
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Add Child Lifelines to Sequence Diagram

You can add child lifelines to a sequence diagram to represent model hierarchy and describe the
interactions between lifelines.

1  From the menu, select Component > Add Lifeline. From the list that appears, select the
Controller component.

PedLoop

lampSubsystem v “

Controller

InputSubsystem

ampSuhbsystem

2 Child components called Llampcontroller and controller are located inside the
lampSubsystem and Controller components, respectively.
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TrafficLight # D lampSubsystem P

lampSubsystem

> @trafficPed

trafficPed [
D> traffic
trafficjp

switchPed p

> gswitchPed

@
lampcontroller
pSwitch [>
P> trafficPed
Cl pedpolor g
> traffic

> switchPed

trafficColor >

tSwitch >

4 pSwitch
@ pedColor
@trafficColor

4tSwitch

pSwitch [ >

pedColorp{ >

trafficColorp 1>

tSwitch[p{ >

3  Select the LlampSubsystem lifeline. Navigate to Component > Add Lifeline > Add Child
Lifeline. Select Llampcontroller. The lampcontroller child lifeline is now situated below
lampSubsystem in the hierarchy.

4 Repeat these steps for the Controller lifeline to add the controller child lifeline.
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PedLoop
lampSubsystem Controller
1
lampcontroller ?&, -
controller L'\\,s
switch

Create Sequence Diagram Gates

1  Select the Lampcontroller lifeline, then click and drag it to the gutter region. Start typing
tSwitch into the To box and select tSwitch from the list. See that a gate called tSwitch has
been created with a message from the lampcontroller lifeline at the port tSwitch.

PedLoop

lampSubsystem ‘ ‘ Controller ‘

Oy

lampcontroller T & T

confroller o

tSwitch
tSwit¢h

- e e e e e e e s e e e
- S e s e e

- o e o e e e e

]
i
|
I
|
|
|
|
|
|
|
|
|

2 Return to the architecture diagram. Observe that tSwitch is a root architecture port connected
to the Llampcontroller component in the hierarchy through the LlampSubsystem component.
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pSwitch - b
lampSubsystem
B+ trafficPed pSwitch [ —4fpSwitch pColor b
pedColor [ —4pColor
B traffic
trafficColor [ —+4ftColor tColor &
> switchPed

tSwitch b —@tSwitch

tSwitch i+ =

Co-Create Components

The co-creation workflow between the sequence diagram and the architecture model keeps the model
synchronized as you make changes to the sequence diagram. Adding both lifelines and messages in a
sequence diagram results in updates to the architecture model. This example shows component co-
creation.

1  From the toolstrip menu, select Component > Add Lifeline. Another box with a vertical dotted
line appears on the canvas to represent a lifeline. In the box, enter the name of a new component
named Machine.

PedLoop

lampSubsystem ‘ ‘ Controller ‘ ‘ Machine

=]

(=LY 3
lampcontroller T controller 3

tSwitch
tSwit¢h

2 Observe that the Machine component is co-created in the architecture diagram.
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[ TrafficLight ¥ -
TrafficLight
pSwitch{ >
Controller lampSubsystem Machine
pColor >
InputSubsystem pedCalor > b trafficPed pSwitch I> | —4llpSwitch
e | B invage 0T
L on b e R pedColor [> —4@pColor
trafficCalor > b traffic
Inhibit On B trafficColor > —4fjtColor
B Inhibit On tColor [ >
lampColor B B switchPed

tSwitch [> —4tSwitch

tSwitch >

Synchronize Between the Sequence Diagram and the Model

1 Remove the Machine component from the architecture diagram.

2  Return to the sequence diagram and select Synchronize > Check Consistency. See that the
Machine lifeline is highlighted, as it does not correspond to a component.

PedLoop

lampSubsystem ‘ ‘ Controller ‘ ‘ Machine

=

3 controller e

(=]
lampcontroller T

tSwitch
tSwit¢h

3 To restore consistency, either remove the Machine lifeline or click Undo in the architecture
model to restore the Machine component.

4 Click Check Consistency again.

Create Messages in the Sequence Diagram

You can create a message from an existing connection.

1 Draw a line from the controller lifeline to the Lampcontroller lifeline. Start to type
traffic in the To box, which will automatically fill in as you type. Once the text has filled in,
select traffic.
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FedLoop

lampSubsystem

Controller ’

‘ lampcontroller

(=]
]

controller ?&I

tSwit¢ch

t

trafiicPed

traffic
o CO—
1

2

Since the trafficColor port and traffic port are connected in the model, a message is
created from the traffic port to the trafficColor port in the sequence diagram.

PedLoop

tSwitch

lampSubsystem ’ ‘ Controller ’
I [
I 1
: lampcontroller ?& : controller ?é
I I 1 1
I I 1 1
I I 1 1
T T ] ]
I I 1 1
I I 1 1
I I I I
: traffic N : :trafficCoIor
1 1 1
1 1 1
k t tSwitch 1 1
I 1 1
I 1 1
I I I
I I I
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Modify Sequence Diagram Using Model Browser

1

The Views Gallery model browser located on the bottom left of the canvas is called Model
Components. Click and drag the switch child component into the sequence diagram.
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¥ View Browser o PedLoop
» B8 Views -
4 [H] Sequence Diagrams
5] PedLoop lampSubsystem Controller
H H
: lampcontroller T : controller R
1 1
H ' H '
1 L 1 1
Model Components H : H :
4 [ TrafficLight - H H H : switch
4™ : H : :
- 1 1 1 1
@ i = E E
2 switch ! traffic ! T 1 trafficColor
4 ™ InputSubsystem ! H H i
F) inhibit ! ! ! !
2 poller , i 1 tSwitch i i
[% source tSwitgh H H i i
2 The sequence diagram is updated with a new lifeline.
PedLoop
lampSubsystem ‘ ‘ Controller ’
1 1
1 1
1 lampcontroller [::_'e, 1 controller ?&, ‘ switch ?é
1 1
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
L | T L | LI L
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
1 traffic T 1trafficColor !
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
T 1tSwitch ! 1 !
tSwitgh ! ! ! ! !
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
3  Click and drag to reorder the lampSubsystem and the Controller lifelines.
PedLoop
Controller ’ ‘ lampSubsystem ’
controller ?&, ‘ switch ?é lampcontroller ?&,

Traffic Light Example with Hierarchy for Sequence Diagrams

This traffic light example contains sequence diagrams to describe pedestrians crossing an
intersection. The model describes these steps:

1  The traffic signal cycles from red to yellow to green.
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2 When the pedestrian crossing button is pressed, if the traffic signal is green, the traffic signal
transitions from yellow to red for a limited time.

3 The pedestrians cross while the walk signal is active.

Open the System Composer model that contains the sequence diagrams.

model = systemcomposer.openModel('TrafficLight');

Open the Architecture Views Gallery to view the sequence diagrams.

openViews (model)

The sequence diagrams in this example represent operative scenarios in the architecture model.

1. InputPollNested sequence diagram: When the poller recognizes a signal event as inValue
rises to 1, the pedestrian crossing button is pressed. Next, the switch lifeline recognizes a signal
event to Lampcontroller as switchPed rises to 1, which activates the pedestrian crossing signal.

InputPollNested

InputSubsystem ‘ ’ Controller ‘ ’ lampSubsystem \

[

lampcontroller T

poller L] switch L]

rising(inValue-1)

. SN P

L_on inValue

nising({switchPed-1)

lampColor switchPed

. T ——

2. PedLoop sequence diagram: The traffic lamp changes trafficColor from green (3) to yellow (2)
to red (1). After each traffic color change, the tSwitch value becomes 0, which indicates that the
traffic lamp has been changed. The cycle repeats in a loop for several iterations before the pedestrian
crossing button is pressed.
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PedLoop
lampSubsystem ‘ ‘ Controller ‘
1 1
] ]
| lampcontroller ':3;5 1 controller ?E;
1 1
| | | |
] ] ] ]
1 1 1 1
1 1 1 ]
| | | | | | | ]
1 1 1 1
1 1 1 1
1 1 1 i
] ( L ] ] 3
1 1 1
1 L oop 1 1 J
1 1 1 1
1 1 1 i
: ! rising(traffic-3) :
; traffic .‘ p  traffidColor
1 | | 1
crossing(tSwitch) : : :
i 1 tSwitch 1 1
tSwit¢h 1 1 1 1
: ! falling(traffic-2) :
" traffic :‘ 1  traffidColor
1 1 1 I
crossing(tSwitch) : : :
; 1 tSwitch 1 1
tSwiteh 1 1 1 1
: ! falling(traffic-1) :
I iraffic H 1 ) traffidColor
1 1 1 1
crossing(tSwitch) : : :
i 1 tSwitch 1 1
tSwitch 1 1 1 |
1 1 1 1
] 1 1 ] '
1 1 1 1

Simulate Architecture Model

You can execute the model after setting these variables.

createWorkSpaceVar("SwitchInputs",[0 11 18],[-1 1 -1]);
createWorkSpaceVar("inhibitFlag",1,0);

Create Sequence Diagram from View

1

In the MATLAB Command Window, enter scKeylessEntrySystem. The architecture model
opens in the Simulink Editor.
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2 To open the Architecture Views Gallery for the model, navigate to Modeling > Views >
Architecture Views.

3 Right-click the Sound System Supplier Breakdown view and select New Sequence
Diagram.

View Browser Sound System Supplier Breakdown
4 P Views Views ¢ Sound System Supplier Breakdown
3 . Door Lock System Supplier Breakdown
3 . Key FOB Position Dataflow T
3 . Software Component Review Status )/
3 |:| Sound System Supplier Breakdown

*1 Sequence Diagr| New Sequence Diagram I}
Create a new sequence diagram from contents of view

[ ] Sound System Supplier Breakdown

Sound System

Supplier C

[Eound Controller_doorSistus

-

[Eound Controller keylocalion

.

keyLocation
Sound Controller_engineStatus
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4 A new sequence diagram of lifelines is created with all the components from the view.

SeguenceliagramFromView

Sound System |

Sound Controller | | Dashboard Speaker

See Also

More About

. “Describe System Behavior Using Sequence Diagrams” on page 5-25
. “Compose Architecture Visually” on page 1-2

. “Describe Component Behavior Using Simulink” on page 5-2



Use Sequence Diagrams with Architecture Models

“Describe Component Behavior Using Stateflow Charts” on page 5-16
“Describe Component Behavior Using Simscape” on page 5-54
“Define Port Interfaces Between Components” on page 3-2

5-53



5 Use Simulink Models with System Composer

Describe Component Behavior Using Simscape

DC Motor

5-54

A physical subsystem is a Simulink subsystem with Simscape connections. A physical subsystem with
Simscape connections uses a physical network approach suited for simulating systems with real
physical components and represents a mathematical model.

Using Simscape behaviors for components in System Composer improves model simulation and
design for systems with physical components. This functionality requires a Simscape license. For
more information, see “Basic Principles of Modeling Physical Networks” (Simscape).

To describe component behavior in Simscape for a System Composer architecture model, follow these
steps:

1  “Define Physical Ports on a Component” on page 5-54

2 “Specify Physical Interfaces on the Ports” on page 5-55

3 “Create a Simulink Subsystem Component” on page 5-56

4 “Describe Component Behavior Using Simscape” on page 5-56

Open this model to interact with a System Composer architecture model named Fan with Simscape
behavior on a component DC Motor. The steps in this tutorial will produce this model.

Architecture Model with Simscape Behavior for a DC Motor

This example shows a DC motor in an architecture model of a fan. The DC motor is modeled using a
Simscape behavior within a Simulink subsystem component.

Define Physical Ports on a Component

A physical port represents a Simscape physical modeling connector port called a Connection Port.
Use physical ports to connect components in an architecture model or to enable physical systems in a
Simulink subsystem.



Describe Component Behavior Using Simscape

Create a new System Composer architecture model. Add a component to the canvas called DC
Motor. To add physical ports to a component, pause on the boundary of the component until a port
outline appears. Click the port outline and, from the options, select Physical.

DC Motor

Physical ports can be later used to connect to Simscape blocks.

Specify Physical Interfaces on the Ports
You can specify physical interfaces on the physical ports.

A physical interface defines the kind of information that flows through a physical port. The same
interface can be assigned to multiple ports. A physical interface is a composite interface equivalent to
a Simulink.ConnectionBus object that specifies at least one Simulink.ConnectionElement
object. A physical interface is equivalent to a Simulink.ConnectionBus object that specifies at
least one Simulink.ConnectionElement object. Use a physical interface to bundle physical
elements to describe a physical model using at least one physical domain.

A physical element describes the decomposition of a physical interface. A physical element is
equivalent to a Simulink.ConnectionElement object. Define the Type of a physical element as a
physical domain to enable use of that domain in a physical model.

1 To open the Interface Editor, navigate to Modeling > Design > Interface Editor. The Interface
Editor will open at the bottom of the canvas.

To add a new physical interface definition, click the list next to the =5 icon and select Physical
Interface. Name the physical interface ElectricalInterface.

To add a physical element to the physical interface, click the =% icon. Physical interface and
physical element names must be valid MATLAB variable names. Create the physical elements
Positive and Negative.

4 In the Type column, define the Simscape domain to which these physical elements belong. In this
case, both belong to foundation.electrical.electrical.

Type
~ @ Fanslkx
* {0 Electricalinterface
Positive Connection: foundation_ electrical electrical
Megative Connection: foundation_ electrical electrical

5 Select the E port on the DC Motor component. Right-click the ElectricalInterface physical
interface on the Interface Editor and click Assign to Selected Port(s).
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Create a Simulink Subsystem Component

You can create a Simulink subsystem in System Composer to enable direct Simscape integration. For
more information, see “Create Simulink Behavior Using Simulink Subsystem” on page 5-5.

Select the DC Motor component. Navigate to Modeling > Component > Create Simulink
Behavior, or use the right-click menu on the component.

Create Simulink behavior — Ll X
Create a Simulink behavior and, optionally,
export local interfaces to a new shared data dictionary.

Type Subsystem ~

New file name: DCMotor Browse...

From Simulink template:
Default \

New data dictionary name:

OK Cancel Help

Click OK.

DC Motor ba

O rTe)

Describe Component Behavior Using Simscape

Double-click the subsystem component to describe component behavior using Simscape. For the DC
motor this example is based on, see “Evaluating Performance of a DC Motor” (Simscape).

The physical interface can be decomposed into physical elements using a Simscape bus. Each
physical element represents a conserving connection associated with a domain in Simscape.
Simscape buses bundle conserving connections. For more information, see Simscape Bus (Simscape).

Add a Simscape Bus block next to the E physical port. Double-click the Simscape Bus and select the
connection type Bus: ElectricalInterface. Connect the E physical port to the Simscape Bus
block. The domain foundation.electrical.electrical defined under the Type of the
Positive and Negative physical elements are used for any connections from these ports.
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Positive

R d Negative E

You can also use owned interfaces defined locally on ports to enable domain-specific lines on a
Simscape behavior model in System Composer. Edit the port interface through the Property
Inspector. Navigate to Modeling > Design > Property Inspector. In this case, Simscape Bus blocks
are not needed, and the port can connect directly to the physical connection of the specified domain.
Add an owned physical interface to the physical port R with Type as a
foundation.mechanical.rotational.rotational domain. Selecting edit to Open in
Interface Editor enters the Port Interface View in the Interface Editor. For more information, see
“Define Owned Interfaces Local to Ports” on page 3-10.

Property Inspector L
Port

Architecture Info

* Main
MName R
¥ Imterface

MName <owned> =
Open in Interface Editor edit .
Type foundation.mechanical.rotational rotational =

Using the Library Browser, retrieve the following Simscape blocks and construct the DC Motor model
with electrical and rotational mechanical domain-specific connectors.

A physical connector can represent a nondirectional conserving connection of a specific physical
domain. Connectors can also represent physical signals. Use physical connectors to connect physical
components that represent features of a system to simulate mathematically. For more information,
see “Domain-Specific Line Styles” (Simscape).
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fix)=0 p

Solver
Configuration

Inductor Resistor

Rotational A N "
Electromechanical
Inertia Converter

Positive

© " P>
+ Negative E
Friction —_——_——
S - Simscape Bus

|

Mechanical Electrical Reference
Rotational Reference

Physical modeling uses the network approach and is therefore different from regular Simulink
modeling. For more information, see “Modeling Best Practices” (Simscape) and “Troubleshooting
Simulation Errors” (Simscape).

See Also

createSubsystemBehavior | addPort | addPhysicalInterface | addElement |
setInterface | createInterface

More About
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“Describe System Behavior Using Sequence Diagrams” on page 5-25
“Describe Component Behavior Using Simulink” on page 5-2
“Describe Component Behavior Using Stateflow Charts” on page 5-16
“Define Port Interfaces Between Components” on page 3-2
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» “Allocate Architectures in Tire Pressure Monitoring System” on page 6-5
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Create and Manage Allocations

6-2

This example shows how to create and manage System Composer™ allocations. Use allocations to
establish a directed relationship from architecture elements (components, ports, and connectors) in
one model to architecture elements in another model. One common use case for allocations is to
establish relationships from software components to hardware components to indicate a deployment
strategy.

This example uses the Tire Pressure Monitoring System (TPMS) project. To open the project, use this
command:

scExampleTirePressureMonitorSystem

Create a New Allocation Set

You can create an allocation set using the Allocation Editor. An allocation set is a collection of
allocation relationships between two models: a source model, and a target model. The allocation set
is stored as an .mldatx file.

In this example, TPMS FunctionalArchitecture.slx is the source model and the
TPMS LogicalArchitecture.slx is the target model.

To create an allocation set for these models, use this command.

allocSet = systemcomposer.allocation.createAllocationSet(...

"Functional2Logical', ...% Name of the allocation set
'"TPMS FunctionalArchitecture', ... % Source model
'"TPMS LogicalArchitecture' ... % Target model

);
To see the allocation set, open the Allocation Editor by using the following command.

systemcomposer.allocation.editor;

The Allocation Editor has three parts: the toolstrip, the browser pane, and the allocation matrix.

» Use the toolstrip to create and manage allocation sets. For instance, you can use the New
Allocation Set button to create a new allocation set between two models.

» Use the Allocation Set Browser pane to browse and open existing allocation sets.

* Use the allocation matrix to specify allocations between the source model elements in the first
column and target model elements in the first row. You can create allocations programmatically or
by double-clicking a cell in the matrix.
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ALLOCATIONS

Create and manage

allocation sets - 'y L @l
Mew Open Save SCENARIO  REFRESH ROW FILTER  COLUMN FILTER | FILTERS
Allocation Set  Allocation Set  Allocation Set -
b - - - b -
. FILE .
ALLOCATION SET BRO Scenario 1
4 (@ Functional2Logical £ |7 | @ z _ |z
£ |2 |4 g o (o[58 g 3
& Scenario 1 2 e & g (2552 & |2 2
— . . 2 |8 |3 = | = T e I~
Browse and open 4 gt MyAllocationSat fi 5 5 |% |z E § § = ||
 Scenario 1 215 |B |88 |L (2|2 |8 |8 ¢
. & g |a |@ E |E |E |§ |& |2
allocation sets JIEIEIZEIE 2|28 (2 (5 |E
= I el
'aé__ 0O @ @ @ (=
1] . .
_| I’_l Specify allocations

= using
the matrix representation

~ [ TPMS_Functionalds

S3ILHILOHL O

- : Report Low Tire
T InBus

= QuiBus-->InBus

= OQuiBus-->InBus

—~ QuiBus—->InBus

4 » [™] Measure Tire Pri P

Create Allocations between Two Models

This example shows how to programmatically create allocations between two models in the TPMS
project.

Get handles to the reporting functions in the functional architecture model.
functionalArch = systemcomposer.loadModel('TPMS FunctionalArchitecture');

reportLevels = functionalArch.lookup('Path', 'TPMS FunctionalArchitecture/Report Tire Pressure L
reportLow = functionalArch.lookup('Path', 'TPMS FunctionalArchitecture/Report Low Tire Pressure’

Get the handle to the TPMS reporting system component in the logical architecture model.

logicalArch = systemcomposer.loadModel('TPMS LogicalArchitecture');
reportingSystem = logicalArch.lookup('Path', 'TPMS LogicalArchitecture/TPMS Reporting System');

Create the allocations in the default scenario that is created.

defaultScenario = allocSet.getScenario('Scenario 1");
defaultScenario.allocate(reportLevels, reportingSystem);
defaultScenario.allocate(reportLow, reportingSystem);

Save the allocation set.
allocSet.save;

Optionally, you can delete the allocation between reporting low tire pressure and the reporting
system.

% defaultScenario.deallocate(reportLow, reportingSystem);

See Also

systemcomposer.allocation.AllocationScenario |
systemcomposer.allocation.AllocationSet | editor | getScenario|allocate |
synchronizeChanges
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More About

. “Manage Requirements” on page 2-8

. “Analyze Architecture” on page 6-10

. “Allocate Architectures in Tire Pressure Monitoring System” on page 6-5
. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Allocate Architectures in Tire Pressure Monitoring System

Use allocations to analyze a tire pressure monitoring system.

Overview

In systems engineering, it is common to describe a system at different levels of abstraction. For
example, you can describe a system in terms of its high-level functions. These functions may not have
any behavior associated with them but most likely trace back to some operating requirements the
system must fulfill. We refer to this layer (or architecture) as the functional architecture. In this
example, an automobile tire pressure monitoring system is described in three different architectures:

1  Functional Architecture — Describes the system in terms of its high-level functions. The
connections show dependencies between functions.

2 Logical Architecture — Describes the system in terms of its logical components and how data is
exchanged between them. Additionally, this architecture specifies behaviors for model simulation.

3  Platform Architecture — Describes the physical hardware needed for the system at a high level.
The allocation process is defined as linking these three architectures that fully describe the system.
The linking captures the information about each architectural layer and makes it accessible to the
others.

Use this command to open the project.

scExampleTirePressureMonitorSystem

TPMS

Motion Sensor )

Pressure Sensor V) - ~ S

Temprature Sensor*!)

Open the FunctionalAllocation.mldatx file, which displays allocations from

TPMS FunctionalArchitecture to TPMS LogicalArchitecture. The elements of

TPMS FunctionalArchitecture are displayed in the first column. The elements of

TPMS LogicalArchitecture are displayed in the first row. The arrows indicate the allocations
between model elements.
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The arrows display allocated components in the model. You can observe allocations for each element
in the model hierarchy.

The rest of the example shows how to use this allocation information to further analyze the model.
Functional to Logical Allocation and Coverage Analysis

This section shows how to perform coverage analysis to verify that all functions have been allocated.
This process requires using the allocation information specified between the functional and logical
architectures.

To start the analysis, load the allocation set.

allocSet
scenario

systemcomposer.allocation.load('FunctionalAllocation');
allocSet.Scenarios;

Verify that each function in the system is allocated.

import systemcomposer.query.*;
[~, allFunctions] = allocSet.SourceModel.find(HasStereotype(IsStereotypeDerivedFrom("TPMSProfi
unAllocatedFunctions = [];
for 1 = 1:numel(allFunctions)

if isempty(scenario.getAllocatedTo(allFunctions(i)))

unAllocatedFunctions = [unAllocatedFunctions allFunctions(i)];

end

end

if isempty(unAllocatedFunctions)

fprintf('All functions are allocated');
else

fprintf('sd Functions have not been allocated', numel(unAllocatedFunctions));
end

All functions are allocated
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The result displays ALl functions are allocated to verify that all functions in the system are
allocated.

Analyze Suppliers Providing Functions

This section shows how to identify which functions will be provided by which suppliers using the
specified allocations. Since suppliers will be delivering these components to the system integrator,
the supplier information is stored in the logical model.

suppliers = {'Supplier A', 'Supplier B', 'Supplier C', 'Supplier D'};
functionNames = arrayfun(@(x) x.Name, allFunctions, 'UniformOutput', false);
numFunNames = length(allFunctions);
numSuppliers = length(suppliers);
allocTable = table('Size', [numFunNames, numSuppliers], 'VariableTypes', repmat("double", 1, ni
allocTable.Properties.VariableNames = suppliers;
allocTable.Properties.RowNames = functionNames;
for i = 1l:numFunNames
elem = scenario.getAllocatedTo(allFunctions(i));
for j = 1l:numel(elem)
elemSupplier = elem(j).getEvaluatedPropertyValue("TPMSProfile.LogicalComponent.Supplie
allocTable{i, strcmp(elemSupplier, suppliers)} = 1;
end

end
The table shows which suppliers are responsible for the corresponding functions.

allocTable

allocTable=8x4 table
Supplier A Supplier B Supplier C Supplier D

Calculate if pressure is low
Report Tire Pressure Levels
Calculate Tire Pressure
Report Low Tire Pressure
Measure temprature of tire
Measure rotations

Measure pressure on tire
Measure Tire Pressure

[cNoRDNoNoN DN oNo)
[l NoNoNoNoNoNo)
[cNoNoN SN oNoNoNo)

[cNoNoNON NN i

Analyze Software Deployment Strategies

You can determine if the Engine Control Unit (ECU) has enough capacity to house all the software
components. The software components are allocated to the cores themselves, but the ECU is the
component that has the budget property.

Get the platform architecture.
platformArch = systemcomposer.loadModel('PlatformArchitecture');
Load the allocation.
softwareDeployment = systemcomposer.allocation.load('SoftwareDeployment');

frontECU = platformArch.lookup('Path', 'PlatformArchitecture/Front ECU");
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rearECU = platformArch.lookup('Path', 'PlatformArchitecture/Rear ECU');

scenariol = softwareDeployment.getScenario('Scenario 1');

scenario2 = softwareDeployment.getScenario('Scenario 2');

frontECU_availMemory = frontECU.getEvaluatedPropertyValue("TPMSProfile.ECU.MemoryCapacity");
rearECU_availMemory = rearECU.getEvaluatedPropertyValue("TPMSProfile.ECU.MemoryCapacity");

frontECU _memoryUsedl = getUtilizedMemoryOnECU(frontECU, scenariol);
frontECU_isOverBudgetl = frontECU memoryUsedl > frontECU availMemory;
rearECU_memoryUsedl = getUtilizedMemoryOnECU(rearECU, scenariol);
rearECU_isOverBudgetl = rearECU memoryUsedl > rearECU availMemory;

frontECU _memoryUsed2 = getUtilizedMemoryOnECU(frontECU, scenario2?);
frontECU_isOverBudget2 = frontECU memoryUsed2 > frontECU availMemory;
rearECU_memoryUsed2 = getUtilizedMemoryOnECU(rearECU, scenario2);
rearECU_isOverBudget2 = rearECU memoryUsed2 > rearECU availMemory;

Build a table to showcase the results.

softwareDeploymentTable = table([frontECU memoryUsedl; frontECU availMemory; ...
frontECU isOverBudgetl;rearECU memoryUsedl; rearECU availMemory;rearECU isOverBudgetl],
[frontECU memoryUsed2; frontECU availMemory; frontECU isOverBudget2;rearECU memoryUsed2;
rearECU _availMemory; rearECU isOverBudget2],
'VariableNames',{'Scenario 1', 'Scenario 2'},...
'RowNames', {'Front ECUMemory Used (MB)', 'Front ECU Memory (MB)', 'Front ECU Overloaded',
'Rear ECU Memory Used (MB)', 'Rear ECU Memory (MB)', 'Rear ECU Overloaded'})

softwareDeploymentTable=6x2 table

Scenario 1 Scenario 2
Front ECUMemory Used (MB) 110 90
Front ECU Memory (MB) 100 100
Front ECU Overloaded 1 0
Rear ECU Memory Used (MB) 0 20
Rear ECU Memory (MB) 100 100
Rear ECU Overloaded 0 0

function memoryUsed = getUtilizedMemoryOnECU(ecu, scenario)

For each component in the ECU, accumulate the binary size required for each allocated software
component.

coreNames = {'Corel', 'Core2','Core3', " 'Cored'};
memoryUsed = 0;
for i = l:numel(coreNames)
core = ecu.Model.lookup('Path', [ecu.getQualifiedName '/' coreNames{i}]);
allocatedSWComps = scenario.getAllocatedFrom(core);
for j = 1l:numel(allocatedSWComps)
binarySize = allocatedSWComps(j).getEvaluatedPropertyValue("TPMSProfile.SWComponent.Bi
memoryUsed = memoryUsed + binarySize;
end
end
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end

See Also

getAllocatedTo | load | getScenario | getAllocatedFrom | synchronizeChanges |

getEvaluatedPropertyValue | systemcomposer.loadModel | find | getQualifiedName |
lookup

More About

. “Create and Manage Allocations” on page 6-2

. “Analyze Architecture” on page 6-10

. “Organize System Composer Files in a Project” on page 1-37

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Analyze Architecture

Perform static analysis on a System Composer architecture to evaluate characteristics of the system.
Analysis is a method for quantitatively evaluating an architecture for certain characteristics. Static
analysis uses an analysis function and parametric values of properties captured in the system model.
Use analyses to calculate overall reliability, mass roll-up, performance, or thermal characteristics of a
system, or to perform a SWaP analysis.

Write static analyses based on element properties to perform data-driven trade studies and verify
system requirements. Consider an electromechanical system where there is a trade-off between cost
and weight, and lighter components tend to cost more. The decision process involves analyzing the
overall cost and weight of the system based on the properties of its elements, and iterating on the
properties to arrive at a solution that is acceptable both from the cost and weight perspective.

The analysis workflow consists of these steps:
1 Define a profile containing a set of stereotypes that describe some analyzable properties (for

example, cost and weight).

2 Apply the profile to an architecture model and add stereotypes from that profile to elements of
the model (components, ports, or connectors).

3 Specify values for the properties on those elements.

Create an instance of the architecture model, which is a tree of elements, corresponding to the
model hierarchy with all shared architectures expanded and a variant configuration applied.

5 Write an analysis function to compute values necessary for the study. This is a static constraint
solver for parametrics and values of related properties captured in the system model.

6 Run the analysis function and then see analysis calculations and results in the Analysis Viewer.
Set Properties for Analysis

This example shows how to enable analysis by adding stereotypes to model elements and setting
property values. The model provides the basis to analyze the trade-off between total cost and weight
of the components in a simple architecture model of a robot system.

Open the Model

Open the systemWithProps architecture model.
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E systemWithProps P -

systemWithProps

Computer 93 Robot 0%.

OutBus1
CnitBu

PowerSource )

dag?

Import a Profile

Enable analysis of properties by first importing a profile. In the toolstrip, navigate to Modeling >
Profiles > Import and browse to the profile to import it.

Apply Stereotypes to Model Elements

Apply stereotypes to all model elements that are part of the analysis. Use the menu items that apply
stereotypes to all elements of a certain type. Select Apply Stereotypes > Apply to and then
Components > This layer. Make sure you apply the stereotype to the top-level component, if a
cumulative value is to be computed.

Set Property Values

Set property values for each model element in the Property Inspector. To open the Property Inspector,
navigate to Modeling > Design > Property Inspector.

1 Select the model element.
2 In the Property Inspector, expand the stereotype name and type values for properties.

6-11



6 Analyze Architecture Model

Robot

L

-- P InBus

v
|
|
|
|
[
1

QOutBus

Property Inspector

Component

Architecturs Infi

* Main
Mame
Stereotype
* PhysicalComponent
volume
weight
unitCost

Robot

Add.

Select

0'm3

20 kg

3000 dollars

6-12

Create a Model Instance for Analysis

Create an instance of the architecture model that you can use for analysis. An instance is an
occurrence of an architecture model element at a given point in time. An instance freezes the active
variant or model reference of the component in the instance model.

An instance model is a collection of instances. You can update an instance model with changes to a
model, but the instance model will not update with changes in active variants or model references.
You can use an instance model, saved in an .MAT file, of a System Composer architecture model for

analysis.

Navigate to Modeling > Views > Analysis Model to open the Instantiate Architecture Model dialog.

Specify all the parameters required to create and view an analysis model.




Analyze Architecture

Instantiate Architecture Model x
Description
Create an instance model from this architecture mode! by flattening out all referenced models and their components. Such an [
instance model may be used for system-level analysis expressed as MATLAB functions. N
Step 1: Select Stereotypes Step 2: Configure Analysis
Function
Select the stereotypes to make available on
the instance model Analysis function:
|systemWithProps_1 |13 |4 @
v [m] SystemProfile Function arguments (comma-separated):
Budgets | |
PhysicalComponent
. »> systemWithProps_1(instance
[ PhysicalConnector y ps_1( )
PhysicalElement Model Tteration
SoftwareComponent
Iteration Order: | Bottom-up ~
Instance Model Properties
Name: |systemiithProps
L] Mormalize Units
Strict Mode
Don't see your profile? |Profile Editor ... 2‘3 Cancel [) iretantiate

The Select Stereotypes tree lists the stereotypes of all profiles that have been loaded in the current
session and allows you to select those whose properties should be available in the instance model.
You can browse for an analysis function, create a new one, or skip analysis at this point. If the
analysis function requires inputs other than elements in the model (such as an exchange rate to
compute cost) enter it in Function arguments. Select a mode for iterating through model elements,
for example, Bottom-up to move from the leaves of the tree to the root.

Note Strict Mode ensures instances only get properties if the instance's specification has the
stereotype applied.

To view the instance, click Instantiate and launch the Analysis Viewer. The Analysis Viewer shows all
components in the first column. The other columns are properties for all stereotypes chosen for this
instance. If a property is not part of a stereotype applied to an element, that field is greyed out. You
can use the Filter button to hide properties for certain stereotypes. When you select an element,
Instance Properties shows its stereotypes and property values. You can save an instance in a MAT-file,
and open it again in the Analysis Viewer.
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If you make changes in the model while an instance is open, you can synchronize the instance with
the model. Update pushes the changes from the instance to the model. Refresh updates the instance
from the model. Unsynchronized changes are shown in a different color. Selecting a single element
enables the option to Update Element.

Write Analysis Function

Write a function to analyze the architecture model using instances. An analysis function quantitatively
evaluates an architecture for certain characteristics. An analysis function is a MATLAB function that
computes values necessary to evaluate the architecture using properties of each element in the model
instance. Use an analysis function to calculate the result of an analysis.

You can add an analysis function as you set up the analysis instance model. After you select the

stereotypes of interest, create a template function by clicking + next to the Analysis function
field. The generated M-file includes the code to obtain all property values from all stereotypes that
are subject to analysis. The analysis function operates on a single element — aggregate values are
generated by iterating this function over all elements in the model when you run the analysis from
Analysis Viewer.

function systemWithProps_1l(instance,varargin)

if instance.isComponent()

if instance.hasValue('SystemProfile.PhysicalElement.unitCost")
sysComponent_unitPrice = instance.getValue('SystemProfile.PhysicalElement.unitCost"');

end

for child = instance.Components
comp_price = child.getValue('SystemProfile.PhysicalElement.unitCost');
sysComponent_unitPrice = sysComponent_unitPrice + comp_price;

end

instance.setValue('SystemProfile.PhysicalElement.unitCost',sysComponent_unitPrice);
end

In the generated file, instance is the instance of the element on which the analysis function runs
currently. You can perform these operations for analysis:

» Access a property of the instance:
instance.getValue('<profile>.<stereotype>.<property>")

* Set a property of an instance:
instance.setValue('<profile>.<stereotype>.<property>',value)

* Access the subcomponents of a component: instance.Components
* Access the connectors in component: instance.Connectors
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The getValue function generates an error if the property does not exist. You can use hasValue to
query whether elements in the model have the properties before getting the value.

As an example, this code computes the weight of a component as a sum of the weights of its
subcomponents.
if instance.isComponent()
if instance.hasValue('SystemProfile.PhysicalElement.weight")
weight = instance.getValue('SystemProfile.PhysicalElement.weight');
end
for child = instance.Components
subcomp weight = child.getValue('SystemProfile.PhysicalElement.weight');
weight = weight + subcomp weight;
end
instance.setValue('SystemProfile.PhysicalElement.weight',weight)
end

Once the analysis function is complete, add it to the analysis under the Analysis function box. An
analysis function can take additional input arguments, for example, a conversion constant if the
weights are in different units in different stereotypes. When this code runs for all components
recursively, starting from the deepest components in the hierarchy to the top level, the overall weight
of the system is assigned to the weight property of the top-level component.

Run Analysis Function

Run an analysis function using the Analysis Viewer.

Select or change the analysis function using the Analyze menu.

Select the iteration method.

* Pre-order — Start from the top level, move to a child component, process the
subcomponents of that component recursively before moving to a sibling component.

* Top-Down — Like pre-order, but process all sibling components before moving to their
subcomponents.

* Post-order — Start from components with no subcomponents, process each sibling and
then move to parent.

* Bottom-up — Like post-order, but process all subcomponents at the same depth before
moving to their parents.

The iteration method depends on what kind of analysis is to be run. For example, for an analysis
where the component weight is the sum of the weights of its components, you must make sure
the subcomponent weights are computed first, so the iteration method must be bottom-up.

3  Click the Analyze button.

System Composer runs the analysis function over each model element and computes results. The
computed properties are highlighted yellow in the Analysis Viewer.

&7 Instances Cost Weight volume unitCost weight devCost

4 7 systemWithProps
o Computer
o PowerSource
o Robot

25500
2000
100
3000

a0 o o
P (% 5]
= o on

Here, the total cost of the system is 25500 dollars and the total weight is 55 kag.
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See Also

systemcomposer.analysis.Instance | iterate| instantiate | deleteInstance | update |
refresh | save | loadInstance | lookup | getValue | setValue | hasValue

More About

“Define Profiles and Stereotypes” on page 4-2

“Organize System Composer Files in a Project” on page 1-37

“Simulate Mobile Robot with System Composer Workflow” on page 4-21
“Allocate Architectures in Tire Pressure Monitoring System” on page 6-5
“Battery Sizing and Automotive Electrical System Analysis” on page 6-17



Battery Sizing and Automotive Electrical System Analysis

Battery Sizing and Automotive Electrical System Analysis

Overview

Model a typical automotive electrical system as an architectural model and run a primitive analysis.
The elements in the model can be broadly grouped as either a source or a load. Various properties of
the sources and loads are set as part of the stereotype. This example uses the iterate method of the
specification API to iterate through each element of the model and run analysis using the stereotype
properties.

Structure of Model

The generator charges the battery while the engine is running. The battery and the generator
support the electrical loads in the vehicle, like ECU, radio, and body control. The inductive loads like
motors and other coils have the InRushCurrent stereotype property defined. Based on the
properties set on each component, the following analyses are performed:

+ Total KeyOffLoad.

* Number of days required for KeyOffLoad to discharge 30% of the battery.
» Total CrankingInRush current.

+ Total Cranking current.

» Ability of the battery to start the vehicle at 0°F based on the battery cold cranking amps (CCA).
The discharge time is computed based on Puekert coefficient (k), which describes the relationship
between the rate of discharge and the available capacity of the battery.

Load Model and Run Analysis

archModel = systemcomposer.openModel('scExampleAutomotiveElectricalSystemAnalysis');
% Instantiate battery sizing class used by the analysis function to store

% analysis results.

objcomputeBatterySizing = computeBatterySizing;

% Run the analysis using the iterator.
archModel.iterate('Topdown',@computelLoad,objcomputeBatterySizing);

% Display analysis results.

objcomputeBatterySizing.displayResults;

Total KeyOffLoad: 158.708 mA

Number of days required for KeyOfflLoad to discharge 30% of battery: 55.789.
Total CrankingInRush current: 70 A

Total Cranking current: 104 A

CCA of the specifed battery is sufficient to start the car at 0 F.
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scExampleAutomotiveElectricalSystemAnalysis

Cepyrigat 2070 The Mathidlzrks, Ino.

Close Model
bdclose('scExampleAutomotiveElectricalSystemAnalysis');

See Also

systemcomposer.analysis.Instance | iterate| instantiate | deleteInstance | update |
save | loadInstance | getValue | setValue | hasValue | Lookup

More About

. “Analyze Architecture” on page 6-10

. “Organize System Composer Files in a Project” on page 1-37

. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
. “Allocate Architectures in Tire Pressure Monitoring System” on page 6-5
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Import and Export Architectures

In System Composer™, an architecture is fully defined by three sets of information:

* Component information
e Port information
* Connection information

You can import an architecture into System Composer when this information is defined in or
converted into MATLAB® tables.

In this example, the architecture information of a simple UAV system is defined in a Microsoft®
Excel® spreadsheet and is used to create a System Composer architecture model. It also links
elements to the specified system level requirement. You can modify the files in this example to import
architectures defined in external tools, when the data includes the required information. The example
also shows how to export this architecture information from System Composer architecture model to
an Excel spreadsheet.

Architecture Definition Data

You can characterize the architecture as a network of components and import by defining
components, ports, connections, interfaces and requirement links in MATLAB tables. The
components table must include name, unique ID, and parent component ID for each component. The
spreadsheet can also include other relevant information required to construct the architecture
hierarchy for referenced model, and stereotype qualifier names. The ports table must include port
name, direction, component, and port ID information. Port interface information may also be required
to assign ports to components. The connections table includes information to connect ports. At a
minimum, this table must include the connection ID, source port ID, and destination port ID.

The systemcomposer.importModel (importModelName) API:

* Reads stereotype names from the components table and loads the profiles
* Creates components and attaches ports

* Creates connections using the connection map

» Sets interfaces on ports

* Links elements to specified requirements

* Saves referenced models

* Saves the architecture model

% Instantiate adapter class to read from Excel.
modelName = 'simpleUAVArchitecture';

% importModelFromExcel function reads the Excel file and creates the MATLAB tables.
importAdapter = ImportModelFromExcel('SmallUAVModel.xls"', 'Components',

'Ports', 'Connections', 'PortInterfaces', 'RequirementlLinks');
importAdapter.readTableFromExcel();

Import an Architecture
model = systemcomposer.importModel (modelName, importAdapter.Components,

importAdapter.Ports,importAdapter.Connections,importAdapter.Interfaces,
importAdapter.RequirementLinks);
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% Auto-arrange blocks in the generated model
Simulink.BlockDiagram.arrangeSystem(modelName);

simpleUAVArchitecture

Propulsion Supervisory
EngineStatus [» I+ EngineStatus
[ 3 Filellevel > I EuelData
PwrStatus [ > PwrStatus - Data Link[{T>
> Telemetry
FlightComputer
Flight Support Components I 1
2! Ll B ADSBData [»
AirData [ b AirData
= n - . Control Surface Cmds >
GS Comma k> ADSBData onb
> lGS Commands GRESOat N
GPSData b b+ EngingStatus|
e —— FuelData [+ Payload
I FuellLevel .
. Oipaerator Cmds > [ operatorCinds ===="Data Link [» 4Data Link
> GPSDHS" .
Telemetry [» - Telemetry
k> GS Comfnands
. dT I
> PwrStatus
ghtCmds [= Telemetry[H B
Airframe
GS Commangs[p—{Ir ctiSfeDeflection
b lightCmds | ==

Export an Architecture

You can export an architecture to MATLAB tables and then convert the tables to an external file.

exportedSet = systemcomposer.exportModel (modelName) ;
% The output of the function is a structure that contains the component table, port table,
% connection table, the interface table, and the requirement links table.

% Save the above structure to Excel file.

SaveToExcel('ExportedUAVModel', exportedSet);

See Also
importModel | exportModel | updateLinksToReferenceRequirements

More About

. “Import and Export Architecture Models” on page 6-21
. “Compose Architecture Visually” on page 1-2

. “Decompose and Reuse Components” on page 1-16

. “Manage Requirements” on page 2-8

. “Import System Composer Architecture Using ModelBuilder” on page 6-29
. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Import and Export Architecture Models

To build a System Composer model, you can import information about components, ports, and
connections in a predefined format using MATLAB table objects. You can extend these tables and add
information like applied stereotypes, property values, linked model references, variant components,
interfaces, and requirement links.

Similarly, you can export information about components, hierarchy of components, ports on
components, connections between components, linked model references, variants, stereotypes on
elements, interfaces, and requirement links.

Define a Basic Architecture

The minimum required structure for a System Composer model consists of these sets of information:

* Components table
* DPorts table
* Connections table

To import additional elements, you need to add columns to the tables and add specific values for
these elements.

Components Table

The information about components is passed as values in a MATLAB table against predefined column
names, where:

* Name is the component name.
* 1IDis a user-defined ID used to map child components and add ports to components.
* ParentID is the parent component ID.

For example, Component 1 1 and Component 1 2 are children of Component 1.

Name ID ParentID
root 0

Component 1 1 0
Component 1 1 2 1
Component 1 2 3 1
Component 2 4 0

Ports Table

The information about ports is passed as values in a MATLAB table against predefined column names,
where:

* Name is the port name.
* Direction can be one of Input, Output, or Physical.
» IDis a user-defined port ID used to map ports to port connections.
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* CompID is the ID of the component to which the port is added. It is the component passed in the
components table.

Name Direction ID ComplD
Portl Output 1 1
Port2 Physical 2 4
Portl 1 Output 3 2
Portl 2 Input 4 3

Connections Table

The information about connections is passed as values in a MATLAB table against predefined column
names, where:

* Name is the connection name.

» IDis connection ID used to check that the connections are properly created during the import
process.

* Kind is the kind of connection specified by Data by default or Physical. The Kind column is
optional and will default to Data if undefined.

* SourcePortID is the ID of the source port.
* DestPortID is the ID of the destination port.

* PortIDs are a comma-separated list of port IDs for physical ports that support nondirectional
connections.

Name Kind ID SourcePortID |DestPortID PortiDs
Connl Data 1 2
Conn2 Physical 3,4

Import a Basic Architecture

Import the basic architecture from the tables created above into System Composer from the MATLAB
Command Window.

systemcomposer.importModel('importedModel', components,ports,connections)

The basic architecture model opens.

Tip The tables do not include information about the model's visual layout. You can arrange the
components manually or use Architecture > Arrange > Arrange Automatically.

Extend the Basic Architecture Import
You can import other model elements into the basic structure tables.
Import Data Interfaces and Map Ports to Interfaces

To define the data interfaces, add interface names in the ports table to associate ports to
corresponding portInterfaces table. Create a table similar to components, ports, and
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connections. Information like interface name, associated element name along with data type,
dimensions, units, complexity, minimum, and maximum values are passed to the importModel
function in a table format shown below.

Name

Parentl
D

DataTyp
e

Dimension
S

Units

Comple
xity

Minimu
m

Maximu
m

interface
1

DatalInt
erface

eleml

interfa
ce2

interface
2

Datalnt
erface

elem2

double

real

II[]II

II[]II

elem3

valueTy
pe

3

cm

real

0

100

valueType |6

int32

3

cm

real

100

interface
3

Physica
lInterf
ace

elec

Connect
ion:

foundat
ion.ele
ctrical
.electr
ical

mech

Connect
ion:

foundat
ion.mec
hanical
.mechan
ical.ro
tationa
1

Data interfaces interfacel and interface?2 are defined with data elements eleml and elem2
under interfacel. Data element elem?2 is typed by interface2, inheriting its structure. For more
information, see “Nest Interfaces to Reuse Data” on page 3-7.

Note Owned interfaces cannot be nested. You cannot define an owned interface as the data type of
data elements. For more information, see “Define Owned Interfaces Local to Ports” on page 3-10.

This data interface interfacel includes a data element elem3, which is typed by a value type
valueType and inherits its properties. For more information, see “Create Value Types as Interfaces”

on page 3-6.
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This physical interface interface3 includes physical elements elec and mech, which are typed
under their respective physical domains. For more information, see “Specify Physical Interfaces on
the Ports” on page 5-55.

To map the added data interface to ports, add the column InterfacelID in the ports table and
specify the data interface to be linked. For example, interfacel is mapped to Portl as shown
below.

Name Direction ID ComplD InterfacelD
Portl Output 1 1 interfacel
Port2 Input 2 4 interface2
Portl 1 Qutput 3 2 o

Portl 2 Input 4 3 interfacel

Import Variant Components, Stateflow Behaviors, or Reference Components

You can add variant components just like any other component in the components table, except you
specify the name of the active variant. Add choices as child components to the variant components.
Specify the variant choices as string values in the VariantControl column. You can enter
expressions in the VariantCondition column. For more information, see “Create Variants” on page
1-20.

Add a variant component VarComp using component type Variant with choices Choicel and
Choice2. Set Choice?2 as the active choice.

To add a referenced Simulink model, change the component type to Behavior and specify the
reference model name simulink model.

To add a Stateflow chart behavior on a component, change the component type to
StateflowBehavior. If System Composer does not detect a license or installation of Stateflow, a
Composition component is imported instead.

Name ID ParentID |Reference |Componen |ActiveChoi |VariantCon |VariantCon
ModelNam |tType ce trol dition
e

root 0

Component |C1 0 simulink |[Behavior

1 model

VarComp V2 0 Variant Choice2

Choicel C6 V2 petrol

Choice2 c7 V2 diesel

Component |C3 0 Stateflow

3 Behavior

Component [C4 C1

11

Component |C5 C1

12
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Pass the modified components table along with the ports and connections tables to the
importModel function.

Apply Stereotypes and Set Property Values on Imported Model

To apply stereotypes on components, ports, and connections, add a StereotypeNames column to the
components table. To set the properties for the stereotypes, add a column with a name defined using
the profile name, stereotype name, and property name. For example, name the column
UAVComponent OnboardElement Mass for a UAVComponent profile, a OnBoardElement
stereotype, and a Mass property.

You set the property values in the format value{units}. Units and values are populated from the
default values defined in the loaded profile file. For more information, see “Define Profiles and
Stereotypes” on page 4-2.

Name ID ParentID StereotypeNam |UAVComponent [UAVCompon

es _OnboardEleme |ent_Onboard
nt_Mass Element_Po
wer

root 0

Component 1 1 0 UAVComponent.0|0.93{kg} 0.65{mW}
nboardElement

Component 1 1 |2

Component 1 2 |3 UAVComponent.0[0.93{kg} e
nboardElement

Component 2 4 0

Assign Requirement Links on Imported Model

To assign requirement links to the model, add a requirementLinks table with these required
columns:

* Label is the name of the requirement.

* IDisthe ID of the requirement.

* SourcelD is the architecture element to which the requirement is attached.

* DestinationType is how requirements are saved.

* DestinationID is where the requirement is located.

* Type is the requirement type.

For more information, see “Manage Requirements” on page 2-8.

Label ID SourcelD DestinationT |DestinationlD |Type
ype
rset#l 1 components |linktype r [C:\Temp Implement
11 mi slreq \rset.slregx#1
rset#2 2 components |linktype r [C:\Temp Implement
:0 mi slreq \rset.slreqx#2
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Label ID SourcelD DestinationT |DestinationlD |Type
ype

rset#3 3 ports:1 linktype r [C:\Temp Implement
mi slreq \rset.slreqx#3

rset#4 4 ports:3 linktype r |C:\Temp Implement
mi slreq \rset.slreqx#4

A Simulink Requirements license is required to import requirement links into a System Composer

architecture model.

Specify Elements on Architecture Port

In the connections table, you can specify different kinds of signal interface elements as source
elements or destination elements. Connections can be formed from a root architecture port to a
component port, from a component port to a root architecture port, or between two root architecture

ports of the same architecture.

Interfaces

dl

-

a0

elem

ali

&

-

: elemSelection.slx

~ [:] electricinterface

* [ mobilelnterface
nterface
* mohile (electricinterface)
elem

alt

The nested interface element mobile.elem is the source element for the connection between an
architecture port and a component port. The nested element mobile.alt is the destination element
for the connection between an architecture port and a component port. The interface element
mobile and the nested element mobile.alt are source elements for the connection between two
architecture ports of the same architecture.

For more information, see “Specify a Source Element or Destination Element for Ports on a

Connection” on page 3-13.

Name ID SourcePortl |DestPortID |SourceElement |DestinationElem
D ent
RootToCompl 1 5 4 mobile.elem
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RootToComp?2 2 5 1 mobile.alt
ComplToRoot 3 2 6 interface
Comp2ToRoot 4 3 6 mobile.alt
RootToRoot 5 5 6 mobile,mobile.

alt

Define Architecture Domain for Software Architectures

To specify that the architecture to be imported is a software architecture, specify the domain field of
the import structure as "Software". For more information, see “Import and Export Software
Architectures” on page 7-5.

Export an Architecture

To export a model, pass the model name as an argument to the exportModel function. The function
returns a structure containing five tables: components, ports, connections, portInterfaces,
and requirementLinks, and the field domain that is a character vector that represents the type of
architecture being exported. The value of domainis 'System' for architecture models or
'Software' for software architecture models.

exportedSet = systemcomposer.exportModel (modelName)

You can export the set to MATLAB tables and then convert those tables to external file formats,
including Microsoft® Excel® or databases.

exportedset
|E| 1x1 struct with 6 fields

Field Value

EH components

EH ports

FH connections

FH portinterfaces
feH requiremnentlinks
|=|7| domain

If requirements were imported to the model using an external file, in order to export and reimport
those requirements, update reference requirement links within the model. You can use this API for
the requirement links to point to the imported referenced requirements instead of the external
documents. You can use the systemcomposer.updateLinksToReferenceRequirements function
to make the requirement links point to the imported referenced requirements instead of the external
documents.

See Also
importModel | exportModel | systemcomposer.io.ModelBuilder |
systemcomposer.updateLinksToReferenceRequirements

More About

. “Compose Architecture Visually” on page 1-2

. “Decompose and Reuse Components” on page 1-16

. “Describe Component Behavior Using Simulink” on page 5-2
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. “Manage Requirements” on page 2-8
. “Import and Export Architectures” on page 6-19
. “Import System Composer Architecture Using ModelBuilder” on page 6-29
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Import System Composer Architecture Using ModelBuilder

Import architecture specifications into System Composer™ using the
systemcomposer.io.ModelBuilder utility class. These architecture specifications can be defined
in an external source, such as an Excel® file.

In System Composer, an architecture is fully defined by four sets of information:

* Components and their position in the architecture hierarchy.
* Ports and their mapping to components.

* Connections among components through ports. In this example, we also import interface data
definitions from an external source.

* Interfaces in architecture models and their mapping to ports.

This example uses the systemcomposer.io.ModelBuilder class to pass all of the above
architecture information and import a System Composer model.

In this example, architecture information of a small UAV system is defined in an Excel spreadsheet
and is used to create a System Composer architecture model.

External Source Files

* Architecture.xlsx — This Excel file contains hierarchical information of the architecture
model. This example maps the external source data to System Composer model elements. Below is
the mapping of information in column names to System Composer model elements.

# Element : Name of the element. Either can be component or port name.
# Parent : Name of the parent element.
# Class : Can be either component or port(Input/Output direction of the port).
# Domain : Mapped as component property. Property "Manufacturer" defined in the
profile UAVComponent under Stereotype PartDescriptor maps to Domain values il
# Kind : Mapped as component property. Property "ModelName" defined in the

profile UAVComponent under Stereotype PartDescriptor maps to Kind values in ¢
InterfaceName : If class is of port type. InterfaceName maps to name of the interface linl
ConnectedTo : In case of port type, it specifies the connection to

other port defined in format "ComponentName: :PortName".

H* H#*

* DataDefinitions.xlsx — This Excel file contains interface data definitions of the model. This
example assumes the below mapping between the data definitions in the Excel source file and
interfaces hierarchy in System Composer.

# Name : Name of the interface or element.
# Parent : Name of the parent interface Name(Applicable only for elements)
# Datatype : Datatype of element. Can be another interface in format
Bus: InterfaceName
# Dimensions : Dimensions of the element.
# Units : Unit property of the element.
# Minimum : Minimum value of the element.
# Maximum : Maximum value of the element.

Step 1. Instantiate the ModelBuilder Class

You can instantiate the ModelBuilder class with a profile name.

[stat,fa] = fileattrib(pwd);
if ~fa.UserWrite
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disp('This script must be run in a writable directory');

return;
end
% Name of the model to build.
modelName = 'scExampleModelBuider';

% Name of the profile.

profile = 'UAVComponent';

% Name of the source file to read architecture information.
architectureFileName = 'Architecture.xlsx';

% Instantiate the ModelBuilder.
builder = systemcomposer.io.ModelBuilder(profile);

Step 2. Build Interface Data Definitions

Reading the information in the external source file DataDefinitions.x1lsXx, build the interface data
model.

Create MATLAB® tables from the Excel source file.

opts = detectImportOptions('DataDefinitions.xlsx"');
opts.DataRange = 'A2'; % force readtable to start reading from the second row.
definitionContents = readtable('DataDefinitions.xlsx',opts);

% systemcomposer.io.IdService class generates unique ID for a
% given key
idService = systemcomposer.io.IdService();

for rowItr =l:numel(definitionContents(:,1))
parentInterface = definitionContents.Parent{rowItr};
if isempty(parentInterface)
% In case of interfaces adding the interface name to model builder.
interfaceName = definitionContents.Name{rowItr};
Get unique interface ID. getID(container,key) generates
or returns (if key is already present) same value for input key
within the container.
interfaceID = idService.getID('interfaces',interfaceName);

o® o° of

% Builder utility function to add interface to data

% dictionary.

builder.addInterface(interfaceName, interfacelID);
else

In case of element read element properties and add the element to
parent interface.

elementName = definitionContents.Name{rowItr};

interfaceID = idService.getID('interfaces',parentInterface);

% ElementID is unique within a interface.

% Appending 'E' at start of ID for uniformity. The generated ID for
% input element is unique within parent interface name as container.
elemID = idService.getID(parentInterface,elementName, 'E');

% Datatype, dimensions, units, minimum and maximum properties of

% element.

datatype = definitionContents.DataType{rowlItr};

dimensions = string(definitionContents.Dimensions(rowItr));

units = definitionContents.Units(rowlItr);

% Make sure that input to builder utility function is always a

% string.

if ~ischar(units)

units = ;

o o°
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end
minimum = definitionContents.Minimum{rowItr};
maximum = definitionContents.Maximum{rowItr};

% Builder function to add element with properties in interface.
builder.addElementInInterface(elementName,elemID,interfacelD,datatype,dimensions,units, "
end
end

Step 3. Build Architecture Specifications

Architecture specifications are created by MATLAB tables from the Excel source file.

excelContents = readtable(architectureFileName);
% Iterate over each row in table.
for rowItr =1:numel(excelContents(:,1))
% Read each row of the excel file and columns.
class = excelContents.Class(rowltr);
Parent = excelContents.Parent(rowItr);
Name = excelContents.Element{rowItr};
% Populating the contents of table using the builder.
if strcmp(class, 'component')
ID = idService.getID('comp',Name);
% Root ID is by default set as zero.
if strcmp(Parent, 'scExampleSmallUAV")
parentID = "0";
else
parentID = idService.getID('comp',Parent);
end
% Builder utility function to add component.
builder.addComponent (Name, ID,parentID);
% Reading the property values
kind = excelContents.Kind{rowItr};
domain = excelContents.Domain{rowItr};
% *Builder to set stereotype and property values.
builder.setComponentProperty(ID, 'StereotypeName', 'UAVComponent.PartDescriptor', 'ModelNam
else
% In this example, concatenation of port name and parent component name
% 1s used as key to generate unique IDs for ports.
portID = idService.getID('port',strcat(Name,Parent));
% For ports on root architecture. compID is assumed as "0".
if strcmp(Parent, 'scExampleSmallUAV")
compID = "0";
else
compID = idService.getID('comp',Parent);
end
% Builder utility function to add port.
builder.addPort(Name,class,portID,compID );

% InterfaceName specifies the name of the interface linked to port.
interfaceName = excelContents.InterfaceName{rowItr};

% Get interface ID. getID() will return the same IDs already
% generated while adding interface in Step 2.

interfacelD = idService.getID('interfaces',interfaceName);

% Builder to map interface to port.
builder.addInterfaceToPort(interfacelD,portID);

% Reading the connectedTo information to build connections between
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% components.
connectedTo = excelContents.ConnectedTo{rowItr};
connectedTo is in format:
(DestinationComponentName: :DestinationPortName).
For this example, considering the current port as source of the connection.
if ~isempty(connectedTo)
connID = idService.getID('connection',connectedTo);
splits = split(connectedTo,'::"');
% Get the port ID of the connected port.
In this example, port ID is generated by concatenating
port name and parent component name. If port id is already
s generated getID() function returns the same id for input key.
connectedPortID = idService.getID('port',strcat(splits(2),splits(1)));
% Using builder to populate connection table.
sourcePortID = portID;
destPortID = connectedPortID;
% Builder to add connections.
builder.addConnection(connectedTo,connID,sourcePortID,destPortID);

o® o° of

0° 0 of

o

end
end
end
Step 3. Import Model from Populated Tables with builder.build Function

[model, importReport] = builder.build(modelName);

scExampleModelBuider

Propulsion = supawlsoﬁ
[ —— EngigeStatus [» b EngineStatus
b dT FuslLevel [» b FuelData
- Data Linkp{ >
I FusiSupply FuslRsturn P b PurStatus
E ’ MeachConnection [» B Telemetry
FlightComputer
ADSBData [
b AirData E
b GS Commands Control Surface Cmds Airframe
Flight Support Compenents = I+ EnginaStatus m——
[ = e dT ¥ b ciriSricDeflection
p— AirData P b Fuellevst N
= SlightCmds > = lightCmds
[+ ADSBData GPSData b GPSData N
- . ‘Operator Cmds [
mes  GPSSupportData b > GS Confjmands
Payload Cmds [
- Telemetry
b PwrStatus
Telemetry > _Fayload E_
GS Commands|i — Data Link B @ Data Link
b+ operatorCmds -
— Video Out >
1
bdclose(modelName)

See Also
systemcomposer.io.ModelBuilder | importModel | exportModel
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More About
. “Import and Export Architecture Models” on page 6-21
. “Compose Architecture Visually” on page 1-2

. “Import and Export Architectures” on page 6-19
. “Simulate Mobile Robot with System Composer Workflow” on page 4-21
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Systems Engineering Approach for SoC Applications

This example shows how to design a sample signal detector application on an System on Chip (SoC)
platform using a systems engineering approach. The workflow in this example maps the application
functions onto the selected hardware architecture.

The signal detector application continuously processes the signal data and classifies the signal as
either high or low frequency. The signal cannot change between high- and low-frequency classes
faster than 1 ms. The signal is sampled at the rate of 10 MHz.

Functional Architecture

Define the functional architecture of the application. At this stage, the implementation of the
application components is not known. You can use the System Composer™ software to capture the
functional architecture.

This model represents the functional architecture with its main software components and their connections.

systemcomposer.openModel('soc signaldetector func');

soc_signaldetector_func

= ; > +
Generate Signal *a Preprocess Signal D% Classify Signal O* Activate LEDs 1

< 80C_Siggen > < SOC_Sigreproc > « spe_sigelass > < soc_ladac >

Raw Data [ B InDala OulData B B InDala

i

The functional architecture of the application consists of these top-level components:

Generate Signal
Preprocess Signal
Classify Signal
Activate LEDs

A W N R

Hardware Architecture

Select the hardware architecture. Due to the anticipated application complexity, choose an SoC
device. The chosen SoC device has a hardware programmable logic (FPGA) core and an embedded
processor (ARM) core. You can use the System Composer software to capture the details of the
hardware architecture.
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This model represents the hardware architecture with its main hardware components and their
connections.

systemcomposer.openModel('soc signaldetector arch');

soc_signaldetector_arch

FPGA {E Mermory Processor {E

Samples [» [» Samnples Frame [» [> Frame

ResultOut <1 <1 ResultDut Resultin < <] Result

<1

&l

Behavioral Modeling

If the implementations for functional components are available, you can add them to the functional
architecture as behaviors. In System Composer, for each functional component, you can link the
implementation behaviors as Simulink® models. To review the component implementations, double-
click each component in the functional architecture model.

After you define the behavior of each component, you can simulate the behavior of the entire
application and verify its functional correctness. Select Run in the functional architecture model.
Then, analyze the signals classification results in the Simulation Data Inspector. To change the
signal type, select the Generate Signal component and then select the Manual Switch block.
Confirm that the source signal is classified correctly.

Allocation of Functional and Hardware Elements

After refining the functional and hardware architecture, allocate different functional components to
different hardware elements to meet desired system performance benchmarks. In this case, some
functional components are constrained as to where in the hardware architecture they can be
implemented. You must implement the Generate Signal and Activate LEDs components on the
FPGA core in the chosen hardware architecture due to input output (I/O) connections. Comparatively,
you can implement the Preprocess Signal and Classify Signal components on either the
FPGA or on the processor core.

Component Constraint
Generate Signal FPGA
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Preprocess Signal -
Classify Signal -
Activate LEDs FPGA

This example shows how to use three possible scenarios for allocating the application functional
architecture to the hardware architecture.

* The FPGA handles preprocessing and classification.

* The FPGA handles preprocessing and the processor handles classification.

* The processor handles preprocessing and classification.

System Composer captures these scenarios as Scenario 1, Scenario 2, and Scenario 3 using
the allocation editor.

systemcomposer.allocation.editor
allocSet = systemcomposer.allocation.load('soc signaldetector allocation');

Allocation Set Browser Scenario 1 Allocation Scenario Propertias
PR = Name Value
soc_signaldetactor_allocation —
= - 2 4 Main
- 5]
&| Scenario 1 s |
i 2 |3 Name Scenario 1
& Scenario 2 = % g .
gr Scenario 3 5 |3 5 g o Descripti Preprocessing and c
: E |2 | |w escription p gandc
s 0 D0
lj b b b b
b

~ [™] soc_signaldetector_
= [™] Activate LEDs
~ [™] Generate Signal

~ [™] Preprocess Sign

b b b b

~ [™ Classify Signal

hoosing an allocation scenario requires finding an implementation that optimally meets the application requirements.
Often you can find this implementation via static analysis without detailed simulation. In this
example, use static analysis to analyze the computational costs of implementing different functional
components on the processor and on the FPGA.

Implementation Cost

The implementation cost of a component depends on the required computation operations. To
determine the implementation costs, consider these typical approaches.

* Component implementation is not available: Obtain the computational cost from the available
reference implementations.

* The implementation and the hardware are available: Measure or profile the implementation cost
on the candidate hardware.

* The implementation is available, but the hardware is not: Estimate the implementation cost by
using the SoC Blockset™ algorithm analyzer function socAlgorithmAnalyzerReport.
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The socModelAnalyzer function estimates the number of operations in a Simulink model and
generates an algorithm analyzer report. To get the number of operations that a model executes to
then analyze the implementation cost on the processor, use the dynamic analysis function option. To
get the number of operators an algorithm requires to then analyze the implementation cost on the
FPGA, use the static analysis function option. For an example on how to use socModelAnalyzer, see
this sample function.

soc_signaldetector costanalysis

*** Component: 'Preprocess Signal'
ADD (+) MUL (*)

FPGA Implementation 15 16
Processor Implementation 15300 16320

*** Component: 'Classify Signal'
ADD (+) MUL (*)

FPGA Implementation 32 18
Processor Implementation 32640 18360

The implementation costs for each functional component obtained in this code are entered in the
corresponding stereotypes in the functional architecture. To verify the values, select each component
in the functional architecture model and use the Property Inspector.

To learn more about socModelAnalyzer, see the “Compare FIR Filter Implementations Using
socModelAnalyzer” (SoC Blockset) example. This example shows how to analyze the computational
complexity of different implementations of a Simulink algorithm.

Allocation Choice

You can use the number of operators or operations that are required for implementing the application
functional components to decide how to allocate the functional components to the hardware
components. Analyze the candidate allocations by comparing the implementation cost against the
available resources of the FPGA and the processor. This example uses sample values in the FPGA and
the processor components in the hardware architecture model for the available computation
resources. Verify the values by using the Property Inspector.

Typically, the analysis does not use the number of operators or operations directly. Rather, the
number of operators or operations are multiplied by the cost of each operator or operation first. The
cost of the operator or operations is hardware dependent. Determining such costs is beyond the
scope of this example.

For an example on how to use the cost models, use this function. Observe that we require the
capacity of the FPGA and the processor be greater than the estimated implementation cost as well as
that the processor headroom be between 60 and 90 %.

soc_signaldetector partitionanalysis

FPGA DSPs Used (out of 900) FPGA LUT Used (out of 218600) Processor Inst
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Scenario 1 34 576
Scenario 2 16 192
Scenario 3 0 0

Based on the results Scenario 2 is feasible.

Data Path Design Between FPGA and Processor

The FPGA processes data sample-by-sample, and the processor processes frame-by-frame. Because
the duration of a processor task can vary, to prevent data loss, a queue is needed to hold the data
between the FPGA and processor. In this case you must set these parameters that are related to the
queue: frame size, number of frame buffers, and FIFO size (that is, the number of samples in the
FIFO). Also, in embedded applications, the task durations can vary between different task instances
(for example, due to different code execution paths or due to variations in OS switching time). As a
result, data might be dropped in the memory channel. The “Streaming Data from Hardware to
Software” (SoC Blockset) example shows a systematic approach to choosing the previously mentioned
parameters that satisfy the application requirements.

See Also
socAlgorithmAnalyzerReport | socModelAnalyzer | systemcomposer.allocation.editor

More About

. “Using the Algorithm Analyzer Report” (SoC Blockset)

. “Create and Manage Allocations” on page 6-2

. “Analyze Architecture” on page 6-10

. “Compose Architecture Visually” on page 1-2

. “Describe Component Behavior Using Simulink” on page 5-2
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* “Author Software Architectures” on page 7-2

* “Simulate and Deploy Software Architectures” on page 7-8

* “Modeling the Software Architecture of a Throttle Position Control System” on page 7-14
* “Class Diagram View of Software Architectures” on page 7-20
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Author Software Architectures

7-2

Software architectures in System Composer provide capabilities to author software architecture
models composed of software components, ports, and interfaces. Use System Composer to design
your software architecture model, simulate your design in the architecture level, and generate code.

Use software architectures to link your Simulink export-function, rate-based, or JMAAB models to

components in your architecture model to simulate and generate code.

Create a New Software Architecture Model

The workflow for authoring software architecture models is similar to authoring system architectures.
Start with a blank software architecture template to model.

You can create a software architecture programmatically by using the function.

systemcomposer.createModel( 'mySoftwareArchitectureDesign', 'SoftwareArchitecture'),
where mySoftwareArchitectureDesign is the name of the new model.

You can also use the provided template in the Simulink start page.

MNew Examples

A
— Ko o ke E

Recent a
¥ Statefiow

Projects
v System Composer
B From Source Conirol -

Learn [ yaE

[F@ Simutink Onramp Create Mode|

Cp Statefiow Onramp ]

Jh

453 Control Desig mp with § nik
g% Conlrol Design Onramp with Simulink Architecture Mode Software Architecture Mol "

¥ UAY Toolbox Support Package for PX4 Autopilols
¥ Vehicle Dynamics Blockset
¥ Vision HDL Toolbox

» Wireless HOL ToolDox

From a Simulink model or a System Composer architecture model, on the Simulation tab, select
New "u and then select Architecture Iﬁ_gﬁ Then, select Software Architecture Model.

System Composer opens a new empty software architecture model. Observe the icon on the upper
left corner that distinguishes the empty model from a system architecture.
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=
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When you model software architectures, you can:

* Use model building and visualization tools provided by System Composer such as components,
connections, and ports. For more information, see “Compose Architecture Visually” on page 1-2.

» Define interfaces. For more information, see “Create Interfaces” on page 3-4.

* Create custom views. For more information, see “Create Architecture Views Interactively” on page
8-5.

» Use tools to write analysis and create allocations. For more information, see “Analyze
Architecture” on page 6-10 and “Create and Manage Allocations” on page 6-2.

Build a Simple Software Architecture Model

1 Drag an empty component to the mySoftwareArchitectureDesign model.
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3

mySoftwareArchitectureDesign

Component

Link this simple Simulink Export-Function model, export model software architecture to
your component by right-clicking the component and selecting Link to Model. For more
information about building this Simulink model, see “Create an Export-Function Model”.

......... _i ................. <
function_call_100ms 1 function_call_10ms i
1 1
i i
X X
functioni) output_100ms functioni}
| imput_10ms. output_10ms
Function-Call Function-Call
Subsystern 1

Subsystern 2

Connect component input port and output ports to architecture input ports and output ports.
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mySoftwareArchitectureDesign

Component

. output_100ms i >
< export_model_software_architecture > P »

> Hllinput_10ms output_100ms > —+@loutput_100ms

input_10ms[p— > input 10ms| I S I

output 10ms b —4foutput_10ms
output_10msi b

In this example, you start from a blank template and create a simple software architecture model. To
learn how to simulate a software architecture model and generate code, see “Simulate and Deploy
Software Architectures” on page 7-8.

Import and Export Software Architectures

You can import a software architecture model using the systemcomposer. importModel function.

archModel = systemcomposer.importModel (modelName, importStruct)

If the domain field of importStructis "Software", the importModel function creates a new
software architecture based on the structure of the MATLAB tables.

To export a System Composer software architecture model, use the systemcomposer.exportModel
function.

exportedSet = systemcomposer.exportModel (modelName)

The exportModel function returns a structure containing MATLAB tables that contains
components, ports, connections, portInterfaces, requirementLinks, and a domain field
with value 'Software' to indicate that the exported architecture is a software architecture.

Create Software Architecture from Architecture Model Component

You can also create a software architecture model from an existing component in a System Composer
architecture model.

To create a software architecture model from a component:

1 Select an existing component from your architecture model. In this example, we select
Component2.
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Architecture

Component1 Component2 O

2 To create a software architecture model from Component2, you can use any of these three
methods:

a  Right-click the component and select Create Software Architecture Model.
b  Select the component and, on the toolstrip, click Create Software Architecture Model.

SIMULATION DEBUG MODELING FORMAT APPS

- = aad 1 : e

= g B earc ""‘~| |3”E|

it - -

Us Inte!'face Import Apply ELABORATE -
51l Editor - Stereotypes
MANAGE DESIGN PROFILES %

: e Cra e

[ e | ek | Coe | oo

o - - i . i - — ’ ]
& | ® | @ Successfully imported architecture | % @ Q_"

= |
E @. Create Add Variant Link

o Stateflow. Choice to Mode

¢ To create a software architecture programmatically, use the createArchitectureModel
function.

3 Observe the software architecture model icon in the upper left corner. The new software
architecture contains all elements from the component, including previously applied stereotypes.
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omponent2

i [

The following elements are not supported if you create a software architecture from an existing
component:

» A reference component that references a system architecture.

* A component with Stateflow chart behavior.

* Adapter blocks with applied interface conversions. “Interface Adapter” on page 3-15 conversions
are removed when you create a software architecture from an existing component.

See Also
systemcomposer.createModel | createArchitectureModel | createSimulinkBehavior

More About

. “Compose Architecture Visually” on page 1-2

. “Create an Export-Function Model”

. “Class Diagram View of Software Architectures” on page 7-20

. “Modeling the Software Architecture of a Throttle Position Control System” on page 7-14
. “Simulate and Deploy Software Architectures” on page 7-8
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Simulate and Deploy Software Architectures

This example shows how to build a multi-component software architecture model with a rate-based
and export-function components, how to simulate your design at the architecture level, and how to
generate code.

Open the Software Architecture Model

This software architecture model has two software components: Export Function and
Rate Based.

open_system('RateBasedExportFunctionSoftwareArchitectureModel')

In the software architecture model, the Export Function component is linked to a Simulink®
export-function behavior model, export model software architecture.

RateBasedExportFunctionSoftwareArchitectureModel

t- 4finput_10ms

OutBus [ b=
" - -
Export_Function o Rate_Based J£]
= export_model_software_architecture > ) < rate_based_model_softwars_architecturs =
autput_100ms = B In3 Cut? b —4OutBus
nput_10ms|J B input_10ms
output_10ms = B Ind Outd p> —4ff CutBus1
CuiBus1 ¢ &=

In this Simulink behavior, two functions are modeled using Function-Call Subsystem blocks. The
inport blocks are connected to the function-call input ports and generate periodic function-call events
with sample times 10ms and 100ms. To learn how to model this behavior, see “Create an Export-
Function Model”.

1

function_call_100ms function_call_10ms i
1

1

h 4 h 4
function() output_100ms functicn()
D | (2
input_10ms output_10ms
Function-Call Function-Call
Subsystemn 1 Subsystem 2
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If the inport blocks that are connected to the function-call input ports with sample time specified as
-1, meaning the functions are aperiodic, use a Simulink test model with explicit scheduling blocks
such as a Stateflow chart to simulate. For more information see Test Software Architecture on page 7-
0

The Rate Based component is linked to rate based model software architecture asthe
Simulink behavior model. To learn how to create this rate-based model, see “Create A Rate-Based
Model”.

Co— )

Subsystem with Rate 0.2

Subsystem with Rate 0.4

Simulate the Model with Default Execution Order

Simulate the model. Observe that the Simulation Data Inspector displays the output from the Rate-
Based component.

W Fate_EBased:1 W Rate_Based:?

[
[¥%]
.
o
o
=R
L)
=

Visualize and Edit Component Functions Using Functions Editor

Use the Functions Editor to edit simulation execution order of the functions in your software
architecture. You can also edit the sample time of the functions with inherited sample time (-1).
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The Functions Editor is visible only when you model software architectures. To open the Functions
Editor, in the toolstrip on the Modeling tab, select Functions Editor.
Functions Editor >
Functions

T J a?g.. [] order functions by dependency

2 Export_Function_function_call_100ms Export_Function 0.1
1 Export_Function_function_call_10ms Export_Function 0.01
3 Rate_Based_D1 Rate_Based 0.2
4 Rate Based_D2 Rate_Based 0.4

To edit the functions in your software architecture:
1 Open the Functions Editor. When you open the Functions Editor, the model will automatically
update, and the table will display the functions populated from your model.

2 Ifthere are changes in the software architecture model, the Update Model button becomes
yellow to signal that an update is required to refresh your functions table.

3 To arrange the execution order of the functions, use the up and down arrows or drag and drop
functions to sort them.

To edit sample times of the functions, specify their period in the table.

5 To order functions based on their data dependencies, select the Order functions by
dependency check box. To enable sorting of functions based on dependencies, you can set this
parameter: set param('RateBasedExportFunctionSoftwareArchitectureModel’,"
OrderFunctionsByDependency', 'on'). The default value for the parameter is off.

Alternatively, you can use the systemcomposer.arch.Function object to get the functions
programmatically.

Test Software Architecture

You can test a software architecture model and simulate different execution orders of functions by
referencing it from a Model block in a Simulink test model with explicit scheduling blocks such as
Stateflow® Chart (Stateflow).

In this example, a Model block that references a software architecture model has a function-call input
port for each function in the architecture model.

To simulate the architecture model with a Stateflow chart periodic scheduler, connect the Stateflow
chart function-call outputs to the Model block function-call inputs.
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': ™ RateBazedExportFunctionSoftwarafnchitectureblodel
datai M input_10ms

COutBus .

AjF--------- M Export_Functicn_function_call_100ms

% - M Export_Function_function_call_10ms C]

] M Rate_Based_D1
OutBus1 »
] M Rate_Based_DZ
A
A A
Sequence Model

Deploy Software Architecture

You can generate code from the software architecture model for the functions of the export-function
and rate-based components.

To generate code, from the Apps tab, select Embedded Coder. On the C Code tab, select Generate
Code. The generated code contains an entry-point for each function of the component. For more
information, see “Generate Code for Export-Function Model”.

For the export-function component, it generated the two functions that correspond to the function-
call inport blocks inside the referenced export-function model.
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vold Export_Function_function_call_lems{vocid)
/* Explicit Task: Export_Function_functiom_call_iems */
S

/* RoctInportFunctionCallGenerator generated from: “<Root»/Export_Functicon_function_call_lems' */

/* ModelReference: "«<Root»/Export_Function' incorporates:
* Inport: '<Root>/input_lems’
y
export_model_software_architecture_function_call_ileéms(&Export_Function,
&RateBasedExportFunctionseftwarearchitectureModel_U. input_lems,
&RateBasedExportFunctionsoftwarearchitectureModel_B.Export_Function_o2);

f* End of outputs for RootInportFunctionCallGenerator generated from: '<Root»/Export_Function_function_call_iems' */

/* Model step function for TID2 */
void Export_Function_function_call_leéms{woid)
/* Explicit Task: Export_runction_fumctiom_call_ieems */
S

/* RoctInportFunctionCallGenerator generated from: ‘<Root>/Export_Functicon_function_call_ieems' */

/* ModelReference: "«<Root»/Export_Function' incorporates:
* Inport: '<Root>/input_lems’
y
export_model_software_architecture_function_call_leeéms(&Export_Function,
&rateBasedExportFunctionsoftwarearchitectureModel_B.Export_Function_ol};

f* End of outputs for RootInportFunctionCallGenerator generated from: '<Root»/Export_Function_function_call_ieeéms® */

Observe that, each rate-based component has separate entry point functions that correspond to each
sample time in the referenced rate based model.
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void Rate_Based_D1{wvoid) /* Explicit Task: Rate_Based D1 =/

{* RoctInportFunctionCallGenerator generated from: ‘«<Root»/Rate_Based D1 */

/* ModelReference: "<Root:»/Rate_Based' incorporates:
* Qutport: '<Root»fOutBus'
* pgutport: '<Root:>/fOoutBusl’

%

rate_based_model_software_j

{&RateBasedExportFunctionSoftwareArchitectureModel _B.Export_Function_ci,

&RateBasedexportFunctionsoftwareArchitectureModel ¥.QutBus});

/¥ End of outputs for RootImportFunctionCallGenerator generated from: "<Root:/Rate_Based D1' */f

/¥ Model step function for TIDG */
void Rate_Based_D2({wvoid) /* Explicit Task: Rate_Based D2 =/

=l 1

{* RoctInportFunctionCallGenerator generated from: ‘«<Root»/Rate_Based_D2' */

/* ModelReference: "<Root:»/Rate_Based' incorporates:
* Qutport: '<Root»fOutBus'
* pgutport: '<Root:>/fOoutBusl’

%

rate_based_model_softwar_Jja

{&RateBasedExportFunctionSoftwareArchitectureModel _B.Export_Function_c2,

&RateBasedExportrunctionsoftwarearchitectureModel Y. 0utBusl);

/¥ End of outputs for RootImportFunctionCallGenerator generated from: "<Root:»/Rate_Based D2' */f

See Also

systemcomposer.createModel | createArchitectureModel | createSimulinkBehavior |
increaseExecutionOrder | decreaseExecutionOrder

More About

L]

“Author Software Architectures” on page 7-2

“Compose Architecture Visually” on page 1-2

“Create an Export-Function Model”

“Create A Rate-Based Model”

“Class Diagram View of Software Architectures” on page 7-20

“Modeling the Software Architecture of a Throttle Position Control System” on page 7-14
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Modeling the Software Architecture of a Throttle Position
Control System

This example shows how to author the software architecture of a throttle position control system in
System Composer™, schedule and simulate the execution order of the functions from its components,
and generate code.

Throttle Control Composition

In this example, the software architecture of a throttle position control system is modeled in System
Composer using six components. The throttle position control component reads the throttle and pedal
positions and outputs the new throttle position. Two throttle position sensor components provide the
current position of the throttle, and a pedal position sensor component provides the applied pedal
position. A controller component uses these signals to determine the new throttle position as a
percent value. An actuator component then converts the percent value to the appropriate value for
the hardware.

model = systemcomposer.openModel('ThrottleControlComposition');

ThrottleControlComposition

Throttle Position Control System

b MIAPP_HWIO_Value

TPS_Secondary %
< ThrottiePositionSensor =
TPS_HwIO_Vaiuei p—r TPS_HwIO_Value TPS_Percant_Value [+
TP_Monitor 3
< ThrottlePositionManitor >
PS_Primary "
< ThrottiePosilionSensor =
b TPS,
it lue b
b TPS_HwIO_Value TPS_HwIO_Valuep—> TPS_HwIO_Value TPS_Percant_Value > b TPS_Priman ThrCmd_HwiO_Value >
% Controller {>ﬂ| T bﬁ
APP_Sensor FiTeodieconiolior < ThrottlePosilionctuator >
< AccelerationPedalPositionSensor »
P i [t P t d_Hul lue 13— il
APP_HwIO_Valuell B APP_HwIO_Value APP_Percent_Value [»

b TPS_HwIO_Valug1

Capyright 2020 The MathWorks, Inc.

Simulate the Model at the Architecture Level

Simulate the software architecture model.

sim('ThrottleControlComposition');

To view the list of functions from the components and edit their properties, such as execution order,
use the Functions Editor. To open the Functions Editor, on the Modeling tab, in the Design section,
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click Functions Editor. For more information about the Functions Editor, see “Simulate and Deploy
Software Architectures” on page 7-8.

Funictions

+ 4 & [] Order functions by dependency

1 Actuator_output_Sms Actuator -1

2 Controller_run_5ms Controller 0.005
3 TPS_Primary_read_5Sms TPS_Primary 0.005
4 TPS_Secondary_read_Sms TP5_Secondary 0.005
5 TP_Monitor_D1 TP_Monitor 0.005
& APP_Sensor_read_10ms APP_Sensor 0.01

Simulate the Model at the System Level

To simulate the throttle control system with the throttle body, use a Model block to reference the
software architecture model in the system model. The ThrottleControlSystem model also
contains a Stateflow® Chart block to model a more complex scheduling of the functions of the
software architecture.

A Stateflow license is required for this functionality.

open_system('ThrottleControlSystem');
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Schedule Functions of a Software Architecture with Stateflow

APP_leo_'l;parﬁli.t!IeCnntruICumposition

Step Input

f{) | Base Rate

base_rate Sms{}
APP_read_10ms{)

Pedal Position Input

A

TPS_HwlO_Value

A

TPS_HwlO_Value1

A

.

(o Aciuater_culput_Sms{)

) APP_Sensor_read_10ms

Controler_run_Sms()

P Actuator_output_Sms

sl

alu_Si

Controller_run_5ms

A

RS Prihary_read_Sme()

P TPS_Primary_read_Sms

TS -Becondary_read_Sms()

TP_Monitor_select_Sme{)

TPS_Secondary_read_Sms

b

A

Scheduler

L {TPS1ADC
TPS Sensor In

L TPS2 ADC

P TP onitor_ D1

ThrCmd_HwlO_Value F—

Throttle_Position

Convert TPS to ADC Range

-y

Throttle Pos

PV

Throttle Body

Copyright 2020-2021 The MathWorks, Inc.

To simulate the system model containing the plant and Stateflow scheduler, use this command.

sim('ThrottleControlSystem');
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View the Types in the Software Architecture

To view the unique component types in the software architecture, create a class diagram view and
add all components. To create a class diagram view, on the Modeling tab, in the Views section, click
Architecture Views, then click New to create a new class diagram. Select Class Diagram from the
Diagram section in the Views Gallery. From the list, select Add Component Filter > Select All
Components to add all components in the software architecture to the view.

For more information about the Class Diagram View, see “Class Diagram View of Software
Architectures” on page 7-20.
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View 1
Views »  View 1

B View 1

| ThrottlePositionMonitor |
_-Melhods
D1[0.005]

| AccelerationPedalPosition Sensor |
_.Melhods

read_10ms
ThrottleControlComposition
Methods [ . )
APP_Sensor_read_10ms -— | | ThrottlePositionActuator |
Actuator_output_Sms - Methods
Controller_run_Sms output_Sms
. -—
TPS_Primary_read_5ms
TPS_Secondary_read_5ms
TP_Monitor_D1 [
- - ThrottleController
| Methods
run_5ms
ThrottlePositionSensor |
Methods
read_Sms
% 7

View Configurations
FILTER GROUPING

[, Add ComponentFilter || |bE Add Port Filter |+

E( COMPONENT FILTER

Select All Components

Code Generation

You can generate code to deploy the control system to the target hardware. Code generation requires
an Embedded Coder® license. Open the ThrottleControlComposition model and execute the
slbuild command, or press Ctrl+B to build the model and generate code.

slbuild('ThrottleControlComposition');
The generated code contains an entry-point function for each function of the components in the

software architecture. For more information on code generation for export-function models, see
“Generate Code for Export-Function Model”
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* Model entry point functions */
extern woid ThrottleControlComposition_initialize({woid);
extern void ThrottleControlComposition_terminate(void);

f* Exported emtry point functiom *f
extern wvoid Actuator_output_Sms(void);

f* exported entry point function */f

extern void Comtroller_run_Sms(void);

* Exported entry point function */f

extern vold TPS_Primary_read_Sms(void);

¥ Exported entry point function */f

extern vold TPS_Secondary_read_Sms{void};

* Exported entry point function */f
extern void TP_Monitor_pi{void);

* Exported entry point function */f
extern wold APP_Sensor_read_lems(void);

Copyright 2020-2021 The MathWorks, Inc.

See Also
systemcomposer.createModel | createArchitectureModel | createSimulinkBehavior |
increaseExecutionOrder | decreaseExecutionOrder

More About

. “Author Software Architectures” on page 7-2
. “Simulate and Deploy Software Architectures” on page 7-8
. “Class Diagram View of Software Architectures” on page 7-20
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Class Diagram View of Software Architectures

Use class diagrams to display a graphical representation of the structure of a software architecture
model. You can also use spotlight views to analyze component dependencies and hierarchy, and you
can use component hierarchy views to visualize the component hierarchy as a tree diagram. For more
information, see “Create Spotlight Views” on page 8-2 and “Display Component Hierarchy and
Architecture Hierarchy Using Views” on page 8-22.

A class diagram is a graphical representation of a static structural model that displays unique
architecture types of the software components optionally with software methods and properties.
Class diagrams capture one instance of each referenced model and show relationships between them.
Any component diagram view can be optionally represented as a class diagram for a software
architecture model.

Software Architecture with Class Diagram View

This example uses a software architecture model with functions, stereotypes, and properties to
explore class diagrams in the Architecture Views Gallery. Open the model to follow the steps in this
tutorial.

scCIassDiagram 4 A
scClassDiagram
= ic
" ) cz < mBotPericdicExpFens1_classDiagram >
= mBotPerindicDema_classDiagram = < mBotPeriodicDemo_dassDiagram >
OutBus3 [
[+ InBus [

OutBus2 >
b bus I
CutBus [
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Interact with Class Diagram View

1 Simulate the model to compile it and populate functions. On the toolstrip, click Run.
Alternatively, update the model to compile it by navigating to Modeling > Update Model.

To open the Architecture Views Gallery, navigate to Modeling > Architecture Views.
From the View Browser, select the View 1 view.
To open the class diagram view, click Diagram > Class Diagram.
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W View1
[ scClassDiagram ‘ mBotPeriodicExpFcns2_classDiagram
«Hardware» mBotPeriodicDemo_classDiagram l Methods

Mass: double (kg) =5 Femnae Function4
Version: string ="1.0" Mass: double (kg) = 5 Function5
isNew: boclean = false Version: string = "1.0"

«Software» -

Latency: int16 (cm) = 10 ®———~Softwaren (
Methods Latency. int16 (cm) = 10 ‘ mBotPeriodicExpFcns1_classDiagram
C1_C_1_Function1 Methods «Hardware»
C1_C_1_Function2 C 1 Functioni . Mass: double (kg) =5
C1_C_1_Function3 C 1 Function? Version: string = "1.0"
C1_GC_2_Function1 C_1_Funcl\cm3 isNew: boolean = false

G1_C_2_Function2

C_2_Function1 «Software»
C1_C_2 Function3d C 2 Function? Latency: int16 (cm) = 10

C1_C_3_Function4 C 2 Function3 Methods
C1_C_3_Function5 C737Funclwcm4 Function1
C2_C_1_Function1 C:3:Funclmn5 Function2
C2_C_1_Function2 Function3
C2_C_1_Function3

G2_C_2_Function1
C2_C_2_Function2
C2_C_2_Function3
C2_C_3_Functiond
C2_C_3_Function5
C3_Function1
C3_Function2
G3_Function3

isNew: boolean = false

The class diagram consists of:

* A class box for each unique component type, including reference components.
* A class box as the root that corresponds to the root architecture of the top model.
» Composition connections between the types.

If there are multiple instances of the same type of component, for example, multiple components
that reference the same model across the model hierarchy, then the type of the component is still
represented as one unique box. The component will also relate to its parents and children via
multiple composition connections.

5 You can select Hide methods to simplify the output by removing software functions from the
diagram. Select Hide properties to hide information about stereotypes and property values
applied to the components.

;S u?u El% Hide methods
Component Component  Class Hide properties
Diagram Hierarchy  Diagram
DIAGRAM DISPLAY
See Also
More About

“Author Software Architectures” on page 7-2
“Simulate and Deploy Software Architectures” on page 7-8
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. “Modeling the Software Architecture of a Throttle Position Control System” on page 7-14
. “Display Component Hierarchy and Architecture Hierarchy Using Views” on page 8-22
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Create Spotlight Views

8-2

A system being designed in System Composer for a real application is usually large and complex. It
typically consists of many complex functions working together to fulfill the system requirements. In
the process of designing and analyzing such architectures, you must understand existing components
and what needs to be added. A spotlight view is a simplified view of a model that captures the
upstream and downstream dependencies of a specific component. Use the model below to begin
creating spotlight views.

Mobile Robot Architecture Model with Properties

This example shows a mobile robot architecture model with stereotypes applied to components and
properties defined.



Create Spotlight Views

"o ex_Robotarch_props P

&0

ex_RobotArch_props

[ |4l TargetPosition

Sensors O
Encoder <
v
Trajectory Plannig & Motion O
SensorData < [= SensorData
TargetPosition [ [» TargetPosition Encoder [=
MotionCommand > [ MotionCommand

Create Spotlight Views from Components

To create a spotlight view from the composition, select the DataProcessing component, right-click,
then select Create Spotlight from Component. Alternatively, select the DataProcessing
component and navigate to Modeling > Architecture Views > Spotlight .

The spotlight view launches and shows all model elements to which the component connects in a
hierarchy. The spotlight diagram is laid out automatically and cannot be edited.
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ex_RobotArch_props

Sensors.

SensorsiDataProcessing
Rawata ouBes ]

")
ST

Trajectery Planning/MotionController o

‘ Trajectory Planning/SafetyRules o

TrgetPosiion

51

i
Q&
3
ex_RobotArch_props
Motion o
Sensors o F
Targs N AL SR ° _J Trajectory Planning/MotionController (]
e z Du_l_‘ - s J — S | Trajectory PlanningisafetyRules =)
I - — ]
_____ ‘
S\
«
While in the spotlight view, you can put another component in the spotlight. Select the Motion
component and click @
@
&

You can make the hierarchy and connectivity of a component visible at all times during model

development by opening the spotlight view in a separate window. To show the spotlight view in a
dedicated window, select Open in New Window in the component context menu, then create the
spotlight view. Spotlight views are dynamic and transient: any change in the composition refreshes
any open spotlight views, and spotlight views are not saved with the model.

To return to the architecture model view, click O To view the architecture at the level of a
particular component, select the component and click .

See Also

More About

. “Create Architecture Views Interactively” on page 8-5

. “Display Component Hierarchy and Architecture Hierarchy Using Views” on page 8-22
. “Create Architectural Views Programmatically” on page 8-16

. “Modeling System Architecture of Keyless Entry System” on page 8-26
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Create Architecture Views Interactively

The structural hierarchy of a system typically differs from the hierarchy of the functional
requirements of a system. With architecture views in System Composer, you can view a system based
on different hierarchies.

A view shows a customizable subset of elements in a model. Views can be filtered based on
stereotypes or names of components, ports, and interfaces, along with the name, type, or units of an
interface element. Create views by adding elements manually. Views create a simplified way to work
with complex architectures by focusing on certain parts of the architecture design.

You can use different types of views to represent the system:
* Operational views demonstrate how a system will be used and should be integrated with
requirements analysis.

» Functional views focus on what the system must do to operate.
* Physical views show how the system is constructed and configured.

A viewpoint represents a stakeholder perspective that specifies the contents of the view.

For example, you can author a system using requirements. A view allows you to better understand
what components you need to satisfy your requirements while not necessarily focusing on the
structure.

This example uses the architecture model for a keyless entry system to create component diagram
views. A component diagram represents a view with components, ports, and connectors based on how
the model is structured. Component diagrams allow you to programmatically or manually add and
remove components from the view.

Create Filtered Views with Component Filters and Port Filters

1 Inthe MATLAB Command Window, enter scKeylessEntrySystem. The architecture model
opens in System Composer.

2 Navigate to Modeling > Architecture Views to open the Architecture Views Gallery.
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VIEWS

wH T G Grop | @ @ | Bl S, | Onen Reurmments Eor 50 ) Sis &
New Save Delete  Run E Remove © Ungroup | Pivat Focus é Link to selected requirement Component Component Architecture | Display
- Query w2 Requirements Manager Diagram Hierarchy ~ Hierarchy | Depth =
FILE COMPOMENTS CANVAS NAVIGATE REQUIREMENT DIAGRAM DISPLAY Y
| o |n
4 38 Views =
> . Door Lock System Supplier Breakdown 2
+ [l Key FOB Position Dataflow v §
3 . Software Component Review Sta... 3 &
> . Sound Systern Supplier Breakdown §
w

[E Sequence Diagrams

Use the New button to create a new View or Sequence diagram or

select an existing diagram from the left.

¥ Model Components o
4 [ KeylessEntryArchitecture
4 D Door Lock/Unlock System
= Door Lock Controller
[5] Front Driver Door Lock Actuator
4 Front Driver Door Lock Sensor

[= Detect Door Lock Status View Configurations e
= Door Lock Sensor FILTER | GROUPING |
%! Front Pass Door Lock Actuator [¥. Add ComponentFilt + | |3 Add Port Fite ~ | | [« Apply | |45 Revert Auto Apply | | Mode: | Basic | Code
4 [¢5] Front Pass Door Lock Sensor -
[™ Detect Door Lock Status ey SR TREN R
= Door Lock Sensor No view is selected.
Rear Driver Door Lock Actuator
5| Rear Driver Daar Lock Sanzor - | 5
14 x4

3 Select New > View to create a new view.

4 In View Properties on the right pane, in the Name box, enter a name for this view, for example,
Software Component Review. Choose a Color and enter a Description, if necessary.
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VIEWS

- Open Requirements Editor =o =
Ifl:ll:I E Add Group CRNE | I%L'pk ql . (= | Ghd Erg ;:1
t lal it -
New Save Delet=  Run Femove coun | @ B Pivot Focus | € T o ciectediequiremen Component Component Architecture  Display

- Tue - o - B Requirements Manager Diagram  Hierarchy  Hierarchy  Depth =
FILE COMPOMNENTS CANVAS MNAVIGATE REQUIREMENT DIAGRAM DISPLAY

View Properties

View Browser Software Component Review
Views ¥ Software Component Review Name Value
4 Main

Name e Component Review
Color | R4

Description

4 58 Views
3 . Door Lock System Supplier Br
+ [l Key FOB Position Dataflow
3 . Software Component Revie
» D Sound System Supplier Break..
. Software Component Review

S e ] Software Component Review

W
-
v

Model Components
4 (7 KeylessEntryArchitecture
4 ™ Door Lock/Unlock System
™| Door Lock Controller
%3] Front Driver Door Lock Actuator
4 &3] Front Driver Door Lock Sensor
™= Detect Door Lock Status View Configurations
™| Door Lock Sensor FILTER GROUPING
5| Front Pass Door Lock Actuator [, Add Component F =
4 %3 Front Pass Door Lock Sensor
™| Detect Door Lock Status
™| Door Lock Sensor W No filter specified. Use the “Component Filter” bution to build a new filter or choose "Select All Components” to bring
%3] Rear Driver Doer Lock Actuator

[ COMPONENT FILTER

4 %3] Rear Driver Door Lock Sensor 3

> ]

5 In the bottom pane, select View Configurations > Filter > Add Component Filter to add a
form-based criterion to a component filter.

6 From the Select list, select Components. From the Where list, select Stereotype. Select isa.
In the text box, from the list select AutoProfile.SoftwareComponent.

FILTER GROUFPING

[, Add Component Filter |« | |BE Add Port Filter || |« Apply| |3 Revert Auto Apply Basic | Code

E( COMPONENT FILTER

Select Components - Where Stereotype - isa - \utoProfile.SoﬂwareComponent| - |

Select Apply v

An architecture view is created using the query in the Component Filter box. The view is
filtered to select all components with the AutoProfile.SoftwareComponent stereotype
applied to them.



8 Create Custom Views

[l software Component Review

{Lighting Controller l
J N
(" engineStatus cabinLightCmd
(1> KeyLocation neadiignicma )
[FOB Locator Module |
\J CenterReceiver Keyless Start Controller
1 }
(- FrontReceiver keyLocation
.le RearReceiver J/ buttonPressed
]

ﬂ currentGear

) :
\l InBus isLocked J,)f {

% engineStatus engineCmd
| Rear Pass Door Lock Sensor/Detect Door Lock Status ‘ (. isPegalDepressea
l 48 keyLocation
- = Door Lock Controller
| Front Driver Door Lock Sensor/Detect Door Lock Status “ l
J (i frontDriverSensor doorStatus =
( InBus isLocked ] {Sound Controller
l r 4(9 frontPassSensor frontDriverCmd [
(>
/i keyLocation frontPassCmd ) 5 JoSts L
=] j ( enginestatus soundcmd )
‘ Front Pass Door Lock Sensor/Detect Door Lock Status —(} rearDriverSensor rearDriverCmd ) p| keyLocation ‘/
—
{
‘ jp P: rearPassCmd )
( mBus isLocked ]}— ‘1
‘ Rear Driver Door Lock Sensor/Detect Door Lock Status =]
‘\J InBus isLocked

8 Select Add Component Filter. From the Select list, select Components. From the Where list,
select Name. Select ~contains. In the text box, enter "Door Lock". Select the Auto Apply
check box so that future changes are applied without selecting Apply.

View Configurations
FILTER GROUPING

[, Add component Fiter |+ | [, Add Port Filter |+ [ AutoAppiy | [Basic| code|

E\"r' COMPONENT FILTER

Select | Components * | Where |Stereotype | - | |isa - | |AutoProfile.Soﬂ'.vareCompon...| - |

|And « | Select |Components * |  Where |Name |v| | ~contains - | |'Door Lock” |

-

9 An architecture view is created using the additional query in the Component Filter box. The
view is filtered to select all components not named "Door Lock".
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s

oftware Component Review

Keyless Start Controller

" buttonPressed

cumrentGear

engineStatus engineCmd
~ isPedalDepressed

& keylLocation

Sound Controller [
(" doorStatus
engineStatus soundCmd
g =l —\ keyLocation
FOB Locator Module - '
CenterReceiver . . =
) Lighting Controller =
| FrontReceiver keylLocation =)
; L
(- RearReceiver (" engineStatus cabinLightCmd )

(& keyLocation headlightCmd )

10 From the Add Port Filter list, select the option Hide Unconnected Ports.

View Configurations

FILTER

[, Add Component Filter |+ | |BE Add Port Filter |« | Auto Apply Basic | Code

E, COMPONENT FILTER

Select | Components v | Where |Stereotype |v isa ~ | | AutoProfie.SoftwareCompon.... | +
And - Select Components - Where Name |v ~contains - "Door Lock™
&
b7 PORT FILTER

Hide uncennected ports

%

GROUFING

11 An architecture view is created using the additional query in the Port Filter box. The view is
filtered to hide unconnected ports.
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] software Component Review

1

FOB Locator Module (]

keyLocation [

Keyless Start Controller =

(7 keyLocation

‘ Sound Controller =

(1 keyLocation

l_

Lighting Controller ]

(1= keyLocation

8-10

12

Delete the port filter. Pause on the constraint and select the @ button.

Add Group By Criteria to Filtered Views

Click Add Group By again.

o U A W N M

Click Apply.

In the View Configurations pane, select Grouping.
To choose a property enumeration for grouping, click Add Group By.
From the list, select AutoProfile.BaseComponent.ReviewStatus.

From the list, select AutoProfile.SoftwareComponent.ImplementationlLanguage.
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I Software Component Review

UnderReview

Keyless Start Controller

NeedsReview
Simulink

FOB Locator Module =]

r o8 Lo e Sound Controller =]

Lighting Controlier =

Interactively Add and Remove Elements from Views

1 To add more components to the view, drag and drop components from Model Components.
Drag and drop the Lighting System component to the Software Component Review view.
Alternatively, click Add on the toolstrip. You can also press Ctrl+I to add component
instantiations to your view when they are selected.

Note Interactively adding and removing elements from your view with an associated query is not
supported. You will receive a warning message: Remove associated query? Press OK to proceed.
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VIEWS 2c @
View Browser Software Component Review

4 38 Views Visws b Software Component Review

3 . Door Lock System Supplier Breakdown
» . Key FOB Position Dataflow

3 . Software Component Review Status o

» |:| Sound System Supplier Breakdown

3 . Software Component Review

=1 <
| s3lxadoyd INIWT3

[£7 Sequence Diagrams

Model Components ‘ Lighting System ‘
= Antenna - L. . — =
= PWM
4 == Lighting System %3
™= Cabin Lights =
= Headlights

™ Lighting Controller
4 = Sound System
== Dashboard Speaker

== Sound Controller

|4 VIEW CONFIGURATIONS | A 4]
You can press Delete to delete components from the view.
2 Observe that the Lighting System component has been added to the view.
Lighting System &

Reviewed
Simulink
[Sound Corroller keyl osation
Lighting Controller =
Lighting Controller_sngineStatus Lighting Contraller_engineStatus i
& engineStatus cabinLightCmd
—_— (- keylocaton headightCmd

Lighting Contraller_keyLocation

engineSiatus

Lighting Conroller_keyLocation Cpp
Sound Controller
. doorStatus.
‘Sourd Controller_keyl ocation \ .
‘Sound Controller_keyLocation e  enginaStatus soundCmd )
1 keyLocation L keylocston

3 Navigate to Requirement > Requirements Manager. The Requirement Links tab appears at
the bottom of the Software Component Review view.

4 Select the Lighting Controller component and observe the linked requirement
Automatically turn off headlights.
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Software Component Review
Views b Software Component Review

o
o

Lighting System

Reviewed
Simulink
{5eund Controller kevlocation
Lighting Controller =
Lighting Controller_snginsStatus Lighting Cantrolier_engineStatus J
enginaStatus cabinlightCrd
) 1
(& weyLocation headightCmd
Lighting Controlier_keyLocstion
engineStatus
Lighting Controller_keyLozation
Cpp
Sound Controller =
doorStas
Sound Controter_keyLocs Saund Centrolier_berlocaiz engineStaius soundGmd
keyLocation L keylLocation

[l Requirement Links

E = Implements:

hts

Automati n off headlights n
Flash headlights on lock

5 Select the requirement Automatically turn off headlights to open the Requirements
Editor to view or modify requirement links.

Add or Remove Requirements Links from Views

1 In the Architecture Views Gallery, navigate to Requirement > Open Requirements Editor if
the Requirements Editor is not open already.

Select the Should unlock door requirement.

Return to the Architecture Views Gallery. In the Software Component Review view, select the
Lighting Controller component.

4 Navigate to Requirement > Link to selected requirement. The new requirement Should
unlock door is added.
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View Browser
4 Py Views
» . Door Lock System Supplier Breakdown
3 . Key FOB Position Dataflow
» . Software Component Review Status
3 |:| Sound System Supplier Breakdown
3 . Software Component Review
Py Sequence Diagrams

Model Components

= PWM
4 T3 Rear Receiver
== Antenna
= PWM
4 = Lighting System
™= Cabin Lights
== Headlights
™= Lighting Controller
4 ™ Sound System
== Dashboard Speaker

== Sound Controller

<<

Software Component Review
Views b Software Component Review

= b
(- engineStatus soundCmd )

{ = keylLocation
pund Controllar_keylLocation "

| S LHAL0HS LININOHNOD

imulink

Lighting Controller = I‘::||

engineStatus

|—'r
{ I keyLocation

ghting Cantroller_keyLocation cabinLightCmd )

I
headlightCmd )

View Configurations Q
El < Implements:

Welcome lights

y turn off headlights

ghts on lock

Should unlock door ¢ %

Requirement Links

5 Toremove a requirement link, select # and confirm deletion.

Add Custom Clauses to Component Filters and Port Filters

Select New > View to create a new view.

2 In View Properties on the right pane, in the Name box, enter a name for this view, for example,
Hardware Component View. Choose a Color and enter a Description, if necessary.

3 In the bottom pane, under View Configurations > Filter, select from the list Add Component
Filter > Add Custom Component Filter to enter a constraint by which to filter. In the box,
enter contains(Property('Name'), 'Dashboard').

4 In the bottom pane, under View Configurations > Filter, select from the list Add Port Filter >
Add Custom Port Filter to enter a constraint by which to filter. In the box, enter
contains(Property('Name'), 'sound').

Select Apply v,

8-14



Create Architecture Views Interactively

Hardware Component View
Views » Hardware Component View

B Hardware Component View

‘ Dashboard Speaker {

|: soundCmd

View Configurations
FILTER GROUPING

[, Add Component Filter |« | |BE, Add Port Filter | Basic | Code

:—'r COMPONENT FILTER
contains(Property(Name'),'Dashboard’)

b7 PORT FILTER
contains(Property(Name'),'sound”)

&

The view is filtered using the constraints in the custom filters. For more information on
structuring constraints, see systemcomposer.query.Constraint.

See Also

More About

. “Create Architectural Views Programmatically” on page 8-16

. “Display Component Hierarchy and Architecture Hierarchy Using Views” on page 8-22
. “Create Spotlight Views” on page 8-2

. “Modeling System Architecture of Keyless Entry System” on page 8-26
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Create Architectural Views Programmatically

You can create an architecture view programmatically. This topic presents two examples of creating
architecture views programmatically and shows you how to use queries to find elements in a System
Composer model.

A query is a specification that describes certain constraints or criteria to be satisfied by model

elements. Use queries to search elements with constraint criteria and to filter views.

Create Architecture Views in System Composer with Keyless Entry
System

Use a keyless entry system to programmatically create architecture views.
1. Import the package with queries.

import systemcomposer.query.*

2. Open the Simulink® project file for the Keyless Entry System.
scKeylessEntrySystem

3. Load the example model into System Composer™.

model = systemcomposer.loadModel('KeylessEntryArchitecture');
Example 1: Hardware Component Review Status View

Create a filtered view that selects all hardware components in the architecture model and groups
them using the ReviewStatus property.

1. Construct a query to select all hardware components.
hwCompQuery = HasStereotype(IsStereotypeDerivedFrom('AutoProfile.HardwareComponent'));
2. Use the query to create a view.

model.createView('Hardware Component Review Status',...

'Select',hwCompQuery, ... % Query to use for the selection
'GroupBy',{'AutoProfile.BaseComponent.ReviewStatus'},... % Stereotype property to qualify by
'IncludeReferenceModels',true,... % Include components in referenced models

'Color', 'purple');
3. To open the Architecture Views Gallery the Views section, click Architecture Views.

model.openViews
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Example 2: FOB Locator System Supplier View

Create a freeform view that manually pulls the components from the FOB Locator System and groups
them using existing and new view components for the suppliers. In this example, you will use element
groups, groupings of components in a view, to programmatically populate a view.

1. Create a view architecture.

fobSupplierView = model.createView('FOB Locator System Supplier Breakdown',...
'Color', 'lightblue');

2. Add a subgroup called 'Supplier D'. Add the FOB Locator Module to the view element
subgroup.

supplierD = fobSupplierView.Root.createSubGroup('Supplier D');
supplierD.addElement('KeylessEntryArchitecture/FOB Locator System/FOB Locator Module');

3. Create a new subgroup for 'Supplier A'.

supplierA = fobSupplierView.Root.createSubGroup('Supplier A');

4. Add each of the FOB Receivers to view element subgroup.

FOBLocatorSystem = model.lookup('Path', 'KeylessEntryArchitecture/FOB Locator System');

[)

% Find all the components which contain the name "Receiver"
receiverCompPaths = model.find(...
contains(Property('Name'), 'Receiver'), ...
FOBLocatorSystem.Architecture);

supplierA.addElement(receiverCompPaths)

8-17



8 Create Custom Views

WIEWS
_—l':-, E ﬁ g‘ 5 @ ay EJ 1 Open Reguirements Editar :‘I: L?IJ ‘.h. — Hide unconnected ports
Hew  Smve Delete Reinad &E p Faous & ks selasea et - Component Hirsechy | Displsy Hide pacts
View ¥ Mol 1 Requirements Manager Dagam  Giogam | Ceptn v | Hide correcton
VIEW .._.R:.:._I,;m LOMPOMENTS = . c- ok :":“ — — RECRIBEMERT DiAEAM DEPLAY = :-
a FY Views - Wiews B FOE Lomtor Sysiom Suppher Breakdosn E
+ [l Door Lock System Supplier Greakdown 3
v [l Kev FOB Posltian Datafiow N =
+ [l Soitware Compunsnl Review Stalus N ﬁ
+ [ Geund Sysiam Supnliar Rraakiosn [CIFOE Locator System Supplier Brakdown =
v [l Herdware Componenl Review Stelus
4 [ P Locatar Systenn Supplier Breakdown |
. Supplicr D SRRReTR
™ FOR Locater Madula Supplier B
4[| Suppiler & e |
Cenler Fecsives Jrv— ) [ 'EOB Locator Madule =]
= Aar Razaivar ot P . [ ¢ cenmamie
+ MODEL COMPONENTS o Front Racelver ' —|—'. Pl -
N P ———— N “FOBRESNEN — e FOE Looow Viedws_TonisFros
4 = Daor Lock"riock Systam s :
™ Door Lock Contraller
77 Frank Drives Door Luck Achustur [Rear Recaivar 1|
+ = Front Driver Door Lock Senscr ~FOR=celner. ey
= Matact Mear | ack Statis FaZgral : -
= Doar Liock Sansor
=% Front 1'aag Doer Lock Acluaton
+ 7% Front Pass Ducr Lock Sensor
™ Ditect Door Lock Status
™ Noar Lock Sansor L
T+ Rear Oriver Door Lock Sctustor
« TR Driver Door Lock Sensor
™= Detecl Door 3
™ Doar L .
4 o S VIEW CONFIGURATIONS | Al
5. Save the model.
model.save
Find Elements in Model Using Queries
Find components in a System Composer model using queries.
Open the model.
import systemcomposer.query.*
scKeylessEntrySystem
model = systemcomposer.loadModel('KeylessEntryArchitecture');
Find all the software components in the system.
conl = HasStereotype(Property("Name") == "SoftwareComponent");
[compPaths, compObjs] = model.find(conl)
compPaths = 5x1 cell
{'KeylessEntryArchitecture/FOB Locator System/FOB Locator Module' }
{'KeylessEntryArchitecture/Door Lock//Unlock System/Door Lock Controller' }
{'KeylessEntryArchitecture/Sound System/Sound Controller' }
{'KeylessEntryArchitecture/Lighting System/Lighting Controller’ }

{'KeylessEntryArchitecture/Engine Control System/Keyless Start Controller'}
compObjs=1x5 object
1x5 Component array with properties:

IsAdapterComponent
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Architecture
ReferenceName
Name

Parent

Ports

OwnedPorts
OwnedArchitecture
Position

Model
SimulinkHandle
SimulinkModelHandle
UUID

ExternalUID

% Include reference models in the search
softwareComps = model.find(conl, 'IncludeReferenceModels', true)

softwareComps = 9x1 cell
{'KeylessEntryArchitecture/FOB Locator System/FOB Locator Module'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Door Lock Controller'
{'KeylessEntryArchitecture/Sound System/Sound Controller!'
{'KeylessEntryArchitecture/Lighting System/Lighting Controller'
{'KeylessEntryArchitecture/Engine Control System/Keyless Start Controller'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Pass Door Lock Sensor/Detect Door L«
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Driver Door Lock Sensor/Detect Door
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Pass Door Lock Sensor/Detect Door |
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Driver Door Lock Sensor/Detect Doo

Find all the base components in the system.

con2 = HasStereotype(IsStereotypeDerivedFrom("AutoProfile.BaseComponent"));
baseComps = model.find(con2)

baseComps = 18x1 cell
{'KeylessEntryArchitecture/FOB Locator System/FOB Locator Module'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Door Lock Controller'
{'KeylessEntryArchitecture/Sound System/Sound Controller'
{'KeylessEntryArchitecture/Lighting System/Lighting Controller'
{'KeylessEntryArchitecture/Engine Control System/Keyless Start Controller'
{'KeylessEntryArchitecture/Engine Control System/Start//Stop Button'
{'KeylessEntryArchitecture/Sound System/Dashboard Speaker'
{'KeylessEntryArchitecture/FOB Locator System/Center Receiver'
{'KeylessEntryArchitecture/FOB Locator System/Front Receiver'
{'KeylessEntryArchitecture/FOB Locator System/Rear Receiver'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Driver Door Lock Sensor'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Pass Door Lock Sensor'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Driver Door Lock Sensor'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Pass Door Lock Sensor'
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Driver Door Lock Actuator'}
{'KeylessEntryArchitecture/Door Lock//Unlock System/Front Pass Door Lock Actuator' }
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Driver Door Lock Actuator' }
{'KeylessEntryArchitecture/Door Lock//Unlock System/Rear Pass Door Lock Actuator' }

o e e e e e e e e e e e e

Find all components using the interface KeyFOBPosition.
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con3 = HasPort(HasInterface(Property("Name") == "KeyFOBPosition"));
con3_a = HasPort(Property("InterfaceName") == "KeyFOBPosition");
keyFOBPosComps = model.find(con3)

keyFOBPosComps = 10x1 cell

{'KeylessEntryArchitecture/Door Lock//Unlock System' }
{'KeylessEntryArchitecture/Door Lock//Unlock System/Door Lock Controller' }
{'KeylessEntryArchitecture/Engine Control System' }

{'KeylessEntryArchitecture/Engine Control System/Keyless Start Controller'}
{'KeylessEntryArchitecture/FOB Locator System'
{'KeylessEntryArchitecture/FOB Locator System/FOB Locator Module'
{'KeylessEntryArchitecture/Lighting System'
{'KeylessEntryArchitecture/Lighting System/Lighting Controller'
{'KeylessEntryArchitecture/Sound System'
{'KeylessEntryArchitecture/Sound System/Sound Controller!'

B el e e

Find all components whose WCET is less than or equal to 5 ms.

cond = PropertyValue("AutoProfile.SoftwareComponent.WCET") <= 5;
model.find(con4)

ans Ix1 cell array

{'KeylessEntryArchitecture/Sound System/Sound Controller'}

% You can specify units for automatic unit conversion
con5 = PropertyValue("AutoProfile.SoftwareComponent.WCET") <= Value(5, 'ms');
querylComps = model.find(con5)

querylComps = 3x1 cell
{'KeylessEntryArchitecture/FOB Locator System/FOB Locator Module'}
{'KeylessEntryArchitecture/Sound System/Sound Controller' }
{'KeylessEntryArchitecture/Lighting System/Lighting Controller' }

Find all components whose WCET is greater than 1 ms or that have a cost greater than 10 USD.

con6 = PropertyValue("AutoProfile.SoftwareComponent.WCET") > Value(l,'ms') | PropertyValue("Auto
query2Comps = model.find(con6)

query2Comps = 2x1 cell

{'KeylessEntryArchitecture/Door Lock//Unlock System/Door Lock Controller' }
{'KeylessEntryArchitecture/Engine Control System/Keyless Start Controller'}

Close the model.

model.close

See Also
find | Llookup | systemcomposer.query.Constraint | createView | getView | openViews |
deleteView | systemcomposer.view.View | systemcomposer.view.ElementGroup
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More About
. “Create Architecture Views Interactively” on page 8-5
. “Display Component Hierarchy and Architecture Hierarchy Using Views” on page 8-22

. “Create Spotlight Views” on page 8-2
. “Modeling System Architecture of Keyless Entry System” on page 8-26
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Display Component Hierarchy and Architecture Hierarchy
Using Views

8-22

This example shows how to use hierarchy views in the Architecture Views Gallery to use hierarchy
views to visualize hierarchical relationships. You can visualize a hierarchy diagram as a view with
components, ports, reference types, component stereotypes, and stereotype properties.

There are two types of hierarchy diagrams:
* Component hierarchy diagrams display components in tree form with parents above children. In a

component hierarchy view, each referenced model is represented as many times as it is used.

* Architecture hierarchy diagrams display unique component architecture types and their
relationships using composition connections. In an architecture hierarchy view, each referenced
model is represented only once.

Any component diagram view can be optionally represented as a hierarchy diagram. The hierarchy
view shows the same set of components visible in the component diagram view, and the components
are selected and filtered in the same way as in a component diagram view.

This example uses an architecture model representing data flow within a robotic system. Open this
model to follow the steps in the tutorial.

Robot Computer Systems Architecture

Use a robot computer system with controllers that simulate transmission of data to explore hierarchy
diagrams in the Architecture Views Gallery.
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Switch Between Component Diagram View and Hierarchy Views

[EIAN Components

Controller
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To open the Architecture Views Gallery, navigate to Modeling > Architecture Views.

From the View Browser, select the All Components view.

Observe the component diagram view that corresponds to the all the components in the

architecture model.

Computer

Machine i

RobotController
<CantrolierSimuiinis

Processor i

Motherboard

InternalController
<ControllerSimuink>

The component diagram represents a view with components, ports, and connectors based on how

the model is structured.

Click Diagram > Component Hierarchy.
=5
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Component | Component | Architecture
Diagram Hierarchy™ Hierarchy

-

i
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5

Observe the component hierarchy view that corresponds to the same set of components.

[l All Components
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The component hierarchy diagram shows a single root, which is the view specification itself. The
root corresponds to the name of the view shown in the component diagram. The connections in
the component hierarchy diagram originate from the child components and end with a diamond
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symbol at each parent component.

6 Click Diagram > Architecture Hierarchy.

E-5
L

-
oo |

-

Compenent Component | Architecture

Diagram

Hierarchy

Hierarch

7  Observe the architecture hierarchy view that corresponds to the same set of components.
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B All Components
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The architecture hierarchy diagram starts with the root architecture. The root corresponds to the
boundary of the system. A box in an architecture hierarchy diagram represents a referenced
model and appears only once even if it is referenced multiple times in the same model. For
example, ControllerSimulink, a referenced model that appears on three components, has
three connections to its parent architectures. The connectivity of the boxes represents the
relationship between ContollerSimulink and its parents.

See Also

More About

. “Create Architectural Views Programmatically” on page 8-16

. “Create Architecture Views Interactively” on page 8-5

. “Create Spotlight Views” on page 8-2

. “Modeling System Architecture of Keyless Entry System” on page 8-26
. “Class Diagram View of Software Architectures” on page 7-20
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Modeling System Architecture of Keyless Entry System
Overview

This example shows how to set up the architecture for a keyless entry system for a vehicle. You also
learn how to create different architecture views for different stakeholder concerns.

Open the project.
scKeylessEntrySystem

Starting: Simulink

KeylessEntryArchitecture

FOB Locator System ﬂl% Door Lock/Unlock System ﬂl%

Sound System &

v
Lighting System &z Engine Control System t:%

Copyright 2019-2020 The MathWaorks, Inc

Opening the Architecture Views

You can create, view, and edit architecture views in the Architecture Views editor. To launch the
editor, select the Architecture Views button from the Modeling tab in the toolstrip. Select from one
of the existing views for the model. The model has these views:

* Key FOB Position Dataflow — An operational view of the components in the model that are making
use of the KeyFOBPosition interface.

* Door Lock System Supplier Breakdown — A functional view of the components in the door lock
system grouped by which supplier is providing the given components.

* Sound System Supplier Breakdown — A functional view of the components in the sound system
grouped by which supplier is providing the given components.
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* Software Component Review Status — A physical view of the components in the model with the
SoftwareComponent stereotype applied grouped by the value of the ReviewStatus property.

See Also

createView | getView | openViews | deleteView | systemcomposer.view.View |
systemcomposer.view.ElementGroup

More About

. “Create Architecture Views Interactively” on page 8-5

. “Create Architectural Views Programmatically” on page 8-16

. “Display Component Hierarchy and Architecture Hierarchy Using Views” on page 8-22
. “Organize System Composer Files in a Project” on page 1-37

. “Modeling System Architecture of Small UAV” on page 1-31
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